




ROB MEAD-GREEN 
EDITOR
editor@macformat.com
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Operations Editor 
 Jo’s hoping for an Apple 

iBin – a robot that goes 
around the house collecting 
rubbish, and remembers 
to take itself outside on 
bin collection day.

Meet the teamHot on the heels of the Vision Pro come rumours 
that Apple is already working on its Next Big Thing 
– and its robots that Cupertino may have set it 
sights on. The company is rumoured to be working 
on two possible options: an AI-powered robot that 
follows you around the house and can carry out 
chores like washing the dishes; and a desktop robot 
whose display can follow your every move. While 
the first one could conceivably be something like 
Amazon’s Astro; the desktop robot seems more 
like an iMac G4, only with a motororised arm. 

Now that’s a robot we’d like to see. You can find out more on p6.
Apple, of course, isn’t the only company that’s dabbling in robots – 

there’s the aforementioned Amazon Astro, of course, but Samsung has 
its Pacman-like Ballie; Sony has its cute robot dog Aibo, and Panasonic 
is working on NICOBO, which looks like a bobble hat with eyes and a tail. 
Car companies, too, have long experimented with robotics, with Honda’s 
ASIMO, Toyota’s trumpet-playing robot, and its palm-sized Kirobo, which 
entertained astronauts on the International Space Station, so it’ll be 
interesting to see what Apple’s take might be.

Back down to Earth and you’ll see that this issue is packed with great 
things to read about and to do – from our 13-page guide to fixing your Mac 
(p20), to in-depth reviews of the M3 MacBook Air 13in and 15in (starting on 
p78). Plus there’s a round-up of the best keyboards for your Mac on p86 too. 

Paul Blachford
Art Editor
 Paul’s got his fingers 

crossed for an iPooch – a 
robot dog that can take 
itself for walks. Or failing 
that, one that’ll pick up 
what it ‘leaves’ behind.

Ian Osborne
Contributor
 Ian’s hoping that since 

Apple uses ARM-based 
chips, it’ll come up with 
some robot limbs to make 
writing features and 
how-tos easier.
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ast month, we covered how 
Apple’s much-rumoured 
electric car project had been 

cancelled. Well, Apple has apparently 
found a new “next big thing” to replace 
the car with, and we guarantee it’s 
nothing like what you’re expecting.

If a new report from Bloomberg’s 
Mark Gurman is to be believed, Apple 
has settled on a range of smart home 
robots that will act as helpers around 
your home. It’s a stark departure from 
Apple’s usual range of products – but 
then again, so was the Apple car.

Gurman’s article says that Apple 
has a few different ideas in play, and 
that the company is actively researching 
and developing them all. The first is 
a home-assistant robot that would 
follow you around the home, ready to 
perform tasks for you. It would be able 
to navigate around obstacles thanks 
to an onboard algorithm, and might 

work in a somewhat similar way to 
Amazon’s Astro robot.

The original idea for Apple’s robot 
was that it would be able to walk around 
your home entirely unassisted. As well 
as that, Gurman says that Apple had 
planned for it to be able to perform 
household chores, such as washing the 
dishes in a sink. That, however, proved 
to be too tricky and “would require 
 

overcoming extraordinarily difficult 
engineering challenges,” something 
that Gurman doesn’t believe is likely 
to happen this decade.

It’s not the only robotics project that 
Apple has apparently been working on, 
as the company has also explored a 
much smaller robot that would sit on 
a desktop. It would have an attached 
display that could move around 
depending on the situation.

For example, Gurman’s report 
explains that “The idea was to have the 
display mimic the head movements – 
such as nodding – of a person on a 
FaceTime session. It would also have 
features to precisely lock on to a single 
person among a crowd during a video 
call.” Senior Apple execs were excited by 
this project, and while it’s not certain 
whether either it or the robo assistant 
will ever launch, the display robot is 
further along the development process, 

L

Apple wants 
to build a 
home robot
“Hey Siri, load the dishwasher”

Apple isn’t the only one interested in robots – 
Amazon’s Astro has been available since 2021.

THE LATEST NEWS AND RUMOURS 

HOT TOPIC!



 Image credit: Apple Inc

Gurman says. Additionally, it has been 
reported that Apple is also working on 
a HomePod speaker with an iPad-like 
display. All in all, it seems that Apple is 
taking these developments seriously.

The next big thing
You might be asking why the Vision Pro 
is not Apple’s “next big thing.” Well, the 
company knows it will take years before 
the price comes down and the headset 
goes truly mainstream. And even then, the 
world of virtual reality headsets is still 
very young and the Vision Pro’s future 
success is by no means guaranteed.

To keep the good times rolling, Apple 
is therefore in search of what it feels is 
a sure-fire moneymaker, and just like the 

stormtroopers in Star Wars, droids could 
well be the thing that it’s looking for.

Yet even Apple seems to have 
acknowledged that the robot project 
might fall flat. While Gurman says Apple 
execs liked what they saw of the desktop 
robot, they were also concerned “about 
whether consumers would be willing to 
pay top dollar for such a device.” That 
doesn’t sound like they’re confident it 
will be a nailed-on winner.

So, what will Apple’s next big thing 
be exactly? No one knows, and it seems 
not even Apple is certain. But while it tries 
to work that out, it might continue pouring 
money into home robotics. Who knows, 
you might one day have an Apple-branded 
robot take out the rubbish for you.

he Magic Mouse 2 is 
notorious for its upside-
down charging and 

uncomfortable design, and it’s 
become something of a running 
joke among computer users of 
both the Mac and PC persuasion. 
That might not be the case for 
much longer, though, as a new 
Apple patent has revealed how 
the company plans to overhaul 
its mouse with some fascinating 
new features.

The patent suggests that future 
versions of the Magic Mouse might 
include the ability to tilt the device 
from side to side or front to back. 
As well as that, Apple describes 
circular-shaped mice that could be 
rolled along their sides. In both 
cases, the movement might work 
as a new control method.

For example, these extra 
controls might let you perform 
functions “whether visibly apparent 
on a display screen of the 
computing device or not,” Apple 
says. Which might mean you’ll be 
able to adjust brightness, volume, 
brush sizes and more with just a 
quick flick of your wrist and tilt 
of the mouse.

Will Apple 
fix the Magic 
Mouse?

Siri has a lot of work to do to catch up 
with artificial intelligence (AI) rivals 
like ChatGPT, but Apple may have 
cracked it. In a paper dubbed ‘ReALM: 
Reference Resolution As Language 
Modeling’, Apple’s researchers describe 
how the company’s own large language 
model (LLM) can “substantially” 

outperform GPT-4, the LLM that powers 
ChatGPT, when it considers tasks 
running onscreen as well as in the 
background. If that LLM makes it 
into Siri, it could be great news.

Researchers say there is still much 
to be done, but it’s encouraging news 
for anyone hoping Siri will improve.

Siri’s AI boost

Despite launching the Vision Pro headset, Apple is still looking for a different “next big thing”.

If Siri gets an artificial intelligence 
boost, it may be able to close the 
gap with rival services.

The Magic Mouse has gone largely 
unchanged for years but might get 
some new tilt-based functionality.
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A matt display and better camera placement reportedly on the way

he European Union (EU) has 
recently forced Apple to open 
up its ecosystem to third-party 

app stores, essentially allowing users to 
‘sideload’ apps onto their devices, mostly 
outside of Apple’s control. 

At first it seemed that this new policy would 
be limited to other app stores, but now it looks 
like Apple is going to let you download apps 
directly from websites, without ever having to 
go through an app store at all.

The functionality was implemented in the 
first developer beta of iOS 17.5, and in some ways 
brings iOS a lot closer to macOS, where you’ve 

been able to download apps from websites for 
years. However, iPad users will not be able to get 
apps this way, as it’s limited to those using iOS.

Apple is imposing several restrictions on this 
new policy. It only applies to users who are based 
in the EU and any developer wishing to offer 
apps on their website must meet a set of criteria: 
they must have been in the Apple Developer 
Program for a least two continuous years, have 
had an app with at least one million first installs 
on iOS in the previous year, and their apps must 
be notarised by Apple and come with clear data 
collection policies. If they hit those targets, they 
get the green light.

iPad Pro in line for upgrades
SPATIAL 
COMPUTING 
ON YOUR MAC

> The Apple TV set-top 
box hasn’t changed too 
much in recent years, but 
a future update could 
bring a built-in camera 
in a major change to 
the streaming device. 
Bloomberg’s Mark 
Gurman has claimed 
that this camera would 
enable FaceTime video 
calling direct from the 
Apple TV, as well as in- 
air gestures that enable 
you to control it. We’re 
not sure when (or even 
if) these features will 
arrive though.

APPLE 
NEWS 
ROUNDUP

> Apple’s Vision Pro 
headset is all about 
spatial computing, but 
Apple might one day 
expand that concept to 
other devices. A new 
patent suggests just that, 
with Apple discussing how 
future Mac monitors and 
MacBook displays could 
use lenticular lenses to 
show viewers 3D content. 
The best part is this 
wouldn’t even require 
a headset, hopefully 
making it much more 
accessible and affordable 
than a Vision Pro.

e’re expecting a 
new iPad Pro any 
day now, and there 

are rumours of new features. 
Among them, according to a 
leaker known as Instant Digital, 
is a side-mounted selfie 
camera that would make 
video calls less ‘wonky’. 

At the moment, the iPad 
Pro’s front-facing camera is 
mounted on the top of the 
device. This means it’s off to 
the side when you use it in 
landscape mode, which creates 
an odd effect on video calls. 
In landscape, a side-mounted 
camera would be situated at 
the top of the iPad, making 

FaceTime calls a lot more 
natural and comfortable.

Another rumoured 
addition is a matt display. 
This would help to drastically 
reduce reflections and cut out 

blue light, thus helping to 
protect your eyes. There’s a 
chance this matt display could 
use the same nano-texture 
glass as you find in the Pro 
Display XDR, which contains 
small etchings that reflect light 
in different directions and 
away from your eyes. There’s 
no confirmation yet, though, 
so it’s just speculation for now.

Whatever happens, it 
sounds like there could be 
some notable updates coming 
to the iPad Pro. At the time of 
writing, it was expected to be 
revealed in early May 2024 – 
19 months since its last change 
in October 2022.

WHO NEEDS 
A HEADSET?

APPLE TV 
CAMERA

T

W

GESTURE SUPPORT 
AND VIDEO CALLS

The sideloading saga continues apace for Apple

 Image credit: Apple Inc

If you like using the iPad Pro in 
landscape mode, its rumoured 
changes might be just what you need.

Apple will let you download iOS 
apps from third-party websites

Apple has kept a tight grip 
on its app ecosystem, but 
pressure from the EU is 
causing its hold to loosen.
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Media 
Picks
 What you should 

be playing and 
reading this month

[ i O S  A P P ] [ M A C  G A M E ][ i O S  G A M E ]

APP OF THE MONTH

The latest new features coming to this much-loved set of apps

[ A L B U M ]

Audio Vertigo
Elbow
£10.99

 Elbow’s acclaimed tenth 
album blends samba 
percussion, African 
rhythms, indie guitars 
and glittery synths with 
some of the band’s best 
songwriting in years.

[ A U D I O B O O K ]

The Trading Game
Gary Stevenson
£7.99

 Gary Stevenson 
was a successful city 
trader until he started 
questioning everything 
in this “white-knuckle 
journey to the dark heart 
of an intoxicating world”.

[ P O D C A S T ]

Black Box
 As AI becomes ever 

more prevalent, Black 
Box charts the highs 
and lows of this world-
changing tech, from 
medical breakthroughs 
to criminal plots. 

Weather Up — 
Live Widgets
FREE (IAPs)

Weather Up 
combines detailed 
forecasts with a 

friendly interface. Perhaps 
its best feature is its array of 
interactive widgets and Apple 
Watch complications. These 
condense info into glanceable 
views so you know what to 
expect without getting 
bogged down.
Why you need it: It’s mastered 
the art of widgets.

Death Stranding 
Director’s Cut
£34.99

Mac gaming keeps 
getting better, with 
the launch of Death 

Stranding Director’s Cut 
being further evidence. The 
dead are spilling over into the 
land of the living, but hope is 
not yet lost: it’s up to you to 
connect the last survivors of 
a shattered United States and 
try to rebuild what remains.
Why you need it: It’s one of 
Hideo Kojima’s best games.

Having just been 
snapped up by Canva, 
Serif’s popular suite 
of design apps has 

been updated to version 2.4, and this brings 
a range of new features to Affinity Photo, 
Designer and Publisher.

Among the new features is the introduction 
of Layer States to Designer and Publisher. 
Instead of hiding individual layers when 
switching artboards, you can use the new 

States Panel to manage everything. Beyond 
that, Affinity Designer now supports DWG 
and DXF exports for architects, there are 
improvements to object selection tools, and 
all three apps get an Alignment Options panel 
to reduce the hassle of lining up elements with 
different aspect ratios and dimensions.

The changes cement Affinity as one of 
the best choices available for photographers, 
designers and publishers, and the 2.4 update 
is free to anyone who owns a V2 Affinity app.

Recursion
£3.99

In Recursion, 
you are rudely 
awakened by 

the start-up sounds of a 
time-loop machine. If you 
don’t escape, you’re destined 
to have your day reset over 
and over again – forever. The 
latest title from Glitch Games, 
Recursion is a humorous and 
devilishly tricky puzzler that 
rewards creative thinking.
Why you need it: It’s bursting 
with Glitch Games’ humour.

Affinity Suite 2.4 £67.99
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 Image credit: Edifier

> Desktop speakers are increasingly 
rare, which is why we’re celebrating 
the arrival of Edifier’s QR65 Active 
Desktop Monitors. Capable of belting 
out your tunes at a staggering 70W, and 
in old-school stereo too, they’ll look great 
parked on either side of your Mac – with 
either black or white finishes to choose 
from. You also get a choice of 11 different 
3D lighting effects (available by pressing 
a button on the speaker’s side) with other 

customisation options available via 
the Edifier ConneX app for iPhone.

Each rigid MDF speaker cabinet is 
equipped with a 1.25in silk dome tweeter 
and a 2.75in aluminium mid-low driver, 
giving the QR65 a frequency response 
of 55Hz-40kHz. The speakers also have 
Bluetooth 5.3, USB-A and RCA (phono), 
and a subwoofer output onboard.

Completing your dream stereo set-up 
are a pair of angled aluminium stands.

Edifier QR65
> £329.99 > From edifier.com

THE GEAR WE’RE LUSTING AFTER
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Edifier’s QR65 - look out for the review in the July issue.
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> Join the craft beer cognocenti with 
this app-controlled home brewing 
system. Available in Black, Creamy White 
or Mint Green, the iGulu F1 can serve up 
Pale Ale, Bavarian Wheat and Amber Lager 
with a Stout option coming soon. It’ll also 
ferment wine, cider and non-alcoholic 
drinks such as kombucha too. The Gulu F1 
includes both a touchscreen and an iPhone 
app with recipes to get your brews just 
right. And it has temperature control to 
keep your beer fresh for up to 30 days. 
Go on, pour yourself another one.

> Proof that the pen really is mightier 
than the sword, especially when it 
comes with a voice recorder built in.
The Philips VoiceTracer can capture up to 
129 hours of audio recordings to its 32GB 
of built-in storage, with easy transfer to 
your Mac courtesy of its built-in USB-C 
connector. Once your voice notes are on 
your Mac, fire up the Sembly web app or 
Google Chrome extension and your notes 
will be accurately transcribed using the 
power of AI. Naturally, the VoiceTracer 
works as a regular pen too.

> If you often use Apple Maps to get you 
from A to B, this Wireless Magnetic Car 
Charger from ESR could be just what 
you need. Designed to be mounted on 
your car’s dashboard or slotted into one 
of its air vents, it’ll deliver up to 15W of 
charging power to your iPhone 13 or later 
via USB-C or with the supplied USB-C to 
USB-A adaptor. As it’s the first car charger 
to be Qi2 compatible, it’ll also work with 
compatible third-party cases and phones 
too, ensuring your Android-owning friends 
won’t be left in your dust.

> Convenient they may be, but Bluetooth in-ears 
often compromise on sound quality – and that’s a 
serious no-no if you’re serious about your music. 

Enter Campfire Audio whose Fathom in-ears 
promise audiophile pleasures aplenty – and with a 
price tag to match. Armed with six custom-made 
armatures in each earbud, the Fathom eschew 
Bluetooth in favour of wired 3.5mm or 4.4mm 
connections, ensuring you can listen to them using 
your hi-fi or with your Mac.

With a frequency response of 5Hz to 20kHz, they’ll 
sound great with any kind of music. Plus, they’ll be 
comfy to wear with three pairs of marshmallow and 
silicone tips included, as well as a natty leather case. 
Luxury never sounded so good.

> £69.99 > From philips.com

Philips VoiceTracer 
Audio Recorder Pen

ESR Qi2 
Car Charger

iGulu F1 Beer 
Brewing Station

> £35.99 > From esrgear.com> £555 > From igulu.com

Campfire 
Audio Fathom
> £1,049 > From campfireaudio.com
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ABOUT MATT BOLTON
 Matt is Managing Editor at  

TechRadar.com, and previously worked 
on T3, MacLife and MacFormat. He’s 
been charting Apple’s ups and downs 
since his student days, but still hopes 
to hear “one more thing”.

WOULD LIKE TECH DESIGN TO 
GO FULL CIRCLE AFTER 15 YEARS 
AND BRING BACK BATTERIES YOU 
CAN REPLACE YOURSELF

four years someone could easily get an 
AirPods battery replacement pack and make 
the swap themselves, giving their AirPods 
new life? It is possible to replace the batteries 
in AirPods, but it involves specialised gear 
and soldering skills. It’s tricky enough that 
people will wonder whether it’s worth the 
hassle and expense of doing it; while if you 
own the Fairbuds, it’s a no-brainer, because 
it’s so little effort.

I worked in an Apple repair store 
when we still had replaceable batteries on 
MacBooks, and if someone’s old machine 
could no longer stay awake, we could just 
drop in a new battery. Of course, battery 
chemistry has improved massively, but the 
fundamental issue hasn’t gone. And in that 
time, the sustainability impact of the tech 
world has become a hotter and hotter topic, 
and Apple has positioned itself as a leader in 
the area, including in recycled materials. But 
even better than recycling is less e-waste to 
begin with, and I’d love for Apple to pick up 
this area where Fairbuds are leading.

hile I am far from the first person to suggest 
that swappable batteries should become a part 
of gadget design again, it came to my mind again 

recently thanks to the launch of Fairphone’s Fairbuds. 
These are true wireless earbuds (like AirPods), but the user 
can replace the battery in both the buds and case. They aren’t 
hot-swappable batteries to provide longer nearly unbroken 
listening time – they take a little too much effort for that – 
but they can be swapped by anyone in a matter of minutes. 

This core issue being addressed here isn’t convenience 
(though there’s no question that if you could pop a fully-
charged battery straight into your iPhone or Apple Watch 
when needed, that would be really handy), but sustainability. 
AirPods, along with all the other big earbuds, aren’t designed 
to be easily repairable. They have mini computers, complex 

speaker arrangements 
and an array of mics built 
into a tiny amount of 
space around a battery 
unit, and – ideally – 
they’re waterproof. 
Just sealing that 
whole unit closed is an 
understandable route to 

take. And if that creates a protective effect that means that the 
processing and speaker parts can last for years, then it doesn’t 
seem like too much of a problem… apart from the batteries. 

Battery chemistry fails. It’s not if, it’s when. And that 
when is generally about two years with current battery tech. 
Maybe not a total collapse at two years, but a deterioration of 
charge capacity will begin, and it can make earbuds annoying 
to use pretty quickly. Apple attempts to mitigate this in 
AirPods, Macs and iPhone with its optimised charging option, 

but even that is delaying the 
chemically inevitable.

AirPods Pro 2 are a pretty 
mature version of this product at 
this point, and there’s no reason 
hypothetically that someone 
wouldn’t be able to buy a pair and 
enjoy them for over five years. But 
the odds of the battery still holding 
up aren’t so good. Wouldn’t it be 
better if, instead of going to landfill 
or a limited recycling option, after 

The core issue is 
sustainability. Battery 
chemistry fails. It’s 
not if, it’s when

W

One screw is all you need to swap the battery in the 
Fairbuds’ case. Almost seems too easy, doesn’t it?

Wouldn’t it be useful to drop a new battery 
with two days of charge into your Apple 
Watch when you need it?

 Image credit: Apple Inc, FairPhone
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The key stats and facts behind Apple’s annual WWDC

 Image credit: Apple Inc

4,200
> Number of delegates 
who attended the 2006 
WWDC, where Apple 
said goodbye to the 
PowerPC processor 
and hello to the Intel 
Xeon-powered Mac Pro.

1983
> The first year Apple 
held what’s become one 
of the most important 
events in its calendar.

Apple’s Worldwide Developers Conference in

10-14 
June
> Date of this year’s 
WWDC, which will be held 
both online and at Apple 
Park. Expect to see new 
versions of macOS, iOS 
iPadOS, watchOS, tvOS 
and visionOS, as well as 
an AI-powered Siri.

23 million
> Number of registered developers from 155 
countries and regions eligible to participate in 
Apple’s online-only WWDC in 2020. Over 100 
engineering sessions were available, with over 
1,000 Apple engineers taking part.

> Time it took for $1,599 
developer tickets to sell 
out at WWDC 2012. The 
event saw the launch 
of Apple Maps, OS X 
Mountain Lion and iOS 6.

1 hour, 
43 mins

> Number of possible winners for the Swift 
Student Challenge, which has taken place 
every year since 2020. The programming 
contest is open to students aged 13 or over.

350

5,000
> Number of attendees at 
WWDC 2019 – the last fully 
in-person event before the 
pandemic. Delegates came 
from 86 countries to San 

Jose in California.
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HOMEKIT CONUNDRUM
Your Beginners Guide ‘Automate your smart 
home’ (#MF403) was invaluable. However, 
I seem to have come across an unspoken 
challenge in the installation of smart home 
devices which require/use Matter. The issue 
is associated with the Wi-Fi router which I 
have discovered also needs to support the 
protocol. The requirement is not mentioned 

in your article or identified on the Eve website, whose devices I have been 
using. If my experience is typical it would appear routers provided by 
ISPs are generally not compatible!

Over the years, I have installed a number of Eve devices which have 
worked very well. Recently, I purchased and attempted to install an Eve 
Motion which requires a ‘compatible Thread border router’. To ensure 
this compatibility I also purchased a HomePod mini. 

The conclusion from attempting the installation, and having had 
extensive email communications with Eve technical support, is that 
my existing router does not support the required protocol, or more 
specifically to quote Eve Systems “mDNS/multicast and IGMP Snooping 
(if available) are not enabled”.

Given that I am soon to be served by FTTP (fibre to the premises), 
I checked if the router that would be provided with that service would 
be compatible. To my horror, the FAQ for the router – a LinkSys SPNMX55  
– states “Does the node support Apple HomeKit? – No”.

I asked Eve technical support if they had a list of Wi-Fi routers proven 
to be compatible with the Eve Motion and Apple Home. The answer was no.

Is this problem, which appears to me to be the incompatibility of Wi-Fi 
routers with Matter, commonplace? And, if so, is it worthy of comment in 
either Genius Tips or one of your articles?
by T  M A R T I N

ROB SAYS… 
HomeKit-compatible routers are still something of a rarity, despite 
Apple launching its HomeKit Secure Router program in 2019 (although, 
according to some reports, it also seems to have abandoned it). On its 
Apple Support page (bit.ly/mac404homekitrouters), Apple lists only 
two routers as being HomeKit compatible: the AmpliFi Alien (£399.95) 
and the Linksys Velop AX4200 (£259.95), both of which are available 
through the Apple Store. 

While most HomeKit products should work fine when teamed with a 
Thread border router such as the HomePod or HomePod mini, there are 
exceptions – we’ve never been able to get the Eve Motion to work on our 
smart home system either. There is a wider issue too with ISP-supplied 
routers, both when it comes to HomeKit and because they often have 
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limited functionality and features. Where 
possible, we’d recommend you replace your 
ISP-supplied router with something more 
capable, although we appreciate that it’s not 
always possible – or desirable – to do that.

TO CROP OR NOT TO CROP
In #MF403, Steve Sanford asked about 
cropping a screenshot before it’s saved, and 
Rob, the editor, replied that it wasn’t possible 
on iPads. Not true actually! Screenshots can 
be very quickly cropped beforehand using 
Gestures. Go to Settings > Multitasking & 
Gestures and make sure ‘Swipe Finger from 
Corner’ is set to on. Then select Screenshot 
from the drop-down menu for Bottom Left 
Corner (or Right). Once that’s set, any time 
you want a screenshot, swipe up from 
whichever corner you chose. Then quickly 
drag the handles of the shot to the part of 
the image you want to keep, and tap Done.

I use it all the time, and my only complaint 
is the file size of Apple screenshots. If they’re 
opened and then saved in ACDSee, they’re 
often several MBs smaller, while looking the 
same. If only Apple gave us a choice of file 
size for screenshots…
by A L I S O N  N A PI E R

ROB SAYS… 
We’re happy to be corrected – thank you for 
sharing that very useful tip. It just goes to 
show there’s always something new to learn!

 Contact us

 Email your queries  
and your questions to 
letters@macformat.com
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Go to Settings > Multitasking & Gestures > Swipe Finger From 
Corner > Screenshot to crop screenshots before saving.
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pple is no 
stranger to legal 
and regulatory 
challenges, but 

things have gone up a gear 
recently. You can read about 
some of those issues, like the 
controversy around sideloading 
in #MF402, and other previous 
issues of MacFormat. Those 
actions were predominately 

based in the EU. Now, though, 
the US justice system has its 
sights on Cupertino.

On 21 March, the US 
Department of Justice Antitrust 
Division filed a case in New 
Jersey against Apple. The 
88-page document starts by 
explaining that “for many years, 
Apple has built a dominant 
iPhone platform and ecosystem 

A

Regulators around the world are 
coming for Apple. We take a look 
at the challenges it faces
WRITTEN BY CHARLOTTE HENRY  
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that has driven the company’s 
astronomical valuation.”

It adds that Apple decided to “meet 
competitive threats by imposing a series 
of shapeshifting rules and restrictions 
in its App Store guidelines and 
developer agreements that would 
allow Apple to extract higher fees, 
thwart innovation, offer a less secure 
or degraded user experience, and 
throttle competitive alternatives.”

Later, the document alleges that 
the company “wraps itself in a cloak 
of privacy, security, and consumer 
preferences to justify its anti-
competitive behavior.” This comment is 
worth remembering as we explore the 
issue. It is the one most likely to rankle 
Apple leadership as it essentially boils 
down to an allegation of hypocrisy.

The fundamentals
In some ways, what the DOJ appears 
to dislike about Apple are the very 
characteristics that have become 
fundamental to the company. They are 
born out of its inception, from when 
Steve Jobs and Steve Wozniak first 
combined forces and the respective 
roles were taken up by the two men. 

In his biography of Jobs, Walter 
Isaacson explains how the partnership 
developed, even from the early days:

“Wozniak would be the gentle 
wizard coming up with a neat invention 
that he would have been happy to just 
give away, and Jobs would figure out 
a way how to make it user-friendly, 
put it together in a package, and make 
a few bucks.” But it’s that user-friendly 
nature and ability to package products, 
as well as making money, that has 
ultimately caught the eye of regulators 
around the world.

The DOJ filing provides examples 
of alleged wrongdoing, some of which 

readers will be familiar with. They 
include, for instance, the cut Apple takes 
from third-party App Store purchases 
and subscriptions. But this is not just an 
App Store issue. Some of the allegations 
revolve around the way Apple 
hardware interacts with each other. 

The DOJ says that “by suppressing 
key functions of third-party watches – 
including the ability to respond to 
notifications and messages and to 
maintain consistent connection with 
the iPhone”, Apple is reducing the 
draw for consumers to buy other 
smartwatch brands.

The argument put forward by 
the DOJ is logical and coherent. 
As highlighted with the Apple 
Watch example, the heart of 
the action boils down to the 
accusation that it is hard to leave 
the iPhone world because it is 
complicated and costly to do so, 
and that this situation has been 
intentionally engineered. This is bad for 
consumers and the tech industry as a 
whole, according to those taking action.

Lee Hepner, Legal Counsel at 
the American Economic Liberties 
Project which looks to argue against 
monopolies, backs that argument. 
He explained to MacFormat that 
“the DOJ’s case includes extensive 

It has been alleged that Apple suppresses 
the key functions of other smartwatches 
when it comes to iPhone compatibility.
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allegations that Apple has created high 
switching costs, which essentially lock 
consumers into Apple’s product ecosystem, 
to the detriment of innovation and product 
quality across industries.”

“Over 90% of iPhone users replace their 
smartphone with another iPhone, and that 
includes consumers who would otherwise be 
inclined to switch to another device but find 
it too difficult or costly to switch between 
walled off product markets,” he said.

“The case against Apple is about lowering 
those barriers so that consumers have a 
meaningful choice in the marketplace,” 
Hepner added. “When you give consumers 
a meaningful choice – which Apple’s high 
switching costs prevent – companies 
must compete by offering higher-quality 
and competitively priced products.”

This is all, of course, the exact opposite 
of what Apple claims it is doing. It has long 
insisted that the walled garden it has built 
is to the benefit of customers, creating a 
controlled environment that provides a 
better experience, alongside security and 
privacy for users. No product launch or 
event goes by without these points being 
made at every juncture.

Mitch Stoltz, IP Litigation Director at 
the Electronic Frontier Foundation (EFF), 
does though take a similar view to that put 
forward by Hepner. In a statement, he said:

“This antitrust suit against Apple is 
timely and welcome. Apple’s anticompetitive 
practices, like barring competing app stores, 
blocking secure messaging with Android 
devices, and limiting the functionality of 

competing apps and smartwatches, all while 
keeping users locked into the iOS platform, 
have hurt innovation and made consumers 
poorer. We are happy to see that this suit by the 
DOJ [and states] focuses on the importance of 
interoperability between devices and software 
from different vendors, and how Apple’s efforts 
to block interoperability have hurt consumers.” 

Specifically talking about the issue of 
security, Stoltz said:

“This suit says what EFF has been saying 
for a long time: Apple only protects users’ 
privacy and security when that protection 
is good for Apple’s bottom line. Apple’s 
argument that monopoly is safer for users 
than competition is wrong, and is contrary 
to a century of antitrust law.”

However, some experts do seem to have 
some sympathy with Apple’s argument 
regarding their ability to better protect 
customers due to the design of its ecosystem. 
Danny Rogers, CEO of the cybersecurity 
company iVerify, told The Verge:

“Our data from millions of device scans 
on iOS and Android devices around the world 
suggests that open app stores lead to more 
malicious activity than closed ecosystems. So 
while opening up app stores to third parties 
might be good for competition, it will likely 
increase malicious activity as well.”

Helping out rivals
There are other, perhaps more philosophical, 

questions to ponder – why shouldn’t Apple 
build an ecosystem in which its hardware 
products work best with each other? Why 
should it help out its rivals? 

 Image credit: Apple Inc18 | MACFORMAT | JUNE 2024

Apple takes a cut from 
subscriptions and in-app 
purchases on the App Store…

The iPhone may be incredibly popular, but it’s far from being the only smartphone available. 

… but then developers 
make revenue from selling 
on Apple’s platform.



Uncle Sam vs Apple APPLE 

In simple terms, effective markets, should 
produce healthy competition prompting 
innovation and improvements whilst also 
lowering prices. And this, in turn, is beneficial 
for the consumer. There is no doubt that 
high-end smartphones, both iPhone and 
Android, are expensive. However, there remain 
cheap alternatives on the market. Apple just 
doesn’t want to make them.

Other smartphone makers can compete with 
Apple to try and win people over at premium end 
of the market. Indeed, if you look at some of the 
innovative camera products being offered by 
Samsung it is clear that they are. Yes, it is a bit 
fiddly moving between iPhone and Android, but 
that cuts both ways, and if the incentives are 
there for the customer, ie, the Android phone is 
noticeably better or better value, plenty will 
surely make the leap.

While Apple products are, by and large, 
more expensive than those of their rivals, most 

of us Apple fans benefit from their tight 
integration. It’s easy to move from one iPhone 
to the next; your Apple Watch can instantly 
unlock a new MacBook Air, and you can easily 
control the audio playing from your iPhone to 
your AirPods Pro via Siri.

It’s hopefully a given that a company is going 
to design its products to give customers the best 
possible experience. While the arguments put 
forward around the costs of leaving the 
ecosystem are reasonable, it is not impossible to 
do so. Plenty of people choose not to use iPhones. 
And, of course, Google and the like get revenue 
from subscriptions and in-app purchases made 
through the App Store…

It also seems that, to some extent at least, 
Apple is being punished for its success and the 
quality and reliability of the ecosystem it’s 
created. An ecosystem which generally makes 
technology easier to use.

The DOJ filing says that Apple has built a 
“moat around its smartphone monopoly” that is 
“wide and deep”. Furthermore, it alleges that “it 
uses a similar playbook to maintain its monopoly 
through many other products and services”. 

The criticism includes claims that “Apple has 
impaired third-party location trackable devices 
that fully function across platforms” and it has 
“impaired third-party, cross-platform video 
communications apps whilst steering users to 
its own video communications app, FaceTime.” 

And the list of allegations goes on…

Driven to succeed
While it’s easy to criticise some of Apple’s 
practices, the tech giant is also hugely successful 
at what it does – creating products that we all 
love to own and to use.  

The iPhone has achieved its popularity, not 
by barging rivals out of the way, but by creating 
premium products that offer high-quality user 
experiences. Time and again in product surveys, 
Apple and its iPhone score incredibly highly. 
That has led 1.334 billion people worldwide to 
choose an iPhone over any other smartphone, 
according to Statista – yet that figure still only 
represents 23% of the entire global market. In 
the US, the story is different, true, with iPhone 
accounting for 62%, but even that points to its 
popularity, not its monopoly.

Whatever your view, it is clear that regulators 
around the world are not going to give up in their 
pursuit of Apple. The end result of its latest 
challenges could be to fundamentally change 
the company and its products, and that could be 
both a good thing and a bad thing for consumers.

JUNE 2024 | MACFORMAT | 19 Image credit: Apple Inc

There’s a good reason why the Apple Watch has been so successful – it’s the best wearable by far.

Developers on the App Store and Mac App Store adhere to strict regulations from Apple.

The AirPods Pro work in perfect 
harmony with iPhone.
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Having trouble with your Mac? 
This expert guide will equip you 
with the know-how you need to 
get it running smoothly again
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ne of the reasons 
we love our Macs 
so much is they 
just work. There’s 
no need to worry 

about clashing hardware, software 
compatibility or a host of other 
irritations that plague users of 
other computers. You know exactly 
where you’re at with a Mac.

Yet this doesn’t mean they 
won’t ever give you problems. With 
a machine as complicated and 
advanced as a Mac, a few issues are 
bound to arise from time to time. 
Thankfully, they’re often simple – 
and inexpensive – to resolve. 

Mac problems are usually 
software issues, and can be fixed 
at home, without taking your 
computer to the Genius Bar at your 
local Apple Store. Likewise, issues 
with your files can be fixed quickly 
and easily, and if an individual file 
has been deleted or has corrupted, 

you can retrieve it using your 
backups; we show you how to do 
this. We also show you how to fix 
iCloud issues, and squash problems 
you might be having with your 
home or small business network. 
Finally, we look at hardware 
hiccups you might have with your 
peripherals and accessories. Are 
your Bluetooth speakers not 
playing nicely with your MacBook? 
Is your new external drive not 
recognised when you plug it into 
your Mac? Our straightforward 
tips show you exactly what to do.

And remember, if you can’t 
solve your Mac problems yourself, 
the Genius Bar is always an option. 
Go to apple.com/retail/geniusbar 
to make an appointment at your 
local Apple Store. The experts 
there can solve almost any Mac 
problem, and unless they have 
to physically take it apart, the 
fix is often free.

The Golden Rule: Restart your Mac

If you’re having problems 
with your Mac – or any other 
piece of technology – the first 
thing you should do is turn 
it off, count to 20 and then 
turn it on again. Restarting 

your Mac in this way frequently 
fixes issues. Likewise, if it’s an 
application that’s not behaving 
as it should, quit and reopen it. 
You’ll be surprised how many 
times this works.
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Having problems with your computer? Follow these tips…

 Image credit: Apple Inc

Help! My Mac is broken!

macOS and the apps that run on it are 
very reliable, but given the complexity 
of today’s software, it’s inevitable that 
a few bugs will creep in. These bugs are 
squashed by free updates, so it’s 

important to keep your apps and macOS 
up to date with the latest bug fixes. Click 
on the Apple icon, and if App Store or 
System Settings is captioned ‘[X] 
updates’, select that option and update.

If an app has crashed with the 
spinning beachball, or simply 
isn’t behaving as it should, quit 
it and relaunch. If Cmd+Q doesn’t 
work (which is highly likely if it’s 
crashed), click the Apple icon in 
the top left of the menu bar and 
select Force Quit. Alternatively, 
press Cmd+Opt+Esc. In the Force 
Quit Applications window that 
appears, select the app that’s 
giving you trouble and click the 
Force Quit button.

We’ve all seen them. Those 
irritating error windows that pop 
up while you’re trying to do 
something on your Mac are never 
welcome, but if you know how to 
read them, they can tell you much 
about what’s gone wrong. 

Error code –36, for example, 
occurs when copying files, and 
Error code –500 means there’s 
a problem with an App Store 
download. There’s a great article 
on error codes and what they 
mean at macpaw.com/how-to/
mac-error-codes-guide.

If your Mac is having trouble booting 
up, try starting it in Safe mode. This 
disables all startup items and third-party 
design features. If your Mac has an Apple 
silicon chip, press and hold the Power 
button on your Mac until you see 
‘Loading startup options’. Choose your 

startup volume, hold the Shift key and 
click ‘Continue in Safe Mode’. If it has an 
Intel processor, restart and press and 
hold Shift until you see the login window. 
Log in (maybe twice) and you’ll boot in 
Safe mode. Then investigate which app 
is causing the problem.

Disk Utility
Disk Utility (Applications > 
Utilities) is great for fixing 
drive issues. Click on the drive 

in the left-hand side panel, and click First 
Aid in the toolbar. You can also mount, 
partition and reformat drives.

The Console
Also in Applications > Utilities, 
Console gives access to crash 
reports, logs, diagnostic info, 

system logs, etc. This provides valuable 
info for technicians. You can copy and 
paste it into an email or on a forum too.

How to squash those bugs

Problems booting your Mac

Force Quit a 
misbehaving app

Mac error codes

Useful Problem-
Solving Apps
These apps are useful for finding 
and fixing issues. The first three 
are bundled with macOS, so you 
already have them.
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Try freeing up some storage space. 
Look through your Mac’s storage drive 
for apps you no longer use, files you no 
longer need and media you no longer 
want. Move them to the Bin, then empty 
it; if it’s not emptied, the files still take up 

space on your Mac. Photos, iMovie and 
Mail have their own bins. Remember to 
empty these too. CleanMyMac X is great 
for identifying files you’ve not opened in 
a while, as is DaisyDisk (shown above, 
daisydiskapp.com).

Open Disk Utility from 
Applications > Utilities. 
If you can’t start your 

Mac properly, use Recovery 
Mode. For Apple silicon Macs, turn 
on and hold the Power button 
until you see the startup options 
window. Click the gear icon 
labelled Options, then click 
Continue. For an Intel processor, 
turn on your Mac then press and 
hold Cmd+R until you see an 
Apple logo. Either way, you then 
enter your password if asked, 
then from the Utilities window, 
select Disk Utility.

Select the drive you want to 
check in the sidebar, then click 
First Aid in the toolbar. In the 
window that opens, select Run 
and the checks are made. If you’re 
offered a Repair Disk button, 
choose it and Disk Utility attempts 
to repair your drive. This might be 
as simple as ignoring damaged 
sectors in the future.

When you’re done, if you 
opened Disk Utility as normal, you 
can close it. If you did so through 
Recovery, restart your Mac.

Run Apple Diagnostics. On an Apple 
silicon Mac, press and hold the Power 
button to turn on your Mac. When you 
see Options, release the Power button 
and press and hold Cmd+D. On an Intel 
Mac, turn it on and immediately press 
and hold the D key. Release it when you 

see a progress bar or you’re asked to 
choose a language. If using the D key 
doesn’t work, press and hold Opt+D 
at startup instead. Apple Diagnostics 
checks your Mac for issues. There’s a list 
of useful diagnostic reference codes 
here: support.apple.com/en-gb/102334.

Activity Monitor
Another app found in Utilities, 
Activity Monitor shows processes 
that are active on your Mac. If your 

computer isn’t running as it should, a check 
here might identify an app that’s using too 
much memory or CPU processes, for example.

CleanMyMac X
CleanMyMac (macpaw.com) is an 
excellent all-round maintenance 
tool. It can get rid of system junk, 

identify large files you’ve not opened in a 
while, clean-uninstall apps, securely delete 
confidential data files and more.

My Mac is running S-L-O-W-L-Y

I’m having hardware issues

How to use 
Disk First 
Aid and 
Recovery
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Lost a file? Opening with the wrong app? We solve all this and more

 Image credits: Apple Inc, Tekkie OU/Anyakichi

Help! I’m having file problems

If a document won’t open, it might 
be corrupted. If this is the case, you 
might have to delete it and obtain a 
working copy. But if it won’t let you open 
it or it opens but won’t let you edit it, 
Ctrl-click on the file and select Get Info 

from the menu. The Information window 
opens. Click the chevron next to Sharing 
& Permissions at the bottom, and make 
sure you have Read & Write privileges. 
Change them if necessary; you will need 
your admin password.

If a file is stored in iCloud Drive, 
you’ll be able to access it from 
any Apple device that’s signed 
into your Apple account, and 
computer or mobile device with 
a web browser by logging into 
iCloud.com and signing in. 

To access your iCloud Drive 
from your Mac, open a Finder 
window and click iCloud Drive in 
the sidebar. There are already 
folders in there, for apps such 
as Pages, Numbers and Keynote. 
You can also create new folders 
and drag files into and out of 
iCloud Drive just like you would 
with any other Finder window.

Clean system files

Store in iCloud

Sometimes, non-Apple 
devices and third-party 
peripherals fail to open 

archives made on a Mac. This 
might be due to system files that 
are invisible on the Mac, but can 

cause problems for non-Apple 
gear. Their file names begin with 
a dot, and they set things like 
where icons appear in a folder 
window. To make an archive 
without these files, download 

CleanArchiver (bit.ly/
macupdatecleanarchiver) and 
make the archive with that 
instead of macOS’ own archiver. 
This will be devoid of Mac 
resource forks.

I can’t access a file

1Open the Info window
You can change which app opens 

a file. Ctrl-click on the file, and choose 
Show Info from the window that appears. 
This shows a range of information about 
the file. You can lock it, change the file 
name and more from here.

2Open in another app
If it isn’t already open, click the 

chevron next to ‘Open with’, near 
the foot of the window. By default, 
this shows the default app that opens 
the file; simply choose the app you’d 
prefer to open it with.

3Change all apps
If you want to change every file of 

that type to open in the other app, click 
the Change All button. If you only want 
to open the file in the other app once, 
Ctrl-click on it and select it from the 
Open With option.

How to Change file associations > 
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I can’t AirDrop files
Make sure both your 
Mac and the device 
you’re trying to 

AirDrop to have Bluetooth and 
Wi-Fi switched on. Next, ensure 
they’re connected to the same 

Wi-Fi network, and within 30 feet 
(10 metres) of each other. When 
you try to AirDrop a file, you see 
a radar-like window showing 
nearby devices, listed by name. If 
the person/device you’re trying 

to AirDrop to isn’t shown, speak 
to the person who owns it and 
make sure they’ve switched 
AirDrop on and their device is 
unlocked. Their icon should then 
appear in the AirDrop window.

1Open Settings
By default, Spotlight indexes and 

searches all attached drives as well 
as your Mac’s internal drive, but there 
are some that you might not want to 
be covered, such as backup drives. 
Open Settings > Siri & Spotlight.

1Open Spotlight
To open your Mac’s Spotlight window, 

click the magnifying glass in the menu 
bar or (if available) on the Function keys, 
or hold Cmd and tap the Space bar. Type 
in the name or partial name of the file 
or app you want.

2Take some options off
Scroll up and click the Spotlight 

Privacy button. A window titled ‘Privacy’ 
appears. Click the ‘+’ icon in the bottom-
left of this window, and select a drive or 
folder you don’t want to be covered by 
Spotlight to add it to the list.

2Find in Finder
You get a lot of results, including 

images, suggestions for searches, file 
names, websites, Mail messages and 
more. To search for that term in Finder, 
scroll to the bottom of the Spotlight 
search and choose that option.

3Remove drives/folders
You can add as many files and 

folders to this Privacy window as you 
wish, though Time Machine drives cannot 
be added. To remove a drive or folder 
from the list, click on it and click the ‘–’ 
button (bottom left).

3Customise Spotlight
In Settings > Siri & Spotlight, you 

can choose which categories of files, 
documents and data are indexed 
and searched for in Spotlight. Simply 
use the checkboxes to activate or 
deactivate a category.

How to Hide drives from Spotlight > 

How to Find files faster with Spotlight > 
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It’s always wise to back up regularly, but what if you have problems?
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Help! My backups are broken
o you have too many 
backups, or not enough? 
Can you easily recover from 
the backups you do have? 
Here we talk you through 

how you can create and restore from Time 
Machine backups, and also how to clone 
your internal and external drives using 
third-party apps. We strongly recommend 
you use both Time Machine and drive 
cloning apps. Time Machine is great for 
delving into to retrieve a file deleted in error, 
or for restoring your Mac from a previous 
backup. Cloned backups, on the other hand, 

are kept in exactly the same state as 
the drive you’re cloning. Therefore, if 
the original drive ever fails, you’ll have 
an exact copy of it.

Here’s a quick tip about Time Machine. 
If you need to recover an accidentally 
deleted file, or one that’s been edited and 
you need an older version, open the Finder 
window where it is – or was – stored. Open 
Time Machine and navigate to the time and 
date when the file you want was present, or 
before the edit. Click on it, then click the 
Restore button to recover the file, or an 
earlier version of it. 

iDrive
>About £95/year  
> idrive.com

>Another cloud 
backup service, 
you can back up 

multiple devices to a 
single account, manage 
your data with a web 
interface and more. iDrive 
retains up to 30 different 
versions of a file too, so you 
can recover historical data.

Backblaze
>About £7/month 
>backblaze.com

>Backblaze 
automatically 
backs up all 

files including documents, 
photos, music, movies and 
more to the cloud. Even if 
your computer and its drives 
are stolen or destroyed, 
your backups will be safe 
and accessible.

Get Backup Pro
>£28.50 >belightsoft.com

> Get Backup 
Pro lets you 
back up and 

archive your data, clone 
your drives and sync 
folders and drives. Quickly 
back up data, create 
bootable and encrypted 
backups, sync folders, and 
be confident that your data 
is safely stored.

SuperDuper!
>£27.25 > shirt-pocket.com

>Another 
cloner, 
SuperDuper! 

offers a clear and friendly 
interface, scheduled 
backups, smart delete, 
native Notification Centre 
and more. Whether you go 
for SuperDuper! or Carbon 
Copy Cloner is largely a 
matter of preference.

Carbon Copy 
Cloner
> £40.85 >bombich.com

> Clone your 
Mac’s hard 
drive, or your 

external drives. You can 
back up anything from a 
single folder to a complete 
hard drive, and schedule 
backups so they’re always 
up to date. It’s an excellent 
backup application.

5 other ways to back up your Mac 

With Time Machine, you can recover a single 
file or folder which you’ve subsequently 
deleted or incorrectly modified.

D

Backup frequency
To change Time Machine’s backup 
frequency, open System Settings and 
click on General in the left sidebar. In 

the right-hand pane, click on Time Machine, then 
Options. Choose how often backups are made 
from the Backup Frequency menu.

Incremental backups
Modern backup apps offer incremental 
backups. This means after the first backup, only 
files and folders that are new or have changed 
are copied to your backup. The first backup 
takes a long time as all your data needs to be 
copied; after that, backups are much quicker.
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1Plug in the drive
Plug in the external drive you’re going 

to use for Time Machine. It will be wiped 
for the process, so make sure there’s 
nothing on it that you need. Open System 
Settings from the Apple menu, and go 
to General > Time Machine.

4Limit backup space
Under Disk Usage Limit, choose 

Custom if you want to limit the amount 
of space your Time Machine backup can 
use on your drive. Never put data and its 
backup on the same drive, though, or 
both will be lost if the drive fails.

7Restore (Intel Mac)
To restore your Mac from a Time 

Machine backup, you must enter 
Recovery mode. If it has an Intel 
processor, turn it off and press the 
Power button while holding Cmd+R. 
Release it when you see the Apple logo.

2Choose a drive
Click Add Backup Disk. You’ll see 

a list of connected drives available for 
Time Machine backups. Click the one 
you want to use, and then click Set Up 
Disk to proceed to the next step about 
choosing whether to encrypt it or not.

5Start the first backup
When you’re ready, click Done. The 

drive is prepared, and the first backup 
starts. You can click the Options button 
to change the frequency of future 
backups, which can be manual only, 
hourly, daily or weekly.

8Restore (Apple silicon)
If your Mac has an Apple silicon 

chip, turn it off, then press and hold the 
Power button. Release the Power button 
as soon as you see the startup options 
on the screen. Now click Options to 
proceed to the next step. 

3Encrypt your backup
If you want to encrypt your backup, 

add a password, retype that password, 
and add a hint. Encrypted drives require 
a password to access. If you don’t want 
to encrypt, click the switch marked 
Encrypt Backup to turn encryption off. 

6Exclude from backups
If you have files or external drives 

you don’t want to back up with Time 
Machine, under Options, click the ‘+’, 
navigate to the item you want to leave 
out and then click Exclude. To change 
your mind, click the ‘–’.

9Enter your details
Whichever processor you have, 

enter your username and admin 
password when asked to do so. From 
the Utilities list, choose the ‘Restore 
from Time Machine’ option and follow 
the on-screen instructions.

How to Back up and restore with Time Machine >
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e all know iCloud is 
pretty reliable, but 
what can you do if 
files aren’t syncing 
properly across your 

devices? How do you cope if your 
iCloud storage is full? And what if 
you’re receiving too much spam to 
your iCloud email account? None of 
these problems are insurmountable. 

If you have issues with iCloud Drive 
not syncing reliably, for example, first 
of all try restarting your Mac. It might 
be as simple as that. Secondly, check 
the date and time are correct. If they 
aren’t, go to System Settings > General 
> Date & Time. If it’s set automatically, 
turn this off and on again. If not, 
correct it manually. Make sure you 
have enough space on your iCloud and 
also your Mac, as files are also stored 
locally. Finally, go to System Settings > 
Apple ID, and sign out then sign in 
again. Chances are one of these tips 
will solve your problems.
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Like your Mac, iCloud just works, but some problems can occur

Help! I’m having iCloud issues

 Image credits: Apple Inc, UpDownSideways LLC

Is iCloud down?
Think there might be a problem with 
Apple’s iCloud servers? Point your web 
browser at downforeveryoneorjustme.com, 
enter iCloud.com in the search field and click 
the ‘or just me?’ button. You’re told whether 
iCloud is down for everyone or only for you.

Where’s my iCloud Drive?
iCloud Drive isn’t in your Finder window’s 
sidebar? To open it, click on the Desktop 
to bring Finder to the fore, click Go and 

choose iCloud Drive. If you want it back in the 
sidebar, click Finder in the menu bar, open Settings  
> Sidebar and tick its checkbox.

W
If you’re out of space and you 
don’t want to delete anything 
from your iCloud Drive, change 
your storage plan. Open System 
Settings, and navigate to Apple ID 
> iCloud. The graphic at the top 
of the window shows how much 
space you have and what is stored 
there. Click the Manage button, 
then Change Storage Plan; 
you can buy more storage 
for a monthly fee. Remember, 
a subscription to Apple One 
also includes iCloud storage.

I’m out of space 
on iCloud Drive

In Mail, click Mail in the menu bar, then 
choose Settings, and turn on Protect 
Mail Activity. This works by hiding your 
IP address and loading remote content 
privately in the background, even when 
you don’t open the message, making it 

harder for senders to follow your Mail 
activity. You can also do this by going 
to iCloud.com/mail; click the gear icon 
in the left-hand sidebar, choose Settings 
> Privacy & Security and turn on Protect 
Mail Activity here.

My iCloud email is getting spammed

If your Mac’s iCloud Drive isn’t syncing 
properly, there are several tips to try, including 
signing out of your Apple ID and back in again.





FEATURE Fast fixes for Mac

30 | MACFORMAT | JUNE 2024

Is your Mac having trouble on your home network? Try these tricks

 Image credits: Apple Inc, AVM Computersysteme Vertriebs GmbH, ASUSTeK Computer Inc, Google LLC, TP-Link Corp Ltd

Help! My network won’t work
hese days, we rely on our 
home networks more 
than ever, especially 
when working wirelessly, 
remotely or from home. 

Macs are easy to connect to home 
networks with Wi-Fi, but you can still 
encounter problems. Here we explore 
some of the more common issues, what 
you can do to identify and address them 
and how sometimes switching things off 
and on again is the only thing that works. 
Seriously. If you can’t get on to the 
internet, or communicate with other 

devices on your network, your first step 
should be to turn off the router, count to 
20 and turn it on again. You’ll be amazed 
how often this solves the problem.

Another thing to try early on is 
Apple’s Wi-Fi Diagnostics. Quit all open 
apps. Press and hold Option on your 
keyboard, and click the Wi-Fi icon in 
the menu bar. The menu that appears 
is larger than the one you get if you click 
the icon without holding Option. Choose 
Open Wireless Diagnostics, and follow 
the on-screen instructions for a 
complete diagnostic of your network.

If turning your router and your Mac off and then 
on again doesn’t work, try running macOS’ built- 
in diagnostics to find where the problem is.

Get a repeater
If your Wi-Fi coverage doesn’t reach the 
furthest corners of your house, get a repeater 
(or an extender). It connects to your router 
and repeats/extends your network’s reach by 
offering another wireless access point. The one 
shown here is an AVM FRITZ!Repeater 6000.

Join a hidden network
If you can’t see a Wi-Fi network, it may be 
hidden. To connect to it, click the Wi-Fi icon 
in the menu bar and select Other Networks. 
Type the network’s name when prompted, 
then choose the type of security it uses. 
Finally, enter your login details and click Join.

T

AVM Fritz!Box 
7590
>About £285 > en.avm.de
>An awesome and 
feature-packed ADSL 
router. It features Wi-Fi 6, 
four Ethernet ports, two 
USB ports and support for 
up to six wireless DECT 
phones. If you have full fibre 
broadband, you can connect 
it to your fibre modem too.

Asus ZenWiFi  
AX (XT8)
>£234.99 >asus.com/uk
>With wireless coverage 
of up to 230 square 
metres, this router should 
get you connected all over 
the house. Available in 
black or white, it comes with 
Wi-Fi 6, very fast speeds and 
excellent security features. 
Definitely worth considering.

AVM FRITZ!Box 
5590 Fibre
>About £285 > en.avm.de
>This solid, dependable 
fibre optic router can 
replace the router and 
modem for your full fibre 
connection. Although only 
if your ISP allows the use of 
third-party modems. It offers 
Wi-Fi 6, a DECT telephone 
system and more.

Google Nest Wifi 
Pro Two-Pack
>£370.69 
> store.google.com/gb
>The Nest Wifi Pro gives 
you a smart speaker, Wi-Fi 
router and extender in 
one. It’s fast, and features 
simple controls, but only two 
Gigabit Ethernet ports (on 
the router). It’s just the thing 
for your Google smart home.

TP-Link Archer 
AX10000
>£693.03 > tp-link.com/uk
> If you want the ultimate 
tri-band wireless gaming 
router, check this out. It’s 
not cheap, but it offers 
ultra-fast Wi-Fi, and a Game 
Accelerator to identify and 
optimise gaming streams. 
A separate modem is 
required with most ISPs.

5 best Wi-Fi routers 
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1Mac won’t connect
If your Mac won’t connect to your 

network, try turning Wi-Fi off then 
on again. To do, that, click the Wi-Fi icon 
at the top right of the menu bar, and use 
the switch at the top of the menu. Or do 
so from System Settings > Wi-Fi.

4Network information
Hold the Option key down and 

click on the Wi-Fi icon again for a large 
information window that tells you a lot 
about the network on which you’ve 
connected, including the IP address, 
security and more.

2Restart your router
If this fails to sort things, it might be 

that your router has glitched or crashed. 
Unplug the router, and wait around 60 
seconds, then plug it in again. Give it 
time to reboot, then see if you can 
connect to Wi-Fi as normal.

5Delete networks
Open System Preferences and click 

on Wi-Fi. Click Advanced at the foot of 
this window to see a list of the networks 
you’ve previously connected to. To delete 
one, click the ‘…’ icon alongside it and 
choose Remove From List.

3Low data mode
If you’re using a Wi-Fi network  

for which you have to pay according  
to how much data you use, Low data  
mode can help cut the bill. In System 
Settings > Network > Wi-Fi, click Details 
and switch on ‘Low data mode’.

6Test your speed
If you want to test the speeds you’re 

getting from your ISP, download the 
Speedtest by Ookla (speedtest.net). It’s 
free, and easy to use; just click Go and 
your upload and download speeds are 
measured and the results shown.

How to Identify and fix Wi-Fi issues >

Don’t automatically join
You might want to keep a network on 
your list of previously joined networks 
but not automatically join it again when 

you open your Mac within its range. Open System 
Settings, click Wi-Fi in the sidebar, then Advanced. 
Find the network, click ‘…’ and untick Auto Join.

Personal hotspots
If your regular internet connection is 
unavailable on your Mac, try using your iPhone 
instead. To do that, click the Wi-Fi icon on your 
Mac’s menu bar and select your iPhone under 
Personal Hotspot. Use it selectively, though, as 
you don’t want to end up with a hefty phone bill.
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Hardware peripherals can cause issues. Here’s how to fix your kit 

 Image credits: Apple Inc

Help! My accessories won’t work

If you’re having problems with your 
external displays, check the cables are 
correctly connected. If they are, unplug 
and reconnect it. The next step is to open 
System Settings, and click Displays on 

the left. Hold the Option key and the 
Night Shift button turns into Detect 
Displays; click it and see if it appears. You 
can also click Arrange to set where the 
screens are in relation to each other.

If your Bluetooth peripheral won’t 
connect to your Mac, turn it off 
and turn it on again. If that fails, 
click the Bluetooth icon in your Mac’s 
menu bar, then click the peripheral 
name in question to see if you can 
connect it that way. If this doesn’t 
work, in the same menu, select 
Bluetooth Settings at the bottom. 
This opens System Settings, with 
Bluetooth already selected. Click on 
the ‘i’ icon next to the device in 
question, and then click Forget This 
Device. Your Mac and the device are 
no longer paired. Pair it again (dig 
out its instructions if necessary).

As your keyboard and Magic 
Trackpad or Magic Mouse are likely 
Bluetooth peripherals, it’s a good 
idea to keep a cheap USB mouse and 
keyboard handy in case you have 
problems with these input devices. 
You can pick them up extremely 
cheaply from charity shops or from 
car boot sales, and they can be 
lifesavers if your regular keyboard 
or mouse/trackpad glitches.

If you’re struggling to get something 
printed, check the printer is switched 
on and correctly plugged into your 
Mac or connected to the same Wi-Fi 
network, check it has paper! Next, click 

the printer icon in your dock to see the 
print queue. If there’s more than one 
printer on your network, check you’re 
printing from the one you intended. Click 
‘X’ do delete a job from the queue.

Mouse/trackpad settings
Open System Settings, and in the left 
sidebar, click Mouse or Trackpad. You 
can then customise the way it works. If 

your Gestures have gone awry, make sure they’re 
set up correctly. If the pointer is moving too quickly 
or slowly, change the tracking speed.

Fix external display issues

Displays and M-series chips
If your Mac has a regular Apple silicon M-series chip 
(as opposed to a Max, Pro or Ultra), you can only 
connect up to one external monitor natively. If you’re 
trying to connect a second and failing, this is probably 
why. OWC makes an adaptor that can get around this 
limitation. See bit.ly/3IJhrR6 for details.

Fix Bluetooth 
peripheral 
issues

Fix common printer problems
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When you press the ‘y’ on your 
keyboard, do you get a ‘z’ instead? 
If so, it could be set to German. 
Other language settings can cause 
similar quirks. Go to System Settings > 
Keyboard. Under Languages, make sure 

it’s set to English (United Kingdom), or 
the option you want. If it isn’t, click Edit 
and check the correct box, and uncheck 
the incorrect ones. If your keyboard isn’t 
recognised, click Change Keyboard Type 
and follow the instructions.

If an external drive doesn’t show in 
Finder, make sure you’ve given it 
enough time – wait a minute before 
trying anything else. After that, try 
a different USB port, ideally in the 
computer itself instead of a hub. 
Try a different USB cable too.

Open Disk Utility from 
Applications > Utilities. Look in the 
list of external drives in the left-hand 
sidebar. Is it there? If so, click the 
chevron to its left. If you see the 
volume you’re looking for greyed 
out, try clicking on this greyed-out 
volume, and then click ‘Mount 
in the toolbar’.

If it appears in Disk Utility but 
you can’t use it for some reason, 
click on it and then click Erase in the 
toolbar. Choose a name for it, and 
under Format, choose APFS, then 
click the Erase button. If you’ve just 
bought the drive, it might not be 
readable as it’s formatted in a way 
the Mac can’t understand. Erasing 
it in this way reformats it to your 
Mac’s preferred format, but also 
wipes it clean so make sure there’s 
nothing on it that you need.

Today’s Macs mostly offer USB-C 
ports, but many peripherals still use 
USB-A connectivity. If you have a 
USB-A gadget and only USB-C ports free 
on your Mac, you can get an adaptor 
fairly cheaply. Alternatively, use a USB 

hub, which plugs into one USB socket 
and offers several USB-A ports. If a USB 
peripheral plugged into your hub isn’t 
found by the Mac, try a different port 
and failing that, try plugging it into the 
computer instead of the hub.

If you keep getting this notice, the device might 
be drawing too much power. Is it a mains-powered 
device? If so, make sure it’s plugged into the mains 
as well as your computer. If it’s connected to a hub, 
try connecting it directly to your Mac.

My speaker won’t work
First check the connections, Bluetooth or cabled. 
Remember, there’s usually more than one volume 
control in operation. Make sure your Mac’s volume 
isn’t all the way down to nothing; click the speaker icon 
in the menu bar. Now check the volume on the app 
you’re using, and finally, the speaker’s own volume.

My keyboard’s in the wrong language

My USB accessory 
is disabled

Fix common 
external drive 
problems

My USB peripheral isn’t showing up
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 Master Apple 
shortcuts

iOS 
 A tap is a brief contact 

of (usually) one finger 
on your device’s screen.
 To drag is to move a finger 

across the screen to scroll 
or pan around content.
 Swipe means move one or 

more fingers across an item 
or the screen, then let go. 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.
 Pinch means move two 

fingers together or apart, 
usually to zoom in or out.
 Touch and hold means lightly 

rest your finger on an item 
and wait for a reaction.

Your in-depth guide to 
getting more from 

your Apple kit

NEW 
IDEAS

WHAT’S INSIDE

macOS 
 Cmd is the Command key.
 Alt or Opt is the Option key.
 Ctrl is the Control key, also 

shown as ‘̂ ’ in shortcuts in 
the menu bar.
 The thick, outlined up 

arrow is the Shift key.
 The thin, left arrow or 

outlined pointer with ‘X’ 
inside is the Delete key, which 
deletes to the left. Pressing 
the Function key (Fn) and the 
Delete key deletes to the right.
 The thin, right arrow key with 

a small vertical line at the end 
is the Tab key, which shifts the 
focus between some controls.

Contact us

 Email your queries and 
your questions to 

letters@macformat.com
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 Create shortcuts to files, folders and more
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 Use artificial intelligence to fix your photos

42 BOOST DISPLAY BRIGHTNESS
 Let Vivid help your Mac to see the light

44 CLEAN UP YOUR MAC 
 Bring order to chaos with Hazel organisation 
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 Scan barcodes for advice on buying decisions
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 Share your favourite tracks on Apple Music
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 Create vibrant documents and posters
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 Team your iPhone 15 with loads of add-ons
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 Image credits: Apple Inc, Adobe Inc, Canva, Little Labs Inc, Cross Forward Consulting LLC
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Make and use aliases on Mac
Create handy shortcuts to your favourite files, folders and apps

IT WILL TAKE
  5 minutes

YOU WILL LEARN
  How to create aliases 

for files, folders and 
more on your Mac

YOU’LL NEED
  Files, folders or 

apps that you want 
easy access to

There will probably have been 
times when you’ve wanted 
to access a file or folder on 
your Mac without having to 

rummage around inside your computer 
to locate it. On occasions like that, aliases 
can be invaluable.

In short, an alias provides a shortcut to an 
item on your Mac. So, you could store a group 
of files inside a folder in your Documents 

folder, then create an alias of that folder 
on your desktop. Open the alias and you’ll 
be taken to the original location, with all the 
proper files in place. This is useful if you want 
to keep files in their original place while still 
having an easy way to access them. It also 
means there’s no need to duplicate files 
and folders and lose storage space on 
your Mac as a result.

Many advantages
You can create aliases of files, folders, apps 
and drives, and they’re easily identified by the 
small black arrow in their bottom-left corner. 
One benefit of aliases is their flexibility – once 
you’ve created one, you can rename it or 
move it to another location and it will still 
work as expected. You can also move the 
original file (that is, the one that the alias 
links to) and the link will remain intact, so 
there’s no need to worry about breaking 
aliases by changing them.

The ease of use belies the utility of 
an alias, and they can be deployed in all 
sorts of ways. Let’s get started and see 
just what they can do. Alex Blake

Genius tip!
 When creating an alias, 

your pointer should turn 
into a curved black arrow 

as you drag the file or 
folder. If not, you’re just 

moving an item.

 Image credit: Apple Inc

Look out for the curved black arrow as you drag an alias, 
visible both when creating one and after it has been made. 
This distinguishes aliases from regular files and folders.



Make an alias APPLE SKILLS

JUNE 2024 | MACFORMAT | 39

HOW TO Make and use aliases on your Mac 

1Drag and drop
To create an alias, hold the Cmd and 

Opt keys, then drag an item to a new 
location. For instance, you could drag 
a file from the Downloads folder to the 
desktop and an alias is then created 
at that destination.

2Other methods
Alternatively, pick a file in Finder, 

then select File > Make Alias. Or Ctrl-click 
it and choose Make Alias, or select the 
item and press Ctrl+Cmd+A. These 
methods create an alias inside the 
original file’s folder.

3Make a group
There’s no need to create aliases 

one by one. You can select a group 
of items, then use one of the above 
methods to create multiple aliases at 
once. You can then save time by moving 
them all together if you want.

4Dock aliases
You can also create an alias from 

items in your Mac’s Dock. The process 
is very similar; hold Cmd+Opt, then drag 
the file from the Dock to a location in 
Finder. This works for apps as well 
as files and folders.

5Finder sidebar
Aliases can be added to the Finder 

sidebar or the Dock for quick access. 
For the former, drag the item to the 
Favourites section in Finder’s sidebar. 
For the latter, just drag the original 
item onto the Dock.

6The dividing line
Note that when you add aliases 

to the Dock, app aliases should be 
dropped to the left of the divider that 
separates recently used apps. File and 
folder aliases should be dropped to 
the right of the divider.

7Show original
To open an alias’s original folder, 

Ctrl-click an alias, then select Show 
Original. For aliases in Finder’s sidebar, 
Ctrl-click and choose ‘Show in Enclosing 
Folder’, or pick Options > ‘Show in Finder’ 
for Dock aliases.

8Removing aliases
It’s safe to remove aliases – the 

original item won’t be affected. Remove 
aliases from the Finder sidebar or the 
Dock by dragging them out until you see 
the word Remove or an ‘X’ icon appear 
next to the item, then let go.

9External drives
Avoid using aliases with removable 

drives. If you disconnect the drive, the 
alias my no longer work because its 
connection to the original file has 
been severed. Try to keep aliases 
and targets on the same drive.

 Image credit: Apple Inc
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Improve your images with AI
How to use AI tools to make photo fixes and creative adjustments

IT WILL TAKE
  15 minutes

YOU WILL LEARN
  How to try out AI 
photo editing with 

various software

YOU’LL NEED
  Adobe Photoshop 
2024, macOS 10.14 

or later

AI – artificial intelligence – 
is changing the way we edit 
photos. For example, Adobe 
Photoshop 2024 uses its Adobe 

Sensei AI tool to perform common photo fixes 
– such as removing unwanted background 
objects from a photo or making a pouting 
model smile. And Apple are developing an AI 
tool called MGIE. This is a Multi-modal Large 
Language Model (MLLM) that turns written 
prompts into edits. For example, you can 
type ‘change hair colour from blonde to pink’, 

and the code will apply that command to 
a photo. However, while hair colour may be 
changed the code tends to replace subject’s 
faces with less than flattering eyes and teeth. 

While Apple’s AI tool is still in development, 
Adobe have been evolving their Adobe Sensei 
AI tool for years, and we’ll put Photoshop’s AI 
features through their pixel-pushing paces. But 
we’ll kick off by experimenting with a browser-
based demo that lets you use text prompts to 
get Apple’s MGIE AI code to edit your photos. 
George Cairns

HOW TO Experiment with Apple’s AI tool 

1Upload image
In Safari, go to https://huggingface.co/

spaces/tsujuifu/ml-mgie. Click on the 
input image panel and browse to a photo 
that you want MGIE to fix. In our example, 
we want to remove the distracting 
umbrella from the scene.

2Type a prompt
In the Instruction panel, type a 

command such as ‘Remove umbrella’. 
Click the Submit button. MGIE will 
then analyse the image and attempt 
to carry out your command by editing 
the appropriate pixels in the picture.

3Check results
MGIE has done a reasonable job of 

replacing the umbrella with appropriate 
background details. However, it has 
distorted the woman’s face. It has 
also missed the umbrella’s handle 
and cropped the edges of the image.

 Image credits: Apple Inc, Adobe Inc, Hugging Face
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HOW TO Use Adobe’s Generative Fill command  

HOW TO Use Neural Filters in Photoshop 

1Unwanted objects
We could use Photoshop’s Clone 

Stamp tool to manually replace the 
unsightly LED light (and the subject’s 
hand) with background pixels but this 
would take a long time due to the 
complex architecture behind the girl.

2Lasso and generate
Use the Lasso tool to draw a rough 

outline around the unwanted objects. 
The Generative Fill panel appears. Click 
on Generative Fill. Leave the text field 
blank. Click Generate. AI will analyse 
the background pixels.

3Choose a variation 
A Generative Fill layer will appear 

containing new pixels based on the 
surrounding architecture. In the 
Generative Fill panel, you can toggle 
between three versions to choose the 
most effective AI-generated patch.

1Try a neural filter 
If you feel that your subject looks 

a bit too enigmatic and you want to 
introduce a bit more of a smile, open 
a shot in Photoshop 2024 and choose 
Filter > Neural Filters to access creative 
AI-powered tools.

2Say ‘cheese!’
In the Neural Filters workspace 

toggle on the Smart Portrait option. 
Drag the ‘Be Happy’ slider right to add 
a smile to your subject but don’t go too 
far or you’ll get a set of unconvincing 
computer-generated teeth!

3Strike a pose
You can get your model to turn 

their head and look away from the 
camera using the Head and Eye Direction 
sliders, but don’t push things too far 
or the results will be less convincing, 
especially if the eyes are replaced. 

Go further with AI 

In our walkthrough, we used Photoshop’s Generative Fill tool to replace a 
distracting LED light with appropriate bits of background buildings. You can alter 
your photo in a more creative way by generating new objects to replace existing 
ones. Here we drew a rough outline around our subject’s leather jacket with 
the Lasso tool. We then typed the prompt ‘Change jacket to denim’ into the 
Generative Fill text field. We then toggled between three different attempts 
to replace the leather jacket to choose the most convincing variation.

Bring new elements in to your images 

 Image credits: Apple Inc, Adobe Inc
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Boost your display brightness
Let Vivid help you to see the light on your HDR-compatible Mac

IT WILL TAKE
  5 minutes

YOU WILL LEARN
  How to raise your 

Mac’s brightness for 
consistent HDR visuals

YOU’LL NEED
  Vivid app (getvivid.

app), macOS 12 or later

Modern Mac displays can go 
super-bright, but only when 
HDR content is involved. 
Fortunately, you can get 1,000 

nits of brightness whenever you want by 
using an app called Vivid.

Vivid uses your Mac display’s HDR 
capabilities to push its brightness beyond 
its normal bounds. This is great for when 
you need to use a MacBook outside in bright 

sunshine, or if you want a better movie-
watching experience, even if the content 
is not in HDR. It works using your standard 
brightness keys – except they go twice as 
bright. It also comes with extra features like 
customisable shortcuts and a setting that 
shuts off Vivid if your battery is low.

Modern Macs only
Vivid only works on modern Macs with HDR 
support, such as the M1, M2 and M3 series 
MacBook Pro (except the M1 13-inch model) 
and the Pro Display XDR monitor. You can pair 
other Apple silicon Macs with a Pro Display 
XDR and Vivid will work (Apple says the Pro 
Display XDR can run at 1,000 nits indefinitely, 
so it’s safe to use), but it’s not compatible with 
any Intel Mac or the Studio Display. 

Vivid is free to try with limited functionality 
and costs €10 (about £10) on the company’s 
website or £24.99 on the Mac App Store if you 
want to unlock it. This is a one-off fee, not a 
subscription. Now, let’s see what it can do. 
Alex Blake

Any Mac or Apple monitor with XDR should work with Vivid, 
but third-party monitor support isn’t yet available.

 Image credits: Apple Inc, Good Snooze x Lumen Digital

BEFORE AFTER
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HOW TO Boost your display brightness 

1Launch at login
Vivid automatically brightens your display 

when it runs. To have it start when you log in, 
click its menu bar item, then go to Preferences 
> General and pick ‘Launch and Enable’ from 
the ‘Launch at Login’ menu.

2Adjust multiple displays
If you have several compatible displays, 

Vivid can work across them all. Open Vivid’s 
preferences and go to General > Use Displays 
and select All Displays from the menu, then tick 
the checkbox next to Sync Brightness.

3Choose separate screens
If you’d rather have different settings for 

your external displays compared to your Mac’s 
built-in screen, open Vivid’s settings and go to 
General > Use Displays and pick Only MacBook 
Display or Only External Display.

4Save battery life
To save battery life, open settings and 

go to Automations, then tick the checkboxes 
next to Battery and Low Power Mode. You can 
define what battery percentage threshold will 
turn Vivid off in 5% increments.

5Run a timer
You also can disable Vivid after a set 

period of time in Preferences > Automations. 
This is useful if you just want to enable it 
during a game or movie session but think you 
might forget to turn it off when you’re done.

6Enable Eclipse mode
Vivid isn’t just for increasing your display 

brightness – you can lower it too. Click Vivid’s 
menu bar icon, then select Enable Eclipse. You 
can now lower your display’s brightness below 
its normal minimum boundary.

Genius tip!
 Go to the app’s 

settings and select 
Shortcuts. Here, you 
can set a keyboard 
combination to quickly 
toggle Vivid or its 
Eclipse feature.

Jargon buster
 HDR stands for high 

dynamic range. It refers 
to content that has 
a higher range of 
brightness levels than 
regular visual material.

 Image credits: Apple Inc, Good Snooze x Lumen Digital
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Clean up your Mac with Hazel
Bring order to chaos with this amazing rules-based Mac utility

IT WILL TAKE
  20 minutes

YOU WILL LEARN
  How to keep your 
Mac neat and tidy – 

automatically! 

YOU’LL NEED
  macOS Sonoma,  
Hazel ($42, about  

£40, noodlesoft.com)

If your Mac’s messier than a 
teenager’s bedroom after a wild 
weekend sleepover, it may be time 
to call in a supernanny – and 

that’s where Hazel comes in. Now on Version 
5, this brilliant utility from Noodlesoft will help 
tidy up and then keeps things tidy, thanks to 
its straightforward interface and powerful 
condition-based rules.

Hazel can come to the rescue in all kinds of 
ways – whether it’s clearing up a particularly 
messy desktop, fetching and carrying images, 

video and music files and putting them in the 
proper places, or even sweeping away the 
detritus left behind by uninstalled apps.

Plus, Hazel can work with other 
automation apps on Mac such as, ahem, 
Automator and Shortcuts to quickly handle 
things like file conversions (JPGs to PNGs, 
say) and do so automatically. Here we look 
at just some of the things that Hazel can 
do – but be sure to check out Noodlesoft’s 
support pages at noodlesoft.com/support 
for more tips and ideas. Rob Mead-Green

HOW TO Get organised with Hazel  

1Rule-based organisation
Hazel uses rules like those you might 

find when creating smart playlists in 
Music or filing emails away in Mail. To 
help you get started, Hazel will offer to 
load some demo rules when you first 
launch the app. Take a look.

2Put rules into action
Click on any of the existing items in 

the rules list to see the commands they 
contain. The Newly Added Items rule, for 
example, automatically adds a Blue tag to 
any new items you’ve added to your Mac 
so you can find them more easily.

3 It’s automagic!
Any rules you add to the list and run 

will be carried out automatically by Hazel. 
The app window doesn’t need to be open 
for it to do so. You can also manually run 
rules at any time by using the drop-down 
in Hazel’s menu bar item.
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CONTINUED… Get organised with Hazel 

4You make the rules
Once you’ve tried the demo rules, 

you can either customise them to suit 
you, or add new rules of your own. Here 
we’re going to create a rule that will 
automatically add music files contained 
in our Downloads folder to the Music app.

5Create the rule
First click Add Folder – this tells 

Hazel which folder on your Mac it should 
watch so it can apply the rule. Then give 
your rule a suitable name – we’re calling 
this one ‘Import Music’. Next, start adding 
any conditions to your rule.

6Conditions and actions
The first line says ‘If all the following 

conditions are met’. Here, the condition 
we’re adding is ‘Kind is Music’. Next, add 
an Action. Under ‘Do the following to the 
matched file or folder’, choose ‘Import 
files into Music to playlist Library’.

7See the rule in action
Once you’ve added conditions and 

actions to your rule, click Save. Hazel 
should then run the rule automatically.  
From now on, any music files you add to 
your Downloads folder will be imported 
into the Music app with no input from you.

8Customise the rule
The Import Music rule you created 

may have added the files to the Music 
app, but it’s also left the originals in place. 
To remove those originals, you may wish 
to add a further Action to your rule. In 
this case, ‘Move to folder Trash’.

9Head to settings
Now when you add a music file to 

your Downloads folder, Hazel will first 
import them into the Music app, then 
move the originals to the Bin, so you can 
delete them later. But if that still seems 
messy to you, head to Hazel > Settings.

10Take out the trash
In Hazel > Settings, select Trash 

in the toolbar then select the ‘Delete files 
sitting in the Trash for more than’ and 
add a suitable time period. Here we’ve 
chosen ‘1 Week’. You can also choose 
to delete files normally or securely.

11Let’s get sweeping
Still in Hazel > Settings > Trash, 

select Enable App Sweep at the bottom of 
the window. This automatically cleans up 
any leftovers when you remove an app 
from your Mac – if only those messy 
teenagers would do the same, eh?

12Add a shortcut
Hazel also plays nicely with the 

Shortcuts app. Here we’ve created a rule 
that watches for images containing .jpg,  
.jpeg and .webp extensions and converts 
them to PNG files before binning the 
originals. It’s amazing what you can do!
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Make healthier choices
Use your iPhone to scan barcodes for useful shopping advice

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  You’ll learn how Yuka 

can help you shop

YOU’LL NEED
  Yuka app (Free, IAPs), 

iOS 13 or later

Would you like to avoid 
food additives, potential 
allergy triggers and other 
unpleasantness – such as 

hazards that might be lurking in your 
make-up? Then Yuka (yuka.io/en) may be 
the app for you. It uses your iPhone camera 
to tell you what’s in food or cosmetics, warn 
you of potential issues and suggest other 
products you might want to try instead. As 
you’ll see in this tutorial, scores can be pretty 

scary: you can forget about that chocolate bar 
you were going to have as a snack. But if you 
want to avoid unwanted ingredients such as 
palm oil, saturated fats and specific additives, 
or find more natural cosmetic products, the 
app can be very useful too.

Pinch of additive
It’s worth noting that with apps such as this, 
it’s important to understand that the 
information provided is an opinion. For 
example, the app told us flatly that MSG (or 
monosodium glutamate), a common flavour 
enhancer, is ‘hazardous’. But many of MSG’s 
supposed health risks have been wildly 
exaggerated, or would require you to ingest 
massive quantities. 

Similarly, after scanning an antiperspirant, 
the app told us it too was ‘hazardous’ based 
on the possibility that one of the ingredients 
might possibly include a specific impurity. To 
its credit the app does list its sources, but if 
you don’t dig into them you might convince 
yourself that your local supermarket is the 
most dangerous place on Earth.  
Carrie Marshall

Genius tip!
 Yuka automatically 

adds all of its food 
and cosmetic 

recommendations to 
the Recommended tab, 

but you can remove 
any you don’t want.

 Image credits: Apple Inc, Yuka SAS

Looks like this Berry Granola’s going in our basket – Yuka 
has given it an Excellent rating with an 84/100 score.
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HOW TO Get a breakdown of your potential purchase 

1Sign up and in
To use Yuka you’ll need to sign up 

for a free account with your email (you 
can use Hide My Email if you like) and a 
password. Once you’ve done that, you’ll 
see a quick intro to the app and then this 
button, ‘Scan my 1st product’.

2Give it access
The Yuka app needs access to your 

iPhone or iPad camera in order to scan 
the barcodes, as those are where it gets 
its info from. The first time you use the 
app it’ll ask for permission; if you say no 
by accident you can change it in Settings.

3Scan your shopping
All you need to do now is point 

your iPhone at the barcode. Make sure 
the code is the right way up; it wouldn’t 
scan upside-down ones when we tried. 
After a short pause, you’ll see the result 
at the bottom of the screen. 

4Feel good about food
With a score of 90 out of 100, 

these bagged fruits score well. Tap on the 
score and you’ll see a breakdown of the 
nutrition, but take it as a guide: Yuka tells 
us here that our tangerines, a naturally 
sugary fruit, don’t contain sugar.

5Don’t check chocolate
There’s no getting away from the 

fact that sweet treats will generally score 
low. The average chocolate bar tends 
to be high in sugar and oil or fat content, 
with a high overall calorific value. It’s a 
similar story for fizzy drinks and crisps. 

6See what’s inside
With processed foods it’s often 

illuminating to see what’s involved in 
making them; the combination of a few 
additives and quite a bit of salt means 
that Yuka is giving these (very tasty) 
chicken gyozas a score of just 8/100.

7Don’t panic
To Yuka’s credit it cites sources for 

all of its health claims, but that doesn’t 
mean they’re necessarily right. For 
example, it classes MSG as hazardous, 
but the claims here refer to ‘may 
contribute/cause’, etc.

8Check your cosmetics
Yuka doesn’t just do food. It can 

scan many common cosmetic items to let 
you know if they contain anything you 
might not want near your skin. Again 
there’s colour coding and percentage 
scores: our cleanser scores well.

9Consider alternatives
As with food items, if Yuka thinks 

there are alternative options it’ll tell you 
about them here – in this example, it’s 
suggesting that instead of prepackaged 
cleansing wipes that we try a high-
scoring micellar cleansing water. 

 Image credits: Apple Inc, Yuka SAS
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Create collaborative playlists
Sharing is caring – and sharing playlists is a pleasure on Apple Music

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  To create and share 
collaborative playlists

YOU’LL NEED
  All those you’re 

sharing with to have 
an Apple Music 

subscription

Music’s a social thing, which 
is why we flock to small clubs 
or big stadiums to be with 
our fellow fans. Obviously, 

listening to a cracking tune solo on your 
AirPods is great, but music is even more 
fun when it’s a shared experience. And one 
of the most fun ways to share it is to introduce 
your favourite music to other people. 

In the pre-digital days one brilliant way to 
do that was to make a mix tape on cassette for 
your friends or significant other; the modern 
equivalent, collaborative playlists, don’t just 
enable you to share songs but also let others 
add their own suggestions too.

This is not just a playlist
Collaborative playlists are available in the 
Music app on iOS 17.3 or later, iPadOS 17.3 or 
later and macOS 14 (Sonoma), and you must 
be a paid subscriber to Apple Music to invite 
others or to take part in a collaborative 
playlist. That’s because this isn’t the same 
as a shared playlist, which is read-only; with 
collaborative playlists, the people you share 
with can edit and re-order the playlist too.

Collaborative playlists is a new feature, 
and it seems to have a few rough edges; for 
a few days it didn’t work at all for us, an issue 
that now appears to be fixed, and the error 
messages could do with some work. Also, 
if you try to share a playlist with a family 
member under 13, it turns out you can’t do 
that but, instead of saying so, Music tells you 
the sharing link has expired. Carrie Marshall

Genius tip!
 If you don’t want 

other people to add 
to or re-order your 

playlist, don’t use the 
collaboration option; just 
share the playlist as you 

would a photo or file.

 Image credits: Apple Inc, Loma Vista Recordings/Concord

Use Focus Filters (Settings) to turn off Use Listening History 
so that your listening won’t affect future recommendations.
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HOW TO Create a collaborative playlist 

1Pick a playlist
In order to share a playlist, we’ll need 

to create or choose one. Open the Music 
app on iPhone, iPad or Mac then tap or 
click on Library > Playlists. You can now 
select one of your existing playlists or 
use the big red ‘+’ to add a new one.

2Don’t go local
For collaborative playlists, you can 

only use songs from the Apple Music 
catalogue; if your playlists also contain 
songs from your local music library, you’ll 
get this message and your playlist will 
be duplicated without the local tracks.

3Choose your songs
We’ve put together a playlist of 

Apple Music tracks that we want to share. 
As you can see, our name appears just 
below the playlist title. To add friends, 
tap on the icon showing two silhouettes 
towards the top right (not shown).

4Set your sharing
You should now see the option to 

‘Invite People to Join’. This will enable 
you to share your playlist, and it’ll create 
a shareable link; anyone who gets sent 
the link can then edit the playlist. You can 
use Approve Collaborators to limit that.

5Share the songs
Tap on Start Collaborating and you’ll 

see your Share options (we’re using iOS 
here), with all the various different apps 
and your most recent contacts at the top. 
Now it’s just a matter of picking the 
person you want to share with.

6Add more people
You can use the Collaboration icon 

(two silhouettes) to add more people at 
any time, and once you’ve shared a 
playlist for the first time this is the screen 
you’ll see. You’ve got two choices here: 
Share Invite Link and QR Code.

7Crack the code
A QR code enables you to share 

locally; get the person to point their 
iPhone camera at the code and it’ll take 
them to the playlist in the Music app. 
Don’t post QR codes publicly without 
turning on Approve Collaborators.

8Start to share
Collaboration works just like it 

does in Pages or Sheets; when the other 
person accepts your invitation, you’ll 
get a notification on your device and 
you’ll see another person listed in your 
collaborative playlist in the Music app.

9Turn it off
If you decide that you no longer 

want others to collaborate on your 
playlist, you can uninvite them as easily 
as you invited them. In the Collaboration 
page for your shared playlist, simply tap 
the Stop button to end collaboration.

 Image credits: Apple Inc, Loma Vista Recordings/Concord
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Get creative with Canva
Create vibrant artwork, docs, posters, and more with this arty app

IT WILL TAKE
  20 minutes

YOU WILL LEARN
  How to design and 

edit a variety of 
artwork options

YOU’LL NEED
  Canva (Free, IAPs), 

iPadOS 13 or later

Canva is one of the most useful 
art and design apps on the iPad, 
thanks to its ease of use and 
sheer flexibility. Available for 

free or with a Premium subscription for £12.99/
month or £99.99/year for more elements, 
Canva is the perfect app to create artwork, 
posters, documents, and more.

Usually, design apps offer limited services 
on the free tier, but Canva is genuinely useful 
without forking out for a Premium membership. 
The platform is not only one of the best apps 

on iPad but also one of the best apps on just 
about any Apple kit, and all of your projects 
will transfer between your devices.

If you’re looking for an app to start making 
designs for your small business or create 
artwork in your spare time, Canva is the perfect 
companion to unleash your creativity. This 
tutorial will teach you some of the most basic 
tools, including removing the background from 
an image with the tap of a button or using a 
template to create a presentation slide or 
Instagram post. John-Anthony Disotto

HOW TO Get started with Canva 

1Choose a format
Tap one of the icons on the home 

screen, such as Social Media, Docs, 
Presentations, to explore templates. For 
something more specific, like a greeting 
card, an invitation or a poster, use the 
search bar to find your desired format.

2Use a template
Once you’ve chosen a format, you’ll 

be shown the templates available for it. If 
you’re finding it hard to choose, tap the 
All Filters or Category buttons to narrow 
down your search. Alternatively tap 
‘Create a blank…’ to start from scratch.

3Start from scratch
Use the sidebar on the left to add 

elements, choosing from graphics, stock 
imagery, text, and pictures from your 
camera roll. Some elements are only 
available with a premium membership, 
but the free catalogue is substantial. 

 Image credits: Apple Inc, Canva
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HOW TO Edit your Canva elements 

HOW TO Resize and share your work 

1Remove background
If you’ve added an image from uploads 

or camera roll but want to replace the 
background with a solid colour so that 
it either ‘pops’ or blends in, select the 
image, and tap Edit Photo > BG Remover. 
(Note: this is a Premium feature.)

2Change colours
To change the colour of text or 

editable shapes, select the item, and tap 
on the coloured square or font colour 
icon (top right), then type the colour or 
name required. Or tap the rainbow 
square to use the colour picker. 

3Change fonts
To change fonts, select the text 

you want to edit, then tap Fonts > 
Browse Fonts, and choose one.
Alternatively, tap Text in the sidebar 
on the left to use font combinations for 
a more elaborate visual text display. 

1Resize the project
If you want to resize your project 

without starting from scratch or to adjust 
it for a different purpose, select File > 
Resize and Magic Switch, then select 
the required format and save as new 
or format the original.

2Collaborate with others
Canva is the perfect platform to 

collaborate with others, whether you 
want someone to work on a project with 
you or simply view it. To share a project, 
tap Collaborate, add names or email 
addresses and set access preferences.

3Download and export
You can send your artwork to 

print, share it directly to social media, 
or download it to your device. Tap Share  
> Download, then select the file type and 
size, and specify the pages you wish to 
export, then tap Download. 

Get a little help from AI

If you have an image in your head, but not the artistic chops to create it, Canva’s 
built-in artificial intelligence tool can help. Simply tap Magic Media in the toolbar, 
select either Images or Videos and then type the thing you’re thinking of in the 
text entry field. Tap the ‘Generate image’ or ‘Generate video’ buttons at the foot 
and voila! Within seconds, Canva will create suitable content for you. If you’re 
happy with the results, pick one and drag and drop it onto your canvas 
to position or resize it. Or tap Clear in the text field to try again.

Use text prompts to create original images  

 Image credits: Apple Inc, Canva
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Give your Watch a new look
Transform your Apple Watch with Watchsmith and Facer

IT WILL TAKE
  15 minutes

YOU WILL LEARN
  To customise faces 

and complications

YOU’LL NEED
  Watchsmith app, 

watchOS 8 or later; 
Facer app, watchOS 7 

or later

We love the Apple Watch, but 
sometimes we wish there that 
was more customisation than 
Apple allows. While we can 

change the colours and complications of a 
face, the choice is limited. The App Store can 
help. Two apps in particular, Watchsmith and 
Facer (aka Watch Faces by Facer on the App 
Store), can design new complications and 
supply you with entirely new watch faces too.

Both apps offer customisation but they 
focus on different things. Watchsmith is 

designed primarily around complications  
– the little nuggets of information, such as 
weather data, activity circles and calendar 
events. And Facer is more about changing 
up entire watch faces.

In this tutorial, we’ll discover how you 
can use these apps to completely customise 
your Apple Watch. We’ll stick with both 
apps’ free features only; you can unlock 
more features and faces via in-app 
purchases but, as we’ll see, you can 
do a lot for free. Carrie Marshall

HOW TO Customise your Apple Watch  

1Select a face
Although Watchsmith provides some 

useful Apple Watch tools, its core job is 
to create new, useful complications for 
your watch faces. To do that it’s just a 
matter of scrolling through the faces 
to decide what face you want to edit.

2Give permission
The majority of complications 

require data from core apps – Fitness 
complications need access to Health; 
Maps needs access to location, and so on. 
Tap Manage Permissions and authorise 
the data you want to let Watchsmith use.

3Choose a complication
Tap on your chosen watch face and 

you’ll see this screen; it may look slightly 
different for faces that don’t support 
circular complications like the Infograph 
one we’ve chosen here. To change the 
complication, simply tap on it.
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CONTINUED… Customise your Apple Watch 

4Browse the collection
You’ll see a selection of available 

complications, helpfully organised by 
category: Activity, Weather, and so on. 
Simply swipe through the gallery until 
you find one you want to use. You can 
change its font, colour and background.

5Add more complications
Save your complication and you’ll 

be returned to the previous screen, this 
time with a big Add Complication button 
on it. Here we’ve added two more 
complications that we want to use 
on our Apple Watch face. 

6Set a timer
Watchsmith enables you to create 

timed complications on supported faces. 
You can tell your Apple Watch to display 
a particular complication at specific 
times, making various complications 
more useful according to your schedule.

7Change your face
To use a complication, go to the 

Watch Face gallery, choose a face and 
press and hold to bring up Edit. Tap Edit, 
then swipe to Complications. Tap on the 
first complication you want to replace 
with a Watchsmith one.

8Choose the app
The available complications are 

organised by app name, so you might 
need to swipe or scroll until you see the 
option for Watchsmith. Tap on that and 
you’ll then be taken to the list of available 
complications for this watch face. 

9Add your others
Once you’ve added your first 

complication the process is exactly the 
same for other ones; tap the complication 
you want to replace, select Watchsmith, 
then choose the specific complication 
you want to add. 

10Get new faces
If you want to replace your Apple 

Watch face, Facer is a great option; some 
of its designs are an acquired taste but 
there are tons to choose from. The app 
includes free faces you can use before 
deciding if you want to pay for Premium.

11Select your style
Finding a face is simple enough; you 

browse the Watch Face gallery just like 
you’d browse for apps in the App Store. 
We’re quite taken with this Casio-esque 
take on the Infograph Modular face, so 
we’ll tap the blue Add To Watch icon.

12See your style
The watch face will be added to 

the Watch app on your iPhone, where 
you’ll see a screen like this one; add the 
new face to My Faces with the button at 
the bottom of the screen and it’ll then 
be added to your gallery of faces.



The arrival of USB-C means you can team your device with loads of add-ons

YOU WILL LEARN
 The benefits and 

pitfalls of the USB-C 
connector and the 

devices you can connect

Key fact
 If you have a High 

Dynamic Range (HDR) 
USB-C display, connect 

your iPhone using a 
USB-C cable supporting 

USB 3.1 or higher then 
alter the settings to get 
the most out of it. Just 
open the Settings app, 

tap Display & Brightness 
and select the display 

you’re using. When you 
turn on Allow Display 

Mode Changes, the 
frame rate and dynamic 

range will adjust.

 Image credits: Apple Inc

similar to USB-C in that it allows you to 
connect a whole host of devices, hence 
Apple’s Made for iPhone programme so that 
consumers would know which products were 
certified compatible. Third, USB-C cables can 
be fragile so you may still end up contributing 
to that e-waste mountain.

Normal vs unified
Still, there is one big advantage of USB-C over 
Lightning; the former allows for faster data 
speeds, particularly on the iPhone 15 Pro and 
iPhone 15 Pro Max which support USB 3.2 Gen 
2 speeds of up to 10Gbps so long as you use a 
USB 3 cable. To take advantage, you can hook 
up an external SSD, particularly if you want to 
use your iPhone to record video in the highest 
possible quality. Opt for a drive can write at 
speeds of 220MB/sec or more such as the 
SanDisk Extreme Portable or Crucial X6 
Portable and you’ll be able to record 4K 
ProRes video at up to 60 frames per second 
(fps) rather than the 30fps you can commit 
to your iPhone’s internal storage.

It’s also possible to hook up USB-C flash 
drives which will allow you to free up space, 
easily move content between your iPhone, 
iPad and computers and backup files –  even 
password-protecting them if you wish. One of 
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ntroduced in 2012, the Lightning 
connector has long been a key part 
of the iPhone range. Apple wanted it 

to remain that way despite switching to USB-C 
– the standard adopted by practically every 
other manufacturer – with its laptops and 
iPads. But the European Union (EU) had other 
ideas. forcing the company to ditch Lightning 
in favour of USB-C for the iPhone too, even 
though the Cupertino giant said “innovation 
would be stifled by the proposal”.

As it happens, the move has many 
benefits, not least a likely long-term reduction 
in e-waste. The EU reckons that a standardised 
cross-platform port (as opposed to proprietary 
tech like Lightning) will eventually save 1,000 
tonnes of e-waste each year. USB-C also 
means that Android and iPhone users can 
share cables and it opens the door to a large 
ecosystem of accessories originally intended 
for non-Apple devices.

Before we take a look at some of some 
of those uses, it’s worth pointing out three 
things. First, there are different USB-C 
standards so not all cables are equal – some 
allow for fast charging and high-speed data 
transfer rates and some do not, so you need 
to do your homework (at least look for USB-IF 
certification). Second, Lightning is actually 

I

HOW IT WORKS

The iPhone 15’s USB-C port

The iPhone finally has 
a USB-C port, and that 
brings a great range 
of connectivity benefits.
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the best examples is the SanDisk iXpand 
Flash Drive Luxe which has the advantage 
of having both Lighting and USB Type-C 
connectors for backwards compatibility. But 
there are lots of other USB-C flash drives on 
the market (many at low prices) and, if you 
have a standard USB flash drive knocking 
around, you can make use of that too, so long 
as you buy a USB-C to USB-A adaptor.

The adaptor can be used for other 
devices such as a camera but you may find 
that a straightforward SD card reader that 
plugs directly into the USB-C port is a better 
option if you want to port photos and video 
from a dedicated digital camera. Anker, one 
of the best brands for this kind of thing, has 
an inexpensive memory card reader that 
boasts high-speed syncing and works with 
microSD and SD cards; Apple’s own USB-C 
to SD Card Camera Reader costs about 
three times as much. Use the Photon 
photography app and you’ll be able to 
directly save captured ProRAW photos 
externally to a USB-C drive.

More dynamic
If you wish, you could then connect your 
iPhone to a USB-C DisplayPort-supported 
monitor, TV or projector and mirror images 
from your device on the big screen at up to 
4K and 60Hz. This is great if you’re looking 
to show off a presentation, for instance, or if 

Key fact
 Opting for a cheap 

USB-C cable may cause 
problems if you’re 
connecting devices to 
your iPhone 15. Some of 
them don’t include data 
lines and they are only 
useful for charging. This 
means if you want to 
connect your iPhone 15 
model to, say, CarPlay, 
you may find it fails 
to communicate. Choose 
high-quality, pricier 
cables from brands 
you trust.

 Image credits: Apple Inc, Dell Inc

you want to let people see your 
photos or videos. For the best 
results, use a USB-C cable that 
supports USB 3.1 (that is, not 
the one you get out of the 
iPhone box) or, if you’re looking 
to connect via HDMI or VGA, 
use a USB-C Display AV 
Adaptor or USB-C VGA Multi- 
port Adaptor. Opt for an HDMI 
2.0 cable for 4K, 60Hz output, 
but be aware you won’t be able 
to stream copy-protected (HDCP) content.

Hooking up to a TV will also enable you to 
play games from your iPhone on a larger 
display and since it’s possible to connect a 
Bluetooth controller to your device (including 
PlayStation, Xbox and Switch Joy-Cons), this 
effectively turns the iPhone into a highly 
portable games console. As a result, you’ll be 
able to take your Apple Arcade subscription 
to another level with games such as GRID 
Autosport, Journey and Life Is Strange. It 
helps turn your iPhone into an even more 
prominent entertainment device.

This extends to audio too. You can use 
USB-C headphones with your iPhone 15, the 
benefit being that the digital-to-analogue 
converter (DAC) and amp are contained in 
the headset, enabling you to take advantage 
of an individual audio manufacturers’ 
components. You could also plug in a 

microphone and turn the iPhone 
in a recording studio. As you can 
see, USB-C is something to make 
a noise about. David Crookes

Connected a USB flash drive, SD card, 
microSD card or SSD to your iPhone 
(whether direct or via an adaptor)? 
Then, as long as it has a single data 
partition and has been formatted as 
APFS (encrypted or not), macOS 
Extended (HFS+), exFAT (FAT64), FAT32 
or FAT, you can view its contents using 
your iPhone’s Files app. 

Simply launch Files on your iPhone, 
select the external device listed under 
Locations in the Browse tab and any 
saved files and folders will appear. In 
most cases, you should be able to tap, 
open and view them directly and, if you 
tap the ‘…’ button in the top-right corner, 

you can view the files as a list or as 
icons, and arrange them by name, 
kind, date, size or tags. 

You can also create a New Folder on 
the external device, scan a document and 
save it straight to the card or drive, or 
remove files and folders by swiping left 
and tapping Delete. By tapping and 
holding a file to rename, compress or 
duplicate it, you can tap Move to store 
it in the cloud or on your iPhone.

Likewise, you can use the same 
method to move files from iCloud or 
your iPhone to your connected card or 
drive and even tap Share and share the 
files with others.

Manage your documents in the Files app

USB-C allows for faster data speeds 
of up to 10Gbps with a USB 3 cable

You’re now able to view the contents of a variety 
of storage options direct from your iPhone.

You can pick up many 
inexpensive USB-C monitors 
to connect to your iPhone, 
including this Dell S2722QC.

USB-C on iPhone APPLE SKILLS
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EXPERT 
ADVICE

How to restore iCloud shared databases

Q
I have a key app that syncs its 
encrypted database using iCloud. If 
I needed to, could my Time Machine 

backups restore that database?
by S C O T T  A N D E R T O N

A
In most cases, shared databases in 
iCloud should be backed up by Time 
Machine if it makes backups of your 

Home folder, and you haven’t put the Library 
folder within that in the list of excluded 
locations.

Shared databases like this shouldn’t be 
included in your iCloud Drive. But the local 
copy of the database they save to iCloud 
using iCloudKit, a different service from file 
sharing in iCloud, should be located in a 

ow that you can 
rent up to 12TB 
of storage in 

iCloud+, some Macs are 
running into ‘storage debt’. 
That can only occur when 
they have Optimise Mac 
Storage turned on in iCloud 
settings, and many of the 
files in iCloud Drive have 
been evicted from that 
Mac’s local storage. When 
the total size of those 
evicted files exceeds free 
storage space in your Home 
folder, there’s no longer the 
free space to accommodate 
the entire contents of 
iCloud Drive.

Like other forms of debt, 
that isn’t necessarily bad, 
but it does come with 
significant side effects. If 
they’re only stored in iCloud, 
Time Machine can’t back 
those files up, nor can 
Spotlight search them. Not 
only that, but you’re a 
prisoner of Optimise Mac 
Storage, can’t turn it off, and 
you’re committed to paying 
for sufficient storage quota. 

N

Is ‘storage 
debt’ 
dangerous?

56 | MACFORMAT | JUNE 2024

You should be able to restore shared databases from Time Machine backups – check your Home Library/Containers folder.

folder inside your user’s Library, normally 
inside a suitably named folder in Containers 
there. That app’s documentation may 
identify its location.

Even when you set iCloud Drive to 
Optimise Mac Storage, so files can be evicted 
and not held locally, shared databases remain 
accessible on your Mac. The app uses that for 
its transactions, that are then synced to the 
copy of their database in iCloud.

The easiest way to restore shared 
databases, though, is simply for them to be 
synced down from iCloud, requiring no effort 
on your part, or access to hidden folders. For 
some of the more common databases such 
as those of Apple’s bundled apps, that’s 
usually the most reliable.

 Image credit: Apple Inc



iOS software GENIUS TIPS

Q
When I changed to an iPhone 
15, I bought an adaptor 
and cable to connect it to 

CarPlay. While it charges correctly 
and I can make phone calls, it won’t 
connect for anything else. How can 
I get it to work?
by H U G H  C O W A R D

A
Assuming your car is 
a model in Apple’s list at  
bit.ly/mac404carplay, that 

CarPlay is supported in your country, 
the cable and adaptor are good, and 
your iPhone is running the latest iOS, 
this should be straightforward. But 
when it doesn’t work, there are 
enough things that can go wrong 
to make it tricky to fix.

Start with the cable connection, 
using an official Apple USB-C to 
Lightning Adaptor, with a branded 
USB-A to USB-C cable if needed. 
Ensure that Bluetooth and Wi-Fi are 
also turned on for your iPhone, and 
check the car’s Auto-Join setting is 
turned on for the CarPlay network.

Restart your iPhone and your 
car’s system, then ensure that 
Siri is turned on. In Settings > 
Screen Time > Content & Privacy 
Restrictions, if turned on, check 
that CarPlay is enabled in the list of 
Allowed Apps. If it still hasn’t set up 
properly at this stage, in Settings > General  
> CarPlay, tap your car and then Forget This 
Car to set it up from scratch once more.

The final step is to arrange with your 
garage for them to take a look with you, 

How to keep my 
iPhone’s ringtone 
set to maximum?
> Disable the volume 

buttons to prevent any 
inadvertent changes. 

In Settings > Sounds & 
Haptics turn off ‘Change 

with Buttons’, and set 
the volume control 

above to maximum.

How to make a 
folder for apps on 

my Home Screen?
> Open the Home 

Screen page containing 
one of the apps to go 

into that folder, and 
tap and hold until the 
app icons jiggle. Drag 

another app to be 
added and drop it on the 

first app. iOS puts both 
apps inside the new 

folder, and you can edit 
its name. Tap to stop the 

apps jiggling, then tap 
outside the folder to 

close it, and tap again 
to return the Home 

Screen to normal.

Quick-fire 
questions 
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Get CarPlay 
to start up

iOS software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

Some controls that can block CarPlay are hidden away; 
this is buried deep in Screen Time’s Allowed Apps.

 Image credit: Apple Inc

and if necessary to perform a full reset of 
the car’s head unit in its infotainment system. 
They may also be able to update the car’s 
software support in the process.



GENIUS TIPS Networking

on, both you and macOS can decide to evict 
local files by removing the data from them, 
so it has to be downloaded again before they 
can be used. That frees up storage on your 
Mac, but evicted files can’t then be backed 
up or searched as a result.

The Desktop & Documents Folders setting 
determines whether those two folders become 
part of iCloud Drive. Provided that Optimise 
Mac Storage is turned off, it doesn’t remove 
anything from your Mac, although many users 
find it disorientating as those folders no 
longer appear to work the way they used to.

Unless you want the entire contents 
of your Documents and Desktop folders in 
iCloud Drive, it’s better to copy or move files 
manually into its folders, and that’s the more 
popular choice. If you change either setting, 
expect iCloud to run a large sync afterwards 
to set itself up properly.

Q
I’m trying to keep my documents 
both locally on my Mac and copied to 
iCloud Drive, so I turned on Desktop 

& Documents in Sonoma. Everything has 
ended up in iCloud, and it’s no longer on 
my Mac. What have I done wrong?
by N I C K  C O O K

A
iCloud Drive has two fundamental 
controls: Optimise Mac Storage in 
iCloud settings, and Desktop & 

Documents Folders, accessed by clicking 
iCloud Drive in Apps Using iCloud there. 
You also need ‘Sync this Mac’ enabled to 
allow these to work properly.

With the Optimise Mac Storage option 
turned off, your Mac contains an identical 
copy of everything you put in iCloud Drive, 
and can’t remove or evict files so that 
they’re only stored remotely. With it turned 
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Quick-fire 
questions 

Recover documents from iCloud Drive

Turning Desktop & Documents Folders on doesn’t actually remove those folders from your Mac, but moves them into iCloud Drive.

How to set my 
Mac to sync with 
an NTP server?

> Network Time Protocol 
(NTP) servers deliver 
accurate time to set 

your Mac’s clock. This 
should normally be set 

to the default in System 
Settings > General > Date 

& Time, to enable it 
to set automatically. 
If you have a better 

alternative, click the Set 
button for Source, and 
enter its web address.

How to enable 
stealth mode 
on my Mac?

> This is only available 
when you enable your 

Mac’s software firewall. 
Open System Settings, 

open Network there and 
click Firewall. Turn that 

firewall on, then click on 
the Options button. 

Turn on ‘Enable stealth 
mode’, and turn off 
‘Block all incoming 

connections’ unless 
you also want to 

enable that firewall.

Networking 
We help to solve your Wi-Fi woes  
and connection conundrums

 Image credit: Apple Inc



Networking GENIUS TIPS

Q
Storage on 
my NAS is now 
completely full 

of my old Time Machine 
backups. As I’ve just got 
a new iMac, how can I start 
again with fresh backups?
by D A V I D  H I G N E T T

A
This is a good time to consider 
replacing the hard drives 
currently in your NAS system, 

as you could then put the old ones 
by as archives, and start your new 
backups on a set of brand new drives. 
Before changing anything else, update 
the operating system on the NAS 

Q
I’ve just updated my old Mac 
Pro with a USB-C PCIe card. 
Can I connect that to my 

MacBook Pro’s Thunderbolt port using 
a Thunderbolt cable, and network them?
by J O E  B L A K E

A
Although Thunderbolt 3 and 4 
use USB-C ports and cables, they 
require special interface hardware 

to combine their DisplayPort video data with 
PCI Express 3.0 x4 through a dedicated 
Thunderbolt chip. That’s not the same 
as regular PCI Express run over USB, and 
your MacBook Pro won’t recognise that as 

Who to report a fake 
Apple email to?
> If you receive an email 
claiming to be from 
Apple, but you’re fairly 
certain that it has been 
forged, forward it to 
reportphishing@apple.
com. Ensure you include 
header information 
using the Forward As 
Attachment item in 
the Message menu.

Is there a modern 
equivalent to a 
Helios LAN Test?
> That extensive test and 
benchmarking software 
for local area networks 
(LANs) only appears to 
be available as an old 
32-bit app that won’t run 
on any version of macOS 
after Mojave. There 
doesn’t appear to be 
anything similar to 
replace it either.

High speed networking for old Mac Pro

Make fresh 
backups to 
a full NAS

Thunderbolt, so can’t run Ethernet over 
Thunderbolt network protocols through it.

Some people have managed to upgrade 
their ‘cheesegrater’ Mac Pros with 
Thunderbolt 3; but even if you can manage 
that, you’d still have to get your Mac to 
recognise that as a network port. That 
requires adding a Thunderbolt Bridge 
network device to its Network settings, 
which seems an unlikely prospect.

Otherwise, your best option is to locate 
and install an expansion card that includes 
10Gb Ethernet, although you’ll then need to 
buy a matching Thunderbolt to Ethernet 10G 
adaptor, which would be expensive.
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To enable Thunderbolt networking, connect both Macs using Thunderbolt and add a Thunderbolt Bridge network device.

according to its documentation, to 
ensure it’s fully compatible with your 
new iMac, which will prefer using the 
SMB protocol rather than AFP (which is 

being phased out in macOS). Ensure 
the iMac has been fully migrated, and 
you don’t need anything from those 

old backups to assist.
If you’ve replaced 

the drives, you’ll need 
to completely initialise 
those new drives 

anyway; if you’re 
going to continue 
backing up to your 
old drives, use the 

web browser interface 
to the NAS to wipe and 
re-initialise them. That 
will create new volumes, 

on which you set up the new backup 
stores. On your iMac, remove any old 
store from Time Machine’s settings and 
add the new one you’ve just created on 
the NAS. The first full backup should 
then start, and may need to be left 
running overnight to complete.

Migrating to a new Mac is a good time to 
consider putting old backups into archive 
and replacing the hard drives.



Quick-fire 
questions 

GENIUS TIPS macOS

on every file that they write. umasks can’t 
be applied to just specific folders, though, 
and the only system capable of doing that is 
an extension of basic permissions in Access 
Control Lists or ACLs. Those override standard 
permissions with a complex and finer-grained 
system of Access Control Entries that can give 
write access to everyone according to the 
folder permissions.

ACLs can be set using the chmod 
command in Terminal, and using TinkerTool 
System 8 from bit.ly/mac404tinkertool. 
However, they’re complicated and the risk 
of causing problems is significant. A simpler 
solution less likely to mess up your shared 
folders is for each user to periodically select 
their shared folder, open the Get Info dialog, 
and correct permissions with the ‘Apply to 
Enclosed Items’ command in the pop-up 
menu at the foot.

Q
Each family member has their 
own folder in Users > Shared on our 
main Mac for sharing documents. 

Although set to give everyone read and 
write access, when they save new files 
there others can’t write to them. How can 
we change permissions to allow that?
by G R E S H A M  A R N O L D

A
Although part of the permissions 
system in macOS, those set for 
new files created by users aren’t 

determined by the permissions of the 
enclosing folder, but by a user’s umask. The 
standard umask sets permissions on all new 
files created by a user so that everyone has 
read-only access, and can’t write to that file.

Although you can change a user’s umask, 
as described by Apple at bit.ly/mac404umask, 
that isn’t wise, because it changes permissions 

How to update 
firmware on an old 

Mac in Mojave?
> Firmware updates now 

only come as part of 
macOS updates. The 

last security update for 
Mojave was 2021-005 

(21 July 2021), which 
should have been 

installed. Unless you 
want your Mac to lose 

the ability to run 32-bit 
apps, you shouldn’t 

install Catalina or later.

Can Rosetta 2 
run old 32-bit 

Intel apps?
> No, it can only 

translate code and run 
64-bit Intel apps that 

are compatible with 
more recent versions of 

macOS, from Catalina 
onwards. As Apple 

silicon Macs can’t run 
Intel-only versions 

of macOS in virtual 
machines, the only 
way you might be 

able to run them is in 
emulation using UTM.
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macOS 
Shine a spotlight on the solutions to 
your most irritating Mac problems

Give everyone write access to shared docs

Use the ‘Apply to Enclosed Items’ command in the Get Info dialog to change permissions for all files inside a shared folder.

 Image credit: Apple Inc



macOS GENIUS TIPS

One way to customise which columns appear in the Finder’s List view 
is by setting your preference in its View Options.

Q
The Finder’s List view can’t 
remember changed column 
widths. How can I fix that, 

and remove the Size column?
by K E I T H  G I B B I N S

A
Currently, there doesn’t appear 
to be any way to get the Finder to 
remember column widths in List 

views, and you have to adjust each as you 
need them. Neither do third-party utilities 

Change Finder’s List view layout
like Tinkertool seem able to save them for 
you. You can, though, customise the columns 
that appear there…

Open a new Finder window and set it to 
List view. Then use the Show View Options 
command in the View menu to open and set 
the window’s options, including selecting 
which columns are shown. Alternatively, you 
can set this directly in that window, using 
Ctrl-click-hold on one of the view headers to 
open a menu containing fields to be displayed.

How to set a 
firmware password 
on my M3 Mac?
> Apple silicon Macs 
don’t have firmware 
passwords, which are 
only available on Intel 
models with their EFI 
firmware. This is 
because of their 
different firmware and 
Secure Boot mechanism, 
which protects your Mac 
better than any EFI 
password ever could.

How can I set 
Wallpaper to show 
my photo library?
> In theory, this is 
an option available 
in System Settings  
> Wallpaper, but at 
present this doesn’t 
work as intended, at 
least not on most Intel 
Macs. Until it’s fixed, 
use one of the other 
options there that 
does work correctly.
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Q
Although I typed in my 
password correctly, when 
I try to log into my M1 iMac, 

it refuses to accept it. Has it forgotten 
or corrupted my password?
by S T E V E  R O W L E Y

A
Because of the way that Apple 
silicon Macs store and use login 
passwords, it’s far more likely 

that it’s not being entered correctly. 
Don’t keep trying to enter it, though, as 
your Mac’s security system only allows 
a limited number of attempts to enter 
the login password, and soon starts to 
enforce delays, first of a minute, rising 
to as much as an hour before locking 
you out. Check the Caps Lock isn’t lit, 
then open the keyboard menu at the 

top right of the login screen and ensure 
you’ve the correct keyboard set for 
entering your password. 

If those don’t fix the problem, and 
you’re being meticulous in entering 
every character correctly, 
it’s time to look at 
alternatives, offered by 
clicking on the ‘?’ inside 
a circle at the right end 
of the password entry box. 
That should show any 
password hint you set, 
and may give you the 
option of resetting your 
password using your Apple 
ID and its password, using 
a Recovery Key if you 
opted for that, or 

restarting into Recovery mode to 
perform a password reset there.

If you’re still stuck after trying 
these, Apple explains all the options 
at bit.ly/mac404maclogin.

Why won’t my login password work?

 Image credit: Apple Inc

Alternatively, you can achieve the 
same change using the contextual 
menu (Ctrl-click) for the List view’s 
column headers.

Don’t keep entering a rejected password when trying to log in, 
as eventually you’ll be locked out of your Mac.



Become an

Turn your clips into a slick movie with our 
collection of pro shooting and editing tipsWritten by George Cairns
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S hooting videos on your 
iPhone is so easy these 
days that it’s tempting to 
be a bit blasé about it. But 

with a little know-how, some video 
editing skills, and additional third-party 
film-making accessories, you can turn 
ordinary clips of your pets, friends and 
holidays into a mini-movie masterpiece. 
This guide will show you how! 

We’ll explain how to set up your 
iPhone to record footage that suits your 
movie-making requirements, whether 

that’s capturing 4K clips for sharing as 
High Definition footage on a widescreen 
TV, or shooting smaller social media-
friendly files that will catch the eye (and 
elicit ‘likes’) in your Instagram or X/
Twitter) feed. 

We’ll recommend which iPhone 
movie formats will give you more 
control when adjusting colours and 
tones in the edit, and we’ll suggest 
third-party gadgets, such as wireless 
mics and LED lights that will elevate 
your movie making to a more pro level.

We’ll explain which Camera app 
shooting modes can capture gimbal-
smooth action without needing a 
gimbal, plus show you how to add a 
Hollywood style bokeh (blur) to a clip’s 
background using the Cinematic mode 
(and even pull focus from foreground to 
background subjects like a pro camera 
operator). We’ll also demonstrate a 
variety of video editing techniques 
that will give your content a more 
professional look that will impress 
family, friends and followers alike.

1

Apple ProRes 
 ProRes is a 

professional video 
format. The Log 
colour option 
captures a wide 
dynamic range, 
and gives more 
editing control.

3

Clip resolution
 Tap here to 

toggle between 
High Definition 
(1080x1920) or 
4K (3840x2160) 
resolution clips, 
the latter takes 
up more storage.

5

Log colour 
 Log colour clips 

look desaturated 
with a low or ‘flat’ 
contrast. You can 
adjust colour and 
tone in the edit 
for a wide range 
of looks.

2

Action mode
 Tap here to 

toggle on Action 
mode. This gives 
you gimbal-
smooth footage, 
counteracting 
shaky handheld 
camera moves.

4

Duration
 ProRes files take 

up more space 
than standard 
clips, so your 
iPhone estimates 
how much footage 
you can capture 
in this format.

6

Spatial video
 On iPhone 15 Pro 

and Pro Max, tap 
here to shoot 
Spatial Video clips 
that can then be 
viewed in 3D on 
an Apple Vision 
Pro headset.

EXPLAINED… Movie-making settings on iPhone 

1

2

3

4

6

5

 Image credits: Apple Inc, George Cairns
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S hooting movies on your 
iPhone can be fun and 
exciting, and video clips are 
more likely to catch the eye 

on a social media feed than still 
images. As it’s ever-present, you can 
whip out your iPhone and press the 
Action button (on iPhone 15 Pro) to 
instantly open the Camera app. If you 
then press and hold the Action button 
you’ll start recording video. This enables 
you to capture clips of spontaneous 
events such as your child’s first steps. 

However, the best movies should 
start with a bit of planning ahead (which 
professional movie makers refer to as 
the pre-production stage). For example, 
if you’re going to shoot a wedding then 

By shooting with an iPhone mounted in a cage, you 
have more control over camera moves, such as 
rotating the cage to follow the action.

How to Choose the appropriate format and shooting mode > 

1Choose ProRes format
For more editing control over colours 

and tones, use ProRes Log Color format 
(see the guide on p63), although this 
takes up more space. Go to Settings > 
Camera > Formats to turn Apple ProRes 
on. Set ProRes Encoding to Log.

2Opt for Action mode
If chasing your kids or shooting a 

sporting event, set the Camera app to 
shoot video using the Action mode (see 
the guide on p63). This processes shaky 
footage to make it look gimbal-smooth; it 
works best in brightly lit locations.

3Slow things down
When shooting sporting action 

sequences, choose the Camera app’s  
Slo-Mo to slow down time. However, bear 
in mind that Slo-Mo clips are restricted 
to smaller sizes of 1080p HD (at 120 fps) 
or 720p HD (at 240 fps).

Gear up!

Make plans, gear up and shoot
you might want to consider packing 
some helpful accessories into a kit bag, 
such as an iPhone handheld cage. Cages 
have cold shoe mounts – so that you can 
clip accessories on – such as a JOBY 
Beamo LED light to help you capture 
more detail in gloomy interiors, or a mini 
directional shotgun mic to capture 
clearer audio during a noisy party. 
Check out our top kit recommendations 
in this spread’s Gear Up! section.

Shoot to edit
After the pre-production stage you 
move onto your movie’s recording (or 
production) stage. Instead of recording 
the action as one long boring shot with 
the camera panning wildly back and 
forth (or ‘hose-piping’), break it up into 
shorter clips that you can edit together 
to tell a story. 

For example, if shooting action (such 
as a friend performing a parkour move), 
film a static wide shot of the action first. 
Then change your camera angle and 
shot size and ask your friend to repeat 
the same action. You can then cut from 
the wide shot to the close-up in iMovie 
(in the post-production editing stage), 
and it will look like the action was shot 
‘live’ by two cameras, creating a more 
professional-looking sequence.

To improve the production values of 
your footage consider splashing out 
on these third-party gadgets.  
1  The NEEWER iPhone cage (uk.

neewer.com) lets you slide your iPhone 
into a robust aluminium cage. The side 
handles give you a safer grip on your 
phone and enable you to perform a 
range of slick camera moves, from tilts 
and pans to 180º rotations – perfect for 
filming a child performing a somersault 
on a trampoline, for example!

Your iPhone’s built-in mic can do 
a great job of capturing voices from 
subjects in close proximity, but the 

1

Make movies with your 
iPhone – explained!

 Image credits: Apple Inc, George Cairns
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4Shoot in Cinematic
Movie cameras can add background 

blur (bokeh) to draw attention to the 
foreground subject. To mimic this look, 
shoot your subject in Cinematic mode. 
You can adjust a Cinematic mode clip’s 
blur amount and focus point in the edit.

5Make time fly
To add a variety of movement, pop 

your iPhone on a mini tripod and set it 
to Time-Lapse shooting mode. Leave it 
recording for a few minutes. You’ll 
capture moving subjects, such as people 
and clouds, whizzing by at high speed.

6Activate Spatial Video
iPhone 15 Pro owners can activate 

Spatial Video for Apple Vision Pro in the 
Format menu. This uses the Main and 
Ultra-Wide cameras to record depth when 
you shoot in landscape orientation. Tap 
the goggle-shaped icon to activate this.

sound quality rapidly drops off as your 
subject gets more distant, plus ambient 
noise such as traffic can easily make 
voices inaudible. By purchasing a wireless 
mic kit like the 2  Saramonic Blink 500 
B2+ (saramonicuk.com) you can improve 
your movie’s audio production values. 
Simply clip the Blink 500 B2+’s small 
transmitter mic onto your subject’s 
clothing (or attach it via a magnet) and 
then broadcast their sound wirelessly to 
a receiver plugged into your iPhone 
(from up to 150 metres away!). The 
transmitters have an effective noise 
reduction feature too. The Blink 500 B2+ 
kit ships with two receivers – one that’s 

compatible with older iPhone Lightning 
ports and a second USB-C version that 
will slot into an iPhone 15 model.

If you are a self-shooting vlogger and 
want to walk and talk while the iPhone 
follows your every move then consider 
buying a gimbal. Your iPhone is quite 
capable of shooting gimbal-smooth 
footage thanks to its Optical Image 
Stabilisation feature, but gimbals do 
more than simply keeping the iPhone’s 
movement looking stable.  
3  The DJI Osmo Mobile 6 (dji.com) 

uses a free app to make the gimbal-
mounted iPhone pan and tilt to keep your 
face in shot as you walk and talk. This is 

like having your own camera operator 
on location! You can also plug a Blink 
500 B2+ receiver into your iPhone 
while it is mounted on the DJI Osmo 
Mobile 6 so your clip will feature 
camera moves and you’ll sound great!

Hitting the beach with your family 
offers plenty of movie opportunities, 
and while an iPhone 15 is water-
resistant for up to 30 minutes, you’ll 
be safer popping it inside a waterproof 
casing like the 4  JOBY SeaPal (joby.
com). If you drop your ‘naked’ iPhone 
in the ocean it will be a challenge to 
locate it, but inside the SeaPal it’ll 
be much easier to rescue!

2

3

4
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Y our iPhone will soon 
become full of video clips 
that you can find quickly 
in the iPhone Photos app 

by tapping on Albums and scrolling 
down to Videos. 

Tap to view a clip. You can then tap 
Edit to apply the same editing tools that 
you’d use to adjust a photo’s colours and 
tones to a clip. In addition, Photo’s 
video-editing tools enable you to drag 
trim handles at the start and end of a clip 
to cut to the best bit. This process also 
makes the clip shorter and easier to 
upload if you want to share it to social 
media. After editing a single clip, tap 

Done, choose ‘Save Video as New Clip’, 
then tap Share to share it via Mail, 
Instagram, and so on. Sharing a single 
short clip from the Photos app is fine, 
but you can do so much more with your 
valuable video assets by using iMovie to 
turn a collection of individual clips into a 
professional-looking story, complete with 
titles, transitions and music.

Gather your clips
iMovie is Apple’s free NLE (non-linear 
editor), that enables you to pop clips into 
a timeline, trim their duration and swap 
their running order (hence the term 
non-linear) to tell a story. You should 

have iMovie as a built-in app on your 
iPhone (if you don’t have it, download 
it for free via the App Store.) Editing 
clips on the iOS version of iMovie is 
straightforward, but the macOS version 
has extra tools (such as ways to improve 
problems with audio tracks), and you 
have more screen space to work in on 
an iMac or MacBook. 

On these pages, we’ll explain how to 
transfer clips from iPhone to Mac, and 
how to use iMovie’s basic non-linear 
editing tools to create a tightly edited 
and smooth-flowing sequence to share 
with family and friends. We’ll then 
explore more expert techniques on p68.

Editing in iMovie on Mac

EXPLAINED… The iMovie interface 

1

My Media panel 
 All imported iPhone 

clips are visible as 
thumbnails. Swipe 
the cursor across 
a thumbnail to 
preview its content 
in the viewer.

3

Viewer
 Here you can see 

your movie sequence 
starting to take shape. 
Above the viewer 
section, you’ll find 
extra tools that we’ll 
explore on p68.

5

Transitions
 Transitions provide 

eye-catching ways to 
wipe, mix, fade, and 
so on, from one clip to 
the next instead of a 
simply using a series 
of abrupt cuts.

2

Non-linear timeline
 The timeline enables 

you to arrange your 
clips in any order 
(hence the term 
‘non-linear’). You 
can also trim each 
one’s duration.

4

Titles 
 The Titles browser 

is packed full of 
animated titles. 
You can drag a title 
above a clip in the 
timeline and modify 
it in the viewer.

1

2

3

4

5

Turn your long rambling clips into a slickly-edited story

 Image credits: Apple Inc, George Cairns
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How to Transfer clips from iPhone to Mac > 

How to Export and share your finished film > 

How to Make some basic edits > 

1AirDrop your clips
In Photos, go to the Videos album. Tap 

Select, then select the clips you want (a 
blue tick will appear on each). Tap Share, 
then AirDrop. Tap your Mac’s AirDrop 
icon. The clips will be sent to your Mac’s 
Downloads folder.

1Add a title
After choosing your clips’ running 

order, trimming their duration and adding 
transitions, add some titles. Click on 
Titles. Move the pointer along a 
thumbnail to preview the animation, then 
drag a title above a clip in the timeline.

1Add and trim
Move the pointer across a thumbnail 

in My Media to preview it. Drag a clip to 
the timeline (or press W). Place the 
pointer at the start/end of a clip to 
activate Trim. Drag to trim the clip / make 
the action start or end at a specific point.

2 Import your clips
Launch iMovie on Mac. Click on the 

Projects tab, then Create New. Choose 
Movie > File > Import Media. Browse to 
Downloads, hold Shift and click to select 
movies. Click Import > Selected. The clips 
will appear in iMovie’s My Media browser.

2Customise the title
Double-click on the title bar in the 

timeline. Editing tools will appear in the 
viewer. Choose a different font for the 
title. You can also adjust font size, turn it 
bold, or add an outline. Click the Colors 
button for a more eye-catching colour.

2Change order and angle
Drag and drop to swap the timeline’s 

clip order to help the story flow. Cutting 
from one clip’s camera angle to one 
from a different angle adds variety. Press 
Shift+Z to make the timeline zoom out 
to show every clip that you’ve added.

3 Import via USB-C
If you have an iPhone 15, plug it into 

your Mac via USB-C. In iMovie, choose 
File > Import Media. In the Import window, 
click the iPhone icon. Hold Cmd and click 
to choose multiple clips from your iPhone 
Photos Library. Click Import Selected.

3Share your clip
Click the Share button. Choose 

‘YouTube & Facebook’ to create a low-res 
640x350 file that’s easy to upload. For 
higher-quality movies, choose Export File. 
You can then create full 1080p Full HD 
files that will look great on a TV.

3Add a transition
Click on the Transitions browser. 

Move the pointer along a transition to 
preview it. Drag a transition between two 
clips in the timeline. Tap the Space bar to 
preview it. Double-click the transition’s 
icon to increase its duration.

 Image credits: Apple Inc, George Cairns



68 | MACFORMAT | JUNE 2024

Advanced editing in iMovie
Add grading, special effects, and enhance audio tracks

O nce you’ve edited rambling 
raw footage into a short, 
slick sequence – complete 
with titles and transitions 

– you can add an extra level of post-
production polish to make your show 
stand out from the social media crowd. 
Due to different lighting scenarios, such 
as sun and shade, some clips might 
suffer from colour casts (such as a cold 
blue or green tint appearing in certain 
shots). You may even notice a finger 
partially obscuring a corner of the frame 

(a common occurrence when holding 
your iPhone!) Fortunately, iMovie has 
all the tools you need to counteract 
problems with composition, colour 
and tone, as we’ll demonstrate.

You can also take your picture 
adjustments a step further and change 
the look of a clip more creatively using 
grading tools such as Filters. Filters can 
change the mood of a clip by adjusting 
colours and tones in just one click. 
iMovie will even take Log colour clips 
straight from your iPhone and improve 

their colour and contrast automatically 
before you make more creative 
adjustments. 

We’ll also show you how to adjust 
the properties of a Cinematic mode clip 
to change the strength of its blur, and 
show you how to pull focus from 
foreground to background subjects like 
a professional camera operator. Then 
we’ll finish off with some eye-catching 
layer-based effects, such as picture-in-
picture combinations, and even indulge 
in some green-screen compositing!

How to Adjust colour, tone and composition > 

1Use Log colour
In the guide on p63, we featured a clip 

shot in the iPhone’s Log colour format. It 
displayed drab colours and flat tones. 
When you import a Log colour format clip 
into iMovie, it automatically boosts the 
clip’s saturation and contrast.

2Warm up cold colours
Clips shot in the shade can look cold 

(blue). To warm them up, click on Color 
Balance above the viewer, then click 
Match Color. Browse to a sunnier clip in 
the timeline and click on it to transfer its 
warmer colours to the ‘cold’ blue shot.

3Correct composition 
One of our example clips features a 

finger obscuring the lens. To exclude this, 
click on the Crop icon above the viewer. 
Click Crop to Fill. Drag the top-left corner 
handle down to crop out the unwanted 
finger. Click the tick to apply the change.

 Image credits: Apple Inc, George Cairns
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How to Add extra effects > 

How to Get your movie the Hollywood look > 

1Add a background blur
When working with a Cinematic mode 

clip, you’ll see an extra camera icon 
appear above the viewer at the top left. 
Click on it. Tick the ‘Depth of Field’ box 
to add a background blur. Drag the 
adjacent slider left to increase the 
strength of the background blur.

2Change the focus
To change the focal point of the clip, 

click on the background of a specific 
frame. A yellow reticule will indicate that 
the background is in focus. When you 
play the clip, the camera will then change 
focus from the foreground subject to the 
background on the chosen frame. 

3Add a filter
To creatively grade a clip’s colours, 

click on the Clip Filter icon above the 
viewer. Then click the Clip Filter button. 
A collection of 34 filter thumbnails will 
appear. Hover the pointer over a 
thumbnail to preview its look. Click 
to apply a filter to the clip.

1Add sound effects
The Clip filter featured in the previous 

step also gives you access to a collection 
of creative audio effects. Click the Audio 
Effect button and place the pointer on an 
effect’s thumbnail to preview how it will 
alter a clip’s sound. Click the thumbnail 
to apply the effect.

2Try Picture in Picture 
If you place one clip on a layer above 

another clip in the timeline, you can 
combine the overlapping clips in a variety 
of creative ways. Click on the top layer 
clip, then click on the Video Overlay icon 
above the viewer. Choose an option 
such as Picture in Picture. 

3Use compositing tricks
If you shoot against a green or blue 

backdrop (such as a curtain or a large 
piece of card), you can use the Video 
Overlay icon’s Green/Blue Screen menu 
option to replace the top layer clip’s 
coloured backdrop with the background 
from the clip on the layer below. 

Edit your movie on the iPhone

If you’re in a rush to get a collection of clips edited and shared, use the iOS iMovie app 

to make basic edits such as trimming clips, swapping running order in the timeline, 

and adding titles and transitions. You can also add filter effects in a single tap for a 

more creative look, and adjust the speed of clips shot in Slo-Mo mode. The iMovie app 

offers pop-up help labels that explain how to perform a range of editing techniques. 

Once you’ve finished editing your movie, tap Done, then tap Share. Tap Share Video 

to export it via AirDrop, Mail, or send it to your favourite social media site.

Edit and share on the go! 

 Image credits: Apple Inc, George Cairns



T
he Apple Watch has an 
abundance of apps. No, really, 
believe us, it does. While it may 
feel at times that the device 
is not as well served as the 

iPhone, iPad and Mac (and, in truth, it isn’t), the 
App Store is actually very healthy these days 
with many innovative and talented developers 
making good use of the wearable’s capabilities.

The result of this activity is a wealth of apps 
across a wide range of categories which put 
a lot of power on your wrist. The majority of 
them come as part of a package – an additional 
goodie when you download an app to a paired 
iPhone. In this case, the Watch app will usually 
automatically install on your Watch. If it 

doesn’t, just launch the Watch app on your 
iPhone, tap the My Watch tab, scroll down 
and tap Install next to any app you want to 
appear on your wearable.

Many other apps can be downloaded 
directly so long as you’re running watchOS 6 
and above – the version that introduced the 
Watch’s own App Store. To browse these 
offerings, just launch the App Store app 
and scroll through the recommendations 
or tap search and use the keyboard, Scribble 
or Dictation to enter the name of an app and 
tap Get to install it. If you go to the bottom 
of the App Store’s home page, you can 
check past purchases, view subscriptions 
and see which apps need updating.

Written by David Crookes

Your Apple Watch can do some incredible things. 
But to do them, you may need a little help…
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Rather not take 
your iPhone on 
a run? Strava is a 

standalone app so you don’t 
have to. It uses GPS to track 
your runs, hikes, bike rides, 
swims and more, recording 
data straight to the watch 
and delivering easily readable 
insights such as your average 
pace to help you improve.

Whether you’ve 
planned your own 
adventure or chosen 

one of Komoot’s, you can 
navigate from your Watch. 
There’s a choice of hiking, 
mountain biking, road cycling 
and bike touring routes, and 
tours can be saved for offline 
navigation and you’ll get 
turn-by-turn notifications.

This runner-
designed app is 
worth the cost for 

its brilliant tracking metrics. 
You’ll need an active premium 
subscription, but you’ll be able 
to track your distance totals 
from your wrist and see them 
as a complication on your 
Watch face.

It’s hard to turn a 
desire into a habit 
but this app will 

nudge you in the right 
direction. Set up as many 
as 24 tasks – whether that’s a 
prompt to brush your teeth or 
eat some fruit – then indicate 
when you’ll need reminding 
and Streaks will motivate 
you to stick to your plan.

Strava: Run, 
Bike, Hike

KomootTempo – Runners’ 
Workout Stats

Streaks

 Free (with IAPs) 
 FROM strava.com 
 NEEDS watchOS 8 or later

 Free (with IAPs) 
 FROM komoot.com
 NEEDS watchOS 7.4 or later

 Free (with IAPs) 
 FROM indie.sh/tempo
 NEEDS watchOS 9 or later

 £5.99 
 FROM streaks.app
 NEEDS watchOS 7 or later

Stay focused on your goals and improve your well-being

A
long with many 
other life hacks, 
it’s no surprise 
that there are 

loads of health and fitness 
apps for your Apple Watch. 
As you’re likely aware, the 
Watch has heaps of features 
that will enable you to track 
your activity, workouts and 
well-being and, depending on 
the model, can also measure 
your blood oxygen, generate 
an ECG (electrocardiogram), 
track how well you sleep and 
check for high, low or irregular 
heart rhythms. 

Data can be checked 
within the Health app, but you 
can make better use of it by 
installing a bunch of third-
party options. Some are 
designed to motivate you, 
others seek to inspire, while 
many allow you to better 
analyse info so that you can 
make more informed choices.

Health & fitness
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A good night’s sleep 
is vital to your 
health so ensure 

you’re getting quality 
shut-eye with this stat-
packed app. Wear your Watch 
to bed and it’ll detect and 
analyse how long and how 
deeply you slept. You can 
instantly check data using 
one of Pillow’s Watch faces.

CARROT Fit 
combines fitness 
stats with snarky 

comments – struggle to get 
fit and the surprisingly 
motivating AI bot won’t hold 
back. Offering seven-minute 
workouts, it’ll accurately mop 
up your vitals and let you 
know when you’re done 
(literally and figuratively). 
Don’t quit!

Runkeeper’s 
standalone 
Watch app is like 

a simplified version of its 
iOS cousin which makes it 
feel more immediate. As you 
run, it’ll use haptics to let you 
know when you reach set 
stages and it’ll also let you 
know your current and 
average pace. Custom 
workouts are a tap away.

If you’re looking 
to improve your 
mental health, 

the courses and guidance 
on offer from Headspace: 
Mediation & Sleep can prove 
invaluable. The subscriptions 
are costly, but the Watch app 
gives you easy access to the 
sessions, so all you need to do 
is connect headphones and 
tap to ease your stress.

If you’re venturing 
out and about and 
you have allergies or 

a condition such as asthma, 
it’s a good idea to keep a 
check on the air quality. Air 
Matters will notify you of the 
real-time risks from your wrist, 
using colours so you can 
immediately see which 
levels are of concern.

It’s important to 
manage diabetes, 
prediabetes, blood 

pressure and cholesterol. By 
using your Watch to input blood 
sugar, medications, activity and 
food intake, One Drop Diabetes 
Management helps you track 
your range and seven-day 
average. You can also connect 
to OneDrop’s glucose meter.

Pillow: Sleep 
Tracker

CARROT Fit ASICS Runkeeper Headspace

Air Matters One Drop

 Free (with IAPs) 
 FROM pillow.app
 NEEDS watchOS 6 or later

 £4.99 (with IAPs) 
 FROM meetcarrot.com 
 NEEDS watchOS 3 or later

 Free (with IAPs) 
 FROM runkeeper.com
 NEEDS watchOS 8 or later

 Free (with IAPs) 
 FROM headspace.com
 NEEDS watchOS 9 or later

 Free (with IAPs) 
 FROM air-matters.com
 NEEDS watchOS 7 or later

 Free (with IAPs) 
 FROM onedrop.today
 NEEDS watchOS 7 or later

Apple Watch is the perfect 
travel companion, enabling 
you to organise your trip, 
navigate your way around 
and easily communicate 
with local people. Flighty 
(Free, IAPs), for example, 
shares flight details and 
alerts you to delays, while 
Citymapper (Free, IAPs) lets 
you discover the best routes 
around more than 400 
cities. With iTranslate 

Converse (Free, IAPs), 
you can hold natural 
conversations by picking 
a language and tapping to 
speak, and with Elk (Free, 
IAPs) you can turn the 
Digital Crown, enter 
numbers and make rapid 
currency conversions. 
Unsure if today’s a good 
day? Check snarky CARROT 
Weather (Free, IAPs) and its 
host of useful complications.

5 best travel apps

Best Watch apps FEATURE
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For utter simplicity, 
Just Press Record 
takes some beating. 

It does exactly as the title 
suggests: press a button 
(whether in-app, a complication 
or a Siri shortcut) and record 
unlimited audio. Recordings 
are then transferred to your 
iPhone, transcribed and 
synced via iCloud.

If you need to store 
and access nugget-
sized notes with 

the minimum of fuss, 
Cheatsheet is the way to go. 
Jot down your licence plate, a 
code or whatever else and 
view them in-app or as a 
complication. iPhone syncing 
requires Cheatsheet Pro.

Work for too long 
a period and your 
mind can wander, 

making you less productive. 
Step forward a fun, friendly 
cartoon bear to help you 
focus. After setting work and 
break times, you’ll be praised 
for working hard and nudged 
when you need a rest.

Not sure if your 
iPad, trackpad or 
Mac needs juice? 

Get Cloud Battery on your 
Watch and you can monitor 
the battery levels of Apple 
devices linked to the same 
iCloud account. As well as 
being able to do this within the 
app itself, you can also assign 
devices to a complication.

Just Press 
Record

Cheatsheet – Quick 
Note Widget

BFT – Bear 
Focus Timer

Cloud Battery

 £4.99  FROM openplanet 
software.com
 NEEDS watchOS 8.7 or later

 Free (with IAPs) 
 FROM overdesigned.net
 NEEDS watchOS 8 or later

 £1.99 
 FROM bearfocustimer.com
 NEEDS watchOS 6 or later

 Free (with IAPs) 
 FROM alanyan.ca
 NEEDS watchOS 7 or later

Your Watch can make your life easier all-round 

Y
our Apple Watch 
is effectively a 
mini-computer, 
so you can 

harness its ever-present 
nature to remove some of 
the stresses and strains of 
life. You can take the sting out 
of your daily chores through 
better organisation. Or speed 
up laborious processes and 
even make use of Apple Watch 
to aid you with your work.

Of course, all work and 
no play will make anyone a 
bit dull but, thankfully, your 
Watch can also be used to 
engage in a bit of fun to help 
you unwind. Admittedly, the 
screen is a bit too small for 
a truly satisfying gaming 
experience (despite gems such 
as Ping Pong – Watch Retro 
Game (Free, IAPs) and Star 
Duster (£1.99) but there are 
plenty of other entertaining 
apps to be found. 

Organisation 
& relaxation
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The brilliant Things 
3 is designed to 
work in conjunction 

with your iPhone app. 
You can tick off your 
accomplishments, postpone 
tasks, add new ones verbally 
and receive notifications. 
The app also keeps a check 
on the number of tasks 
you complete each day to 
motivate you to keep going.

Yes, it’s costly and, 
yes, there’s already 
a Calculator app 

built into the Watch but 
PCalc is still worth 
considering. It comes with 
a heap of functions, lets you 
quickly make unit conversions 
and enables you to calculate 
tips with ease. If you’re not 
sure, you can try the free 
PCalc Lite for a taster.

Forget the big 
screen: the latest 
videos should be 

enjoyed on the tiniest 
display possible. Probably. 
Okay, so this app could be 
dismissed as a novelty but 
WatchTube is still surprisingly 
feature-packed: subscribe to 
channels, see your viewing 
history and see which 
videos you liked.

Some store reward 
or membership 
cards are physical 

or don’t have Apple Wallet 
options. That means taking a 
screenshot of their barcodes/
QR codes or opening 
individual apps. Import them 
into Barcodes and you can 
store them in one place, 
ready to present at the till.

Grocery remains an 
invaluable shopping 
aid for one simple 

reason… It doesn’t merely 
allow you to view your 
shopping list, it actually learns 
the order you check off items. 
So the next time you shop, the 
list should better reflect the 
store’s layout.

Once you’ve set a 
countdown timer on 
your iPhone, you can 

check the Countdown Watch 
complication to see how long 
there is to go. You can set 
timers for anything – wedding 
anniversaries, birthdays, 
holidays, the day you leave 
your job and so on.

Things 3 PCalc WatchTube Loyalty Card 
Wallet – Barcodes

Grocery – Smart 
Shopping List

Countdowns – 
Event Countdown

 £9.99   
 FROM culturedcode.com  
 NEEDS watchOS 8 or later

 £9.99 
 FROM pcalc.com
 NEEDS watchOS 7 or later

 Free 
 FROM watchtube.app
 NEEDS watchOS 8 or later

 Free (with IAPs) 
 FROM smallcolossus.com  
 NEEDS watchOS 9 or later

 Free (with IAPs) 
 FROM smartgrocery.app
 NEEDS watchOS 6 or later

 Free (with IAPs) 
 FROM countdowns-app.com
 NEEDS watchOS 8 or later

Connect a pair 
of headphones to 
the Apple Watch 
and you’ve got a 
jukebox on your 
wrist. TuneIn (Free, 
IAPs) offers radio 
stations from across the 
world, while Spotify (Free) 
provides a great alternative 
to Apple Music – you’ll just 
need to go to Spotify’s 
website to sign up or buy 
a subscription. For a more 
personalised experience, try 
Endel (Free, IAPs) which 
uses artificial intelligence 
(AI) to create sounds using 
inputs such as your heart 

rate and location. Then 
check Audible (Free) to hear 
your favourite books. Enjoy 
podcasts? Try Overcast 
(Free, IAPs) which has Voice 
Boost for greater clarity 
and Smart Speed to shorten 
silences without making 
playback sound strange.

5 best 
audio 
apps

Best Watch apps FEATURE

The Apple Watch 
is the perfect 
companion for 
enjoying your 
music on the move. 
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Missed an issue?
Complete your collection of the 

UK’s No 1 magazine for Apple fans

Download back issues onto your 
iOS device at any time and keep them 

forever in your personal library. 
bit.ly/macformatipad

To order back issues of the print magazine, 
go to bit.ly/macformat_backissues 
or phone +44 (0)330 333 1113 and 

we’ll post them out to you.

NEVER MISS AN ISSUE! SUBSCRIBE TODAY!
IN PRINT & ON iOS

 Your print subscription includes the  
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edition for iPad and iPhone 
bit.ly/magazinesdirect_macformat

ON YOUR MAC
 Read on the big screen, too! If you prefer 
to read MacFormat magazine on a Mac, 

then subscribe with Zinio at  
bit.ly/ziniomacf

 IN PRINT  ON iPAD & iPHONE

ISSUE 402 
APRIL 2024

 67 amazing iPhone hacks
 Keep your old Mac running forever!

 42 must-try utilities for Mac
 Vision Pro – your first-look guide

ISSUE 403 
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 85 must-try iPad tricks + best apps
 Meet the new M3 MacBook Air
 Build your ideal smart home 

 Be an AI expert with ChatGPT

ISSUE 401 
MARCH 2024

 Give your Mac a speed boost!
 Hands on with the Apple Vision Pro

 Get fit and healthy with iPhone
 6 cool ways to create iPad art
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MacBook Air  
13-inch (2024)
 From £1,099  FROM apple.com/uk  FEATURES Apple M3 chip, 8GB unified memory (16GB/24GB 

available), 13.6in Liquid Retina display (2560x1664), 256GB storage (512GB/1TB/2TB available), Wi-Fi 6E 
(aka 802.11ax Wi-Fi), Bluetooth 5.3, 2x Thunderbolt/USB 4 ports, MagSafe 3, 3.5mm headphone jack

It’s little and good, but is there any more to it than that?

hen the MacBook Air first made its 
debut in 2008, it was remarkable 
for both its light weight and 

compact design – and that’s something 
that’s continued into the Apple silicon era, 
even if the original’s wedged-shaped design 
has given way to something more MacBook 
Pro-like in 2022’s M2 redesign and this 
year’s M3. Measuring just 30.41x21.5x1.13cm 
and weighing 1.24kg, the MacBook Air 13in 
remains a joy to use when commuting on 
space-constrained spaces on trains or planes, 
even if the arrival of the 15-inch version in June 
last year has overshadowed it somewhat.

This time around the MacBook Air 13in 
line-up starts at £1,099 for a version with an 
8-core CPU/8-core GPU Apple silicon M3 chip 
with 8GB of unified memory and 256GB of 
storage; rises to £1,299 for an 8-core CPU/ 
10-core GPU model with 512GB of storage 
onboard; and tops out, in standard guise, with 
a 16GB memory model for £1,499. Like the 

15-inch, the MacBook Air 13in can be configured 
with up to 24GB of unified memory and up to 
2TB of SSD storage. You can also upgrade 
the power supply from the stock 30W USB-C 
adaptor to either a 35W Dual USB-C adaptor or 
a 70W one. Max out the MacBook Air 13in with 
all the trimmings and you’ll pay £2,299.

The MacBook 
Air 13in 

remains a joy 
to use on space-

constrained 
spaces on 

trains and 
planes

W

Like the bigger 15-inch model, the 13in MacBook Air 
provides you with MagSafe 3 and two Thunderbolt ports.

Benchmarks Our analysis explained 

HANDBRAKE 
VIDEO ENCODING
 We transcode a Blu-ray-quality 

video file into H.264 format using 
HandBrake to test the multicore 
processor performance. Handbrake 
is available as a universal binary.

GEEKBENCH 6  
SINGLE-CORE TEST
 This tests the capability of a single 

processor core. Many more common 
tasks on a Mac will only use a single 
core at a time. Geekbench 6 is a 
universal app running on Sonoma.

RISE OF THE TOMB 
RAIDER (1920X1200)
 For a real-world gaming test, we 

use the benchmarking tool in this 
game, with the graphics quality set 
to High and the resolution set to 
1920x1280. Not Apple silicon native.

DAVINCI RESOLVE
 In Blackmagic Design’s editing tool 

for video professionals, we exported 
an effects-laden, 2.5-minute project 
to the H.264 format. The latest 
version of the app (Version 18.6) runs 
natively on Apple silicon Macs.

MacBook Pro 16in 4.05GHz M3 Max (2023)MacBook Pro 16in 4.05GHz M3 Max (2023)

MacBook Air 15in 4.05GHz M3 (2024)MacBook Air 15in 4.05GHz M3 (2024)

MacBook Air 13in 3.78GHz M3 (2024)MacBook Air 13in 3.78GHz M3 (2024)

MacBook Pro 16in 4.05GHz M3 Max (2023)

MacBook Air 15in 4.05GHz M3 (2024)

MacBook Air 13in 3.78GHz M3 (2024)

MacBook Pro 16in 3.22GHz M1 Pro (2021)

MacBook Pro 16in 3.3GHz M2 Pro (2023)

3000 4000 5000 6000200010000 15 20 25 301050 60 80 100 12040200

Frames per second (higher is better)Duration (shorter is better)Index score (higher is better) Duration (shorter is better)
15 20 25 301050

MacBook Air 15in 4.05GHz M3 (2024)

110

34

19 mins, 58 secs

20 mins, 50secs

4 mins, 36 secs
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The MacBook Air 13in’s specs are largely 
identical to its bigger sibling’s with MagSafe 3, 
two Thunderbolt/USB 4 ports and a 3.5mm 
headphone jack, as well as Wi-Fi 6E and 
Bluetooth 5.3. The smaller screen gives you 
slightly fewer pixels to play with at 2560x1664, 
although it has the same display density at 224 
pixels-per-inch (ppi) and 500 nits of brightness. 
Also, like its bigger sibling, the MacBook Air 
13in has incredibly long battery life: up to 18 
hours during Apple TV app streaming playback 
or 15 hours when wireless web surfing.

Performance
When it comes to getting stuff done, the 
MacBook Air 13in is quite the mini-powerhouse. 
With the M3 on board, it makes light work of 
everyday tasks, feeling equally as responsive 
as the 15-inch, although there are differences 
when under sustained pressure. In Geekbench 
6, the 8-core CPU/10-core GPU model on test 
recorded an average score of 3,043 points 
in single-core and 12,061 in multi-core 
benchmarks. And in Davinci Resolve 18, it 
rendered our effects-laden video in 19 mins 
58 secs vs 20 mins 50 secs on the 15-inch.

In Handbrake, the MacBook Air 13in took 
29 mins 33 secs to transcode an hour-long 
video, compared to 23 mins 41 secs for the 
15-inch; and in Shadow of the Tomb Raider, 
it averaged 32 frames per second (fps) vs 
the 15-inch’s 34fps. 

As with the 15-inch, there was quite a lot of 
variability in the benchmarks with the 13-inch 
struggling at times under sustained heavy load 
– at one stage achieving just 21fps in Tomb 
Raider, and taking 28 mins 13 secs in Davinci 
Resolve. None of this should detract though 
from our overall impression of an incredibly 
impressive notebook that’s the best compact 
MacBook Air yet. Rob Mead-Green

We’re fans of the Magic Keyboard’s flat, square keys, and 
even bigger fans of the fingerprint-reading power button.

 A beautifully made 
notebook that’s both 
light to carry and 
light on its feet.

★★★★★
 Ultra-compact design
 Premium build
 M3 performance
 Some slow downs 

under heavy load

Although there was some variability 
across our benchmark tests, the new 
13-inch MacBook Air impresses.



APPLE CHOICE Hardware

80 | MACFORMAT | JUNE 2024  Image credit: Apple Inc

MacBook Air 
15-inch (2024)

 From £1,299  FROM apple.com/uk  FEATURES Apple M3 chip, 8GB unified memory (16/24GB available), 15.3in Liquid Retina display 
(2880x1864), 256GB storage (512GB/1TB/2TB available), Wi-Fi 6E (aka 802.11ax Wi-Fi), Bluetooth 5.3, 2x Thunderbolt/USB 4 ports, 
MagSafe 3 port, 3.5mm headphone jack

Can Apple’s M3 chip make its biggest consumer notebook even better? 

ine months after Apple first 
introduced the 15-inch MacBook 
Air, its successor is here – and this 

time it’s not only £100 cheaper than before 
to start, but it also comes with an Apple 
silicon M3 chip on board. Updated alongside 
the 13-inch MacBook Air (see p78), the new 
model promises to be 60% faster than the 
M1 MacBook Air (2020) and 13 times faster 
than the last of the Intel-powered MacBook 
Air models, making it quite the upgrade.

As before, the M3 MacBook Air is available 
in four different finishes (Silver, Starlight, 
Space Grey and Midnight) and three standard 
configurations. Prices start at £1,299 for a 
15-inch MacBook Air equipped with an 8-core 
CPU/10-core GPU Apple silicon M3 with 8GB of 
unified memory and 256GB of solid-state drive 
(SSD) storage; rise to £1,499 for a mid-tier 
version with identical specs but 512GB of 
storage; and top out at £1,699 for a model with 
16GB of unified memory and 512GB of storage.

You can, of course, customise your 15-inch 
MacBook Air to suit your needs by delving into 
the build-to-order options. These include 
adding either 16GB or 24GB of unified memory, 
512GB, 1TB or 2TB of storage and upgrading 
to a 70W USB-C power adaptor (standard 
configurations come with a 35W Dual USB-C 

adaptor). The maxed-out version with 24GB 
of unified memory, 2TB of storage and a 70W 
power adaptor will cost you a cool £2,499 – 
although if you’re thinking of spending that 
kind of money, you might want to consider 
upgrading to a 16-inch MacBook Pro instead, 
which comes with a 12-core CPU/18-core GPU 
Apple silicon M3 Pro chip, 18GB of unified 
memory and a 512GB SSD for just £100 more.

The MacBook Air 15in (2024) is otherwise 
largely unchanged from last year, with a 
super-slim aluminium unibody (measuring 
34.04x23.76x1.15cm and weighing 1.51kg), 
a gorgeous 15.3-inch Liquid Retina display 
with True Tone and 500 nits brightness and 
a handful of ports: two Thunderbolt/USB 4 
and MagSafe 3 on the left-hand side and a 
3.5mm headphone jack on the right. 

As before, this MacBook Air 15in comes 
with Bluetooth 5.3, although its onboard Wi-Fi 
has been upgraded from Wi-Fi 6 to Wi-Fi 6E, 
giving it two times faster wireless data transfer 
speeds when used with a suitable router. The 
new model also has identical battery life to its 
predecessor too: 18 hours when streaming 
video or 15 hours when wireless web surfing 
– figures that were borne out by our testing.

Performance
While the differences between Apple’s 
consumer and pro notebooks have narrowed 
(chiefly thanks to outward design changes and 
Apple silicon), the MacBook Air remains very 
much an everyday machine ‘for the rest of us’. 
While it lacks the powerhouse chips, uprated 
memory and larger storage options of Apple’s 
‘pro’ notebooks, it’s no slouch – even if its 
fanless design means it can’t sustain heavy 
workloads over long periods. 

In use, the 2024 MacBook Air starts up fast 
and gets to work quickly with apps typically 
launching within a bounce of two of their icons You get one MagSafe 3 and two Thunderbolt/USB 4 ports, and there’s a headphone jack on the other side.

The new 15in 
MacBook Air 

promises to be 
60% faster 

than the M1 
Macbook Air

N
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in the Dock. Unlike the 2023 base model 
MacBook Air, even the solid-state storage on 
this year’s model feels suitably zippy, while our 
benchmarks (see table) reveal just how capable 
this year’s model is. In Geekbench 6, the M3 
MacBook Air 15in achieved an average score of 
3,069 points in the single-core test and 11,922 
in multi-core. And in Davinci Resolve 18 it 
rendered our effects-laden video in an 
average of 20 mins, 50 secs. 

As with previous MBA models, the lack of 
fans can lead to slowdowns as the chip throttles 
to stop itself from getting too warm, with the 
slowest run-through taking 21 mins, 35 secs 
compared to the fastest at 20 mins, 09 secs – 

the MacBook Pro with its built-in fans is much 
more consistent. In our one-hour Handbrake 
transcoding test, the MacBook Air averaged 
23 mins, 41 secs, while in Shadow of the Tomb 
Raider, the game averaged 34 frames per 
second (fps) with the display resolution set 
to 1920x1200 and graphics set to High. 

The M3 Max MacBook Pro 15in we tested in 
#MF399 beat all those scores by some margin, 
but that’s not surprising. What is surprising is 
how much more capable the M3 MacBook Air 
is compared to its M1 and M2 predecessors. For 
example, it took last year’s M2 MacBook Air 29 
mins, 35 secs to achieve our Handbrake result 
and 24 mins, 53 secs in Davinci Resolve. There 
are also differences between the performance 
of the 15in MacBook Air and its 13in cousin. 
While the 13-inch is a great little machine in its 
own right, its bigger sibling’s thermodynamics 
mean it will generally perform better.

Whichever size MacBook Air you go for, all 
the usual superlatives apply. You’ll be buying 
a premium laptop with excellent build quality, 
fast everyday performance and incredibly long 
battery life. No wonder the MacBook Air is the 
world’s most popular laptop – it continues to go 
from strength to strength, and in its 15-inch 
guise even more so. Rob Mead-Green

The 15.3-inch LED-backlit display (with 
IPS) offers up a 2880x1864 screen 
resolution at 224 pixels per inch. 

Like the MacBook Air 13-inch model, we particularly like the 
Magic Keyboard and its handy Touch ID power button.

 If you love the 
16-inch MacBook 
Pro’s size, but not 
its price, this is the 
notebook for you.

★★★★★
 Slim and lightweight
 Premium design
 M3 performance
 MacBook Pro is 

even better
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Soundcore Boom 2
 £119.99  FROM uk.soundcore.com  FEATURES 2.1-channel speaker system (2x 15W tweeters, 1x 50W racetrack subwoofer), 

50Hz-20kHz frequency response, Bluetooth 5.3, integrated microphone, 1x USB-C (input), 1x USB-A (output), waterproof to IPX7,  
up to 24 hours’ play time between recharges; 29.6x10.1x18.5cm, 1.66kg

Get the party started with a sound and light show!

reak out the barbecue and the 
tunes – garden party season’s 
here and, boy, do we have the 

perfect speaker for you! The Boom 2 is 
Soundcore’s follow-up to the original 
2021 Motion Boom. Only now it’s 
even more fun to listen to and to 
use, thanks to improved audio, 
and a crowd-pleasing lightshow.

Available in black, dark blue 
or dark grey, the Boom 2 is a 
portable Bluetooth speaker that 
packs in an incredible amount of 
power despite its compact size. 
That’s thanks to its 50W 
racetrack subwoofer and twin 
15W tweeters, which not only 
enable the speaker to go 
fearsomely loud, but also give 
it a frequency response of 
50Hz-20kHz. While that low 
end is not deep enough for truly 
thunderous bass (the speaker would need 
to be able to reach down to 20Hz or lower 
for that), it’ll still give garden discos plenty 
of oomph, especially when used with its Bass 
Up control, which can be accessed using either 
the dedicated button on the speaker’s top or 
via the free Soundcore app.

Talking of discos, what about that light 
show? That comes courtesy of the LEDs built 
into the pulsing passive bass radiators that sit 
at each end of the main speaker body. There 

are seven light patterns to choose from 
– Flash, Flame, Energy, Wave, Lightning, 
Fireworks and Rainbow – each with 
customisable colours and brightness. 

Party poopers can choose to switch 
the lights off if they wish.

Getting the party started 
couldn’t be easier as the 
Boom 2 connects quickly via 
Bluetooth and never dropped 
once during playback while 
testing. The disco can last all 
night too as the integrated 
battery promises up to 24 
hours of continuous playback, 
although it will be shorter if 
you’re using Bass Up mode 
and those flashing lights. The 
Boom 2 also has a couple of 
other aces up its al fresco 
sleeves; it’s waterproof 
to IPX7 (although it’s not 

dustproof – shame!), ensuring it can cope 
during the inevitable British summer 
downpour. Plus, the speaker will float if you 
accidentally drop it in the pool. The other ace 
is PartyCast. This lets you connect the Boom 
2 to up to 100 other compatible speakers. 
Now that would be a party to remember.

Tweak to taste
In use, the Boom 2 does a fantastic job, 
delivering room-filling beats with ease. The 
speaker sounds best with Bass Up switched 
on and Soundcore Signature selected in the 
Soundcore app’s EQ. You can also tweak the 
sound to suit your taste or create a Custom 
EQ of your own. With your party in full swing, 
the Boom 2 makes light work of bass-heavy 
tracks like Dua Lipa’s Houdini, while giving 
Nick Cave’s sonorous vocal on La Vie En Rose 
room to breathe during that slow smooch you 
planned for the disco’s end. While kitchen-
bound audiophiles will tut over the Boom 2’s 
dynamics, the rest of us can party ’til the 
sun comes up. Rob Mead-Green

B

Despite its size, the Boom 2 boasts a 50W subwoofer and 
twin 15W tweeters, so you can really up the volume. 

VERDICT
 A summer-ready 
ghetto blaster for 

any outdoor party.

★★★★★
 Perfect for 

parties and BBQs
 Long battery life

 Customisable sound
 Not dustproof

Not content with just blasting 
out your tunes, the Boom 2 also 
provides you with a light show.
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With an IPX7 rating, the Boom 2 
is a great option for a pool party 
(or just the usual UK summer). 
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hether you’re a big kid – or a 
little one – gaming on iPhone is 
incredibly popular. And it’s getting 

even more so with the availability of AAA 
titles like Resident Evil Village, Real Racing 
3 and Minecraft. But, while using touchscreen-
based controls is often perfectly fine, there are 
times when you really want to, ahem, up your 
game – and that’s where devices like the 
GameSir X2s Type-C come in.

Inspired by the design of the Nintendo 2DS, 
the GameSir X2s Type-C is a spring-loaded 
gamepad that expands to accommodate your 
iPhone 15 or iPhone 15 Pro and includes a 
movable USB-C port that slots into the base of 
your phone. Powered by your iPhone, the 
GameSir X2s comes with all the buttons, sticks 
and triggers you’d expect to find on a gamepad 
like this – with one Hall Effect stick on the left 
and  a second on the right; four shoulder 
buttons, plus a ‘+’ shaped D-pad, and A, B, X 
and Y buttons. The whole thing feels chunky 
and high quality, with a rubberised surface that 
should ensure you don’t lose your grip during 
frenetic gaming sessions. All the buttons and 
sticks fall easily under your fingers too.

While GameSir suggests downloading its 
free app from the App Store, we found we 
couldn’t use it – chiefly because the X2s 
neither works using Bluetooth nor is supported 
by the app. The latter, though, may change.

The other thing to note is that not all games 
support gamepads like this one – while 
Resident Evil Village, Call Of Duty Warzone 
Mobile and Asphalt 9 instantly recognise it, 
others such as Mario Kart and Sonic The 
Hedgehog don’t - but that’s chiefly because 
they’ve been programmed for touchscreen-
only input. The X2s will also work with any 
Steam games you’ve installed on your Mac 
when connected to your iPhone wirelessly 
using Steam Link, giving you another way to 
play. However, while the X2s includes a second 
USB-C port that you could, theoretically, use to 
connect the gamepad to a Mac or iPad, it won’t 
work as controller for those other devices, and 
that’s a shame; the second USB-C port is for 
passthrough charging for iPhone only.

Making connections
In use, the GameSir X2s works brilliantly - and 
it’s great that it has a physical connection to 
your iPhone rather than relying on Bluetooth. 
Its precision controls help you easily wipe out 
rival players in Call Of Duty Mobile Warzone or 
while haring around a racetrack in Real Racing 
3 without obscuring the display with your 
fingers. We also love the fact that its movable 
USB-C port is flexible enough to make 
connecting your iPhone painless – and doesn’t 
rely on you removing your iPhone from a 
protective case to do so. Rob Mead-Green

 £50  FROM gamesir.hk  FEATURES Anti-drift Hall Effect sticks, Hall Effect analogue triggers, mechanical Microswitch buttons,  
1x movable USB-C port, 1x USB-C port for pass-through charging, Turbo function; 110-168mm, 171.6g

GameSir X2s Type-C
Up your game with this retro controller for iPhone 15 and iPhone 15 Pro

WThe GameSir 
X2s comes 
with all the 

buttons, sticks 
and triggers 
you’d expect 

to find

VERDICT
 A great quality 

controller for 
iPhone 15 gamers.

★★★★★
 Solid, chunky design
 Movable USB-C port

 Pass-through 
charging

 Doesn’t work 
with all games
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hether you’re going 
away from a night, 
or an extended 

break, charging your 
iPhone, Apple Watch and 
AirPods can be a concern. 
While you could pack 
individual chargers for each, 
a compact travel charger 
makes sense, and there are 
plenty to choose from, 
including Mophie’s folding 
3-in-1 Travel Charger with 
MagSafe (£144.95, uk.zagg.
com), STM’s ChargeTree Go 
(£69.99, stmgoods.com) and 

this, the MagGo Wireless 
Charging Station from Anker.

Around the size of a deck 
of cards, it has a MagSafe/Qi2 
charger on top, which opens 
to reveal a wireless charging 
pad for AirPods, while the 
base has a fold-out Apple 
Watch charger. Very neat. 
Included in the box is a UK- 
spec 40W USB-C charger, 
plus a 1.5m USB-C to USB-C 
cable to power it all. And it 
promises to boost your 
devices relatively quickly too, 
with 15W going to your 

iPhone, 5W to your Apple 
Watch and another 5W to 
your AirPods. The MagSafe 
section also doubles as an 
angled stand, so you can use 
your iPhone in StandBy 
mode. In use, the only thing 
obviously missing is a second 
charging port for pepping up 
non-wireless devices.  
Rob Mead-Green

amed for making 
affordable wireless 
earbuds, JLab’s 

now stepping things up a 
gear with its most expensive 
in-ears to date: the Epic Lab 
Edition. Costing £199.99, 
they’re clearly aimed at 
Sony’s WF-1000XM5 and 
Bose’s QuietComfort Ultra 
with a premium design and 
audio performance to match. 

The earbuds feature a 
hybrid dual driver with spatial 
audio support and Active 
Noise Cancelling (ANC), along 
with Bluetooth 5.3 with 
Multipoint, enabling you to 

easily switch between 
devices while using 
them. You also get 
a USB-C dongle to 
connect the earbuds 
wirelessly to your 
Mac. The earbuds last for up 
to 13 hours with ANC off and 
nine hours with it on. The 
metal-clad case enables you 
to charge the earbuds 
another three times, and the 
case itself can be charged 
wirelessly or by using the 
USB-C port on its rear.

The earbuds are water- 
and dust-resistant to IP55, 
although the case isn’t. 

With three pairs of foam 
and three pairs of silicone ear 
tips included, finding the 
perfect fit is easy and while 
the earbuds are bulky, they’re 
comfortable. Sound quality is 
great, serving up lashings of 
bass on Dua Lipa’s Houdini, 
while remaining balanced and 
controlled. You can tailor the 
sound to suit using the free 
JLab app. Rob Mead-Green

Anker’s multi-device charger boasts 
a neat reverse origami-style design!

Anker MagGo Wireless 
Charging Station
Stick this in your bag if you’re off out…
 £99.99  FROM anker.com  FEATURES MagSafe/Qi2 certified, 15W ultra-fast charging, 

40W USB-C charger, 1.5m USB-C to USB-C cable; 89x60x25mm (folded), 195.6g

JLab Epic Lab Edition
Premium wireless earbuds with a great sound
 £199.99  FROM uk.jlab.com  FEATURES Hybrid Dual Drivers, Smart ANC, Bluetooth 

5.3 (Multipoint), spatial audio support, wireless charging, USB-C port (in case), up to 56 
hours’ play time, 3 pairs’ foam ear tips, 3 pairs’ silicone gel ear tips, IP55 (earbuds only)

W

F

VERDICT

VERDICT

 A compact 3-in-1 
charger for life 

on the lam.

★★★★★
 MagSafe and  

Qi2 compatible
 No wired  

charging option

 The Epic Lab Edition 
are JLab’s best-

sounding earbuds yet.

★★★★★
 Premium sound 

and design
 Earbuds are  
a little bulky

JLab ramps up the sound quality 
with the Epic Lab Edition earbuds.
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ALEX BLAKE

ON TEST…
>  Keychron K2
>  Lofree Flow
>  Logitech MX Keys S
>  Logitech MX Mechanical Mini
>  Satechi Slim X3
>   Satechi SM1 Slim

Group 
test
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That feeling when everything just clicks



How we tested
 We paired each keyboard with a 

Mac and spent time typing articles 
and doing day-to-day tasks on 
each one. We assessed the typing 
feel and key layout, how easy it 
was to pair each keyboard and 
switch devices and operating 
systems (where available), and 
looked for extra features like 
backlighting and hot-swappable 
switches. Overall typing comfort 
was most important, but each 
device’s complete feature set 
was considered when coming 
to a conclusion.

pple’s Magic Keyboard 
is popular with Mac 
users, but it’s not for 

everyone. Its key presses can feel 
shallow, the standalone version 
doesn’t have backlighting, and the 
less said about its squished arrow 
keys, the better.

Fortunately, there are plenty 
of alternatives. Whether you’re 
looking for a Magic Keyboard 
replacement or something to 
complement your MacBook or 
iPad, a keyboard that will work 
with multiple devices or one with 
tactile mechanical switches, you’ll 
be able to find something for your 
needs. With our group test to 
hand, your task will be made 
considerably easier.

We’ve put together six of 
the best Mac keyboards available 
right now, from sleek, slimline 
options that use the Magic 
Keyboard for inspiration to 
compact mechanical keyboards 
that offer a supreme typing feel. 
The result should give you a 
clearer idea of which is worth 
your time if you feel like switching.

We’ve tested each keyboard 
against a range of criteria (see 
below) to see which one is worth 
your money. Read on to find out 
what we thought.

A
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1 Should you go 
mechanical?

Some keyboards use tactile 
mechanical switches under their 
keys for improved typing feel, but 
they can be loud and expensive.

2 Device connections
Having multiple Bluetooth 

connections means a keyboard 
can flip between different devices. 
Some keyboards can also switch 
their layout between macOS and 
Windows functionality.

3 Number pad or no?
Some keyboards include a 

number pad while others compress 
their layouts into more compact forms.

4 Keycap concerns
Keycap material matters. ‘Dye 

sublimation’ and ‘double shot’ legends 
last longer than printed letters, while 
keys made from ABS plastic go shiny 
quicker than PBT ones.

Things to 
consider…

Lofree Flow
 $159 (about £155)  FROM lofree.co

Keychron K2
 FROM £84  FROM keychron.uk

The Lofree Flow is the 
pinnacle of keyboard 

build quality. Its all-metal 
chassis is weighty and rock 
solid, its PBT keycaps look 
and feel beautiful, and it’s full 
of delightful little touches, 
from its copper-coloured 
highlights to its adjustable 
underside lighting.

Its keys are surprisingly 
quiet for a mechanical 
board and are supremely 
comfortable in use, with 
just the right amount of 
resistance on each press. 
They also sound great and 
are reassuringly stable.

Disappointingly, you can’t 
change the board’s angle, and 
it’s a little flat for our liking. 

Its layout is also very 
compact, although we didn’t 
struggle to find certain keys 
as much as on rival keyboards 
thanks to its chunky, well-
defined keycaps. It also only 
comes in a US configuration, 
but that’s something you can 
get used to. We didn’t feel any 
of those issues were killers, 
and overall it’s a fantastic 
option if you want a 
mechanical keyboard, if 
a little on the pricey side.

Keychron’s K2 is 
tremendous value for 

money, with an affordable 
price tag and plenty of 
useful features. It’s a 
mechanical keyboard with 
a trick up its sleeve; you can 
change its switches for others 
that feel different (bought 
separately), altering your 
typing experience. We found 
its typing feel with blue 
‘clicky’ switches to be fast and 
comfortable, if a little heavy.

Like several keyboards 
here, the K2 can flip between 
multiple devices and macOS 
and Windows layouts. 
However, it has a physical 
switch on the side that 
switches OS layouts, which 

is much quicker and easier 
than rival keyboards. It’s 
a neat feature.

We did find its compact 
layout a little too cramped, 
and it was hard to find certain 
keys without looking. Its keys 
are also louder than some of 
the keyboards tested thanks 
to their clicky switches. If you 
work alone that won’t be a 
problem, but you might get 
some annoyed glances if 
you frequent an office.

 Amazing build quality
 Excellent typing feel
 Hot-swappable switches
 Can’t adjust typing angle

★★★★★

 Hot-swappable switches
 Mac and PC layouts
 Some keys hard to find
 Fairly loud

★★★★★

1

21

VERDICT VERDICT

APPLE CHOICE Group test
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Logitech MX Keys S
 £109.99  FROM logitech.com

Logitech’s MX Keys 
S gives one of the 

most Apple-like typing 
experiences of any keyboard 
we tested. It’s a great choice 
if you like typing on the Magic 
Keyboard but want a few 
extra features.

You’ll love how beautifully 
quiet its typing is – the 
difference between it and 
a loud mechanical keyboard 
is night and day. Its keys are 
soft to press yet stable and 
never squishy, so you can 
dash over them at a rate 
of knots without losing 
accuracy. Each key is dished 
too, which helps you locate 
them by touch. While it’s not 
quite as satisfying to type 

on as a mechanical keyboard, 
it’s not far off.

The MX Keys S is a large 
keyboard, and it comes with 
the full number pad to the 
right of the arrow keys. That 
can make it feel overly wide 
at times. You can’t change 
the board’s height, but we 
found it to be set to a 
pleasant angle. It’s also 
solidly built, with a plastic and 
aluminium body that looks 
and feels extremely classy.

3 4

3

Logitech MX 
Mechanical Mini
 £149.99  FROM logitech.com

Logitech’s MX 
Mechanical Mini 

keyboard is a strong effort. 
It’s enjoyable to type on, with 
keys that are springy enough 
to give plenty of physical 
feedback without you 
‘bottoming out’ and thudding 
your fingers on the backplate.

Typing is comfortable and 
fast, even for long periods, 
something that’s helped by 
the chunky keycaps. It’s also 
quiet for a mechanical 
keyboard, and we liked the 
smart backlighting that dims 
when you move your hands 
away (there are multiple 
backlighting options, too).

As with other keyboards 
that use the same truncated 
layout, certain buttons like 
the arrow keys can be hard to 
locate. We also noticed that 
the keycaps can very easily 
get smudged and greasy, 
much more so than the other 
options in this test. And 
despite all it has going for 
it, it’s the most expensive 
product in this test.

 Fast, quiet, comfy typing
 Angled keycaps
 Keycaps attract marks
 Expensive

★★★★★

4

VERDICT VERDICT
 Very quiet
 Great typing feel
 Excellent build quality
 Quite large

★★★★★

2

Best Mac keyboards APPLE CHOICE
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Satechi Slim X3 Satechi SM1 Slim
 $89.99 (about £85)  FROM satechi.net  $99.99 (about £95)  FROM satechi.net

The Satechi SM1 Slim 
keyboard is one of the 

best-looking products in 
this test. Its white and grey 
theme fits right in with your 
Apple devices while retaining 
its own distinct identity, and 
its bright, clear backlighting 
turns off when you move your 
hands away.

It uses tactile mechanical 
switches for rapid, accurate 
typing, and its slightly dished 
keys really help with this. 
Unlike the Logitech MX 
Mechanical Mini, though, 
we experienced some 
‘bottoming out’ of the keys, 
which means we frequently 
pressed the key all the way 
down until it struck the 

underlying backplate. This 
made our fingers sore over 
time and could be prevented 
by adding a little more 
resistance to each key switch.

We aren’t huge fans of 
its very compact shape, which 
made it a tough to find the 
arrow keys among 
surrounding buttons. The 
Satechi SM1 Slim also only 
comes in a US layout, so 
there’s also a degree of 
adaptation required.

Typing on the Satechi 
Slim X3 was the 

closest we came to the 
Magic Keyboard in terms of 
feel. As a non-mechanical 
keyboard, there’s a relatively 
low amount of travel on each 
key press, so it’ll feel (and 
sound) familiar if you like 
Apple’s version. We 
appreciated the all-metal 
chassis, and you can also 
connect to four devices over 
Bluetooth, the most of any 
keyboard tested here.

Unfortunately, the Slim X3 
felt like it was lacking a little 
quality. The keys were a touch 
unstable and wobbly, which 
led to some typing errors. The 
keyboard’s angle is also very 

low and can’t be changed 
much – it comes with some 
stick-on feet, but they’re 
non-adjustable and don’t feel 
like a high-quality solution.

There were a few other 
issues. Unlike some boards, 
it doesn’t let you switch 
between macOS and Windows 
arrangements, while it only 
comes in a US layout with a 
slim Return key. You can get 
used to that, but it’s worth 
noting nonetheless.

65

VERDICT VERDICT
 Looks gorgeous
 Solid construction
 Some ‘bottoming out’
 US layout only

★★★★★

 Connects to four devices
 Quiet typing
 Unstable keys
 Non-adjustable height

★★★★★

65

APPLE CHOICE Group test



 How 
do they 
compare?
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THE WINNER

Lofree Flow
icking a winner 
was tough, but 
there were a few 

keyboards we could rule out. 
The Satechi Slim X3 had a few 
too many lapses to come out 
on top. The Logitech MX 
Mechanical Mini and the 
Satechi SM1 Slim are decent, 
but neither did enough to 

beat out their rivals. 
Keychron’s K2 is a serious 
contender, and its layout 
toggle and hot-swappable 
switches are excellent 
features that make it 
customisable and practical. 
But in the end its typing feel 
was too heavy and its layout 
too condensed.

Choosing between the 
Lofree Flow and the Logitech 
MX Keys S was almost 
impossible. Logitech’s 
superb keyboard is quiet, 
comfortable, and reliable in 
almost every way, and if you 
don’t want a mechanical 
keyboard, it’s absolutely 
worth your money. But it was 

pipped to the post by the 
Lofree Flow. We love this 
device – its craftsmanship 
is unparalleled, its key 
comfort supreme, its features 
beautifully considered – and 
it’s a brilliant choice for any 
Mac user. Either device could 
have won, and both will 
make you very happy.

Note: All the keyboards have a backlight feature. ABS = acrylonitrile butadiene styrene; PBT = polybutylene terephthalate.
Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

A gorgeous keyboard fit for any Mac user

> Specs Keychron K2 Lofree Flow Logitech MX  
Keys S

Logitech MX 
Mechanical Mini

Satechi Slim X3 Satechi SM1 Slim

Price From £94 $159 (about £155) £109.99 £149.99 $89.99 (about £85) $99.99 (about £95)

Website keychron.uk lofree.co logitech.com logitech.com satechi.net satechi.net

Mechanical 
switches?

Yes Yes No Yes No Yes

Mac and PC 
layouts

Yes Yes Yes Yes No Yes

UK layout Yes No Yes Yes No No

Number pad No No Yes No Yes No

Multiple 
devices

Yes, up to three Yes, up to three Yes, up to three Yes, up to three Yes, up to four Yes, up to two

Connectivity Bluetooth, wired 
(USB-A)

Bluetooth, wired 
(USB-C)

Bluetooth, Logi Bolt 
dongle (USB-A)

Bluetooth, Logi Bolt 
dongle (USB-A)

Bluetooth, wired 
(USB-C)

Bluetooth, dongle 
(USB-A), wired (USB-C)

Battery life 
(backlight off)

Up to 240 hours Up to 200 hours Up to 610 hours Up to 1,220 hours Up to 131 hours Up to 500 hours

Battery 
capacity

4,000mAh 2,000mAh 1,500mAh 1,500mAh 1,300mAh 2,500mAh

Keycap 
material

ABS PBT ABS ABS ABS Polycarbonate

Extras Hot-swappable 
switches

Hot-swappable 
switches

Logitech Flow 
(mulitple control)

Logitech Flow  
(mulitple control)

Connects to 
four devices

All-metal chassis

> Overall ★★★★★ ★★★★★ ★★★★★ ★★★★★ ★★★★★ ★★★★★

P
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How to transfer photos from iPhone to ACDSee
APP TIPS

92 | MACFORMAT | JUNE 2024
 Image credit: Apple Inc, ACD Systems International Inc, 

George Cairns/Models: Eli Anguelova, Madhuri Choudhary

ACDSee Photo 
Studio 10
 $129.94 (about £120)  FROM acdsee.com  NEEDS macOS 12 or later

Organise, edit and share your shots

ith our ever-present iPhone, our 
collection of photos grows day 
by day. We may also have photos 

scattered in folders on our Mac, or even on 
external drives. ACDSee Photo Studio 10 is a 
Digital Asset Management (DAM) app that is 
designed to help you organise your quickly 
growing collection of images so that you can 
find, edit and share your favourite shots more 
easily. If you want to use ACDSee to organise 
and edit photos that are stored in your 
iPhone’s Photos Library then you can 
download the free Mobile Sync app to your 
iPhone. You can then use the app to select 
specific images on your iPhone and transfer 
them to the ACDSee catalogue on your Mac.

ACDSee Photo Studio 10’s interface is 
divided into workspaces so you can focus on 
various tasks. The Manage workspace provides 
typical asset-management tools such as the 
ability to assign star ratings and colour labels. 
You can then use filters to find images that 

match a wide combination of criteria (such as 
five-star images with a green label that have 
the keyword ‘woman’). Assigning keywords can 
be a time-consuming task so ACDSee Photo 
Studio 10 provides pre-populated keyword sets, 
such as Landscapes or Portraits. Click on a 
particular keyword in a set (such as Fashion 
or Lifestyle) and it will be instantly assigned 
to a selected photo (or group of shots). 

An even faster 
way to manage 

your shots is 
provided by 
the new AI-

assisted People 
workspace

W

The Develop workspace adjusts colours and tones 
by applying Look Up Tables (LUTs).

Mobile sync
Download the free Mobile Sync app onto 
your iPhone. The app can access your 
iPhone’s Photos library. This enables you 
to browse through thumbnails of your 
images in Albums that you’ve created 
using the Photos app.

Rate and select
You can tap to select thumbnails to 
transfer to your Mac’s copy of ACDSee. 
Tap on a thumbnail for a bigger picture. 
Here you can rate the shots with stars. 
If you tap Metadata, you can view the 
image’s shooting location on a map.

Transfer to Mac
After rating and selecting your shots in 
Mobile Sync, tap Share. The files will be 
sent wirelessly to your Mac. You can 
then view them in the Mobile Sync 
section of the Manage workspace and 
filter them by star rating.
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An even faster way to manage your shots 
is provided by the new AI-assisted People 
workspace, which automatically finds faces 
for you to identify. Once you’ve put a name to 
a face, the People tool will group other shots 
containing that person together, making it 
easier to find particular people pictures. 

The other new workspace in ACDSee Photo 
Studio 10 is Media. This displays all the shots 
that you’ve added to the app’s database as a 
series of scaleable and sortable thumbnails. 
You can organise the way assets are displayed 
– such as grouping them by Type (clips or stills) 
or sort them by attributes such as Date Taken 
or by Rating. This gives you the freedom to 

work in a way that suits your specific asset-
management needs. You can also edit 
metadata in the Media workspace (such 
as assigning keywords to a shot). 

Once you’ve used ACDSee Photo Studio 
10 asset-management tools to organise your 
images, you’ll want to share your favourites, 
but they may need a little editing first. The 
Develop workspace provides a comprehensive 
collection of digital darkroom tools that enable 
you to correct problems with colour, tone and 
composition so that your images look their 
best. You can also creatively adjust them using 
Split Toning techniques or apply LUTs (Look Up 
Tables) to create a wide range of looks that 
should elicit more likes on your Instagram feed. 
You can even use brush tools to target specific 
areas in a shot and then adjust their properties 
– such as darkening (burning) detail into parts 
of an overexposed sky or lightening (dodging) 
detail in an underexposed face. 

This option to make selective brush-based 
adjustments gives ACDSee Photo Studio 10’s 
editing tools the edge over the editing tools in 
Apple’s Photos app, though on the downside 
you can’t edit an iPhone’s Portrait Mode blur 
amount in ACDSee Photo Studio 10.  
George Cairns

The new Media workspace displays thumbnails using a wide 
choice of sorting criteria.

The Develop workspace’s 
Color Wheel enables you 
to change the hue of 
targeted colours.

 ACDSee Photo 
Studio 10’s asset-
management tools 
enable you to easily 
find, edit and share 
your shots.

★★★★★
 Transfer photos 

from iPhone via app 
 AI-assisted people 

recognition
 Faster keyboarding 

with sets
 Doesn’t support 

Portrait mode edits

VERDICT
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o intense, stressful games put you 
off? If so, we have some good news: 
Summerhouse is the antithesis of 

that kind of gaming experience. This relaxing 
home-building title is the epitome of ‘chill’. 
There are no goals, no win conditions and no 
ways to lose. You just load it up, start building 
and see where your creativity takes you.

The idea is to construct one or more 
buildings using various pieces. You place the 
pieces where you want, slowly exploring 
different ideas and seeing what works and 
what doesn’t. You can craft beautiful manors, 
imposing castles or run-down strip malls – or 
a blend of everything – the choice is yours.

That’s possible thanks to the large variety 
of pieces Summerhouse provides, from walls 
and roofs to doors and plants, and each one 
feels weighty and real when you place it. We 
also love the many accoutrements and extras 
that add a real lived-in feel, such as telephone 
boxes, graffiti, bunting, plastic chairs and more.

Summerhouse is such a relaxing game that 
it’s easy to tune out and clear your mind of all 
distractions. Your builds might not be perfect, 
but that’s fine – the game doesn’t punish you 
with time limits or incorrect placement 
warnings. It does reward you, however, by 
adding pieces to your library. These can be 
unlocked when you place certain blocks 
together – a plant next to a particular door, 

for example. There are no hints telling you how 
to unlock these extras, which encourages you 
to try new designs and combinations.

Cosy homes
Graphically, Summerhouse is gorgeous, 
whether you pick its pixel art or cartoon style. 
You start with four building environments, 
each of which exudes a lovely summery charm. 
If you prefer, you can change the weather to 
rain or the time to night, at which point your 
building’s lights come on and beautifully shine 
through the windows. Accompanying the game 
is a gentle soundtrack that calms and soothes 
(ideal for those times when you can’t quite 
get the look you want).

There aren’t many frustrations with 
Summerhouse, but one notable one is that you 
can’t move or adjust pieces once they’ve been 
placed. It means you must delete an erroneous 
element and replace it with something else if 
you change your mind. It would also be good 
to be able to rotate the camera to check piece 
positioning – right now, you can only move it 
in two dimensions.

But that’s it for the negatives. Okay, so if 
you’re a high-adrenaline achievement hunter, 
Summerhouse probably isn’t for you. But if all 
you want to do is empty your brain and build 
an array of detailed, lived-in buildings, this 
game will be like catnip. Alex Blake

 £3.99  FROM futurefriendsgames.com  NEEDS macOS 13 or later

Summerhouse
Calming construction without the stress of a real build

D

Summerhouse offers up tons of 
satisfying, relaxing gameplay.

You can craft 
beautiful 
manors, 

imposing 
castles or  

run-down 
strip malls

VERDICT
 A dreamy, relaxing 
building game with 

all the freedom 
you could want.

★★★★★
 Very relaxing

 Looks beautiful
 Detailed item library

 Can’t move 
placed pieces
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ost games focus on human 
problems and human solutions. 
Not so Stray, which follows a ginger 

cat as it explores a dystopian robot world that’s 
suspended between life and death. Separated 
from your feline companions, you must help an 
android underclass escape their slum city and 
find a way to the surface world. From helping a 
flying bot recover its memories to reuniting a 
band of explorers who sought a way out of their 
subterranean incarceration, Stray’s story is 
compelling at every turn.

Its main conceit – the feline protagonist – 
isn’t just a gimmick. It opens up new ways to 
play; jumping onto rooftops and squeezing 
through gaps replace shooting and driving, 
requiring you to crack its puzzles from a fresh 
angle. It also allows for cat-based humour. 
Some challenges are solved by pushing objects 
off ledges, as cats love to do. When you get a 
new backpack, your cat slinks low to the ground 
in a fashion any cat owner will recognise. The 
animations, meanwhile, are beautifully lifelike.

When you’re not seeing what happens when 
your cat gets a paper bag stuck on its head, you 
spend your time exploring environments that 
are almost unparalleled in their beauty. You’ll 
see dark streets illuminated by Day-Glo neon, 
dingy dungeons littered with the crumbling 
remains of past inhabitants, and ominous 
tunnels overgrown with the fleshy abodes 

of the Zurks (small creatures that consume 
anything they see). Wherever you are, you’ll 
want to stop and wonder at your surroundings.

Herding cats
Stray’s levels are varied, filled with simple 
puzzles, fetch quests, stealth missions and 
hell-for-leather escapes. Each is packed 
with secrets and collectibles, encouraging 
exploration and ensuring nothing is too linear. 
Most are enjoyable and rewarding.

The exceptions are any that involve 
encounters with Zurks. You can’t fight them, 
you simply have to flee, but that can get tricky 
with a mouse and keyboard. Often, you must 
steer your cat, hold Shift to sprint, press the left 
mouse button to fire a weapon, and mash a key 
to shake Zurks off. It’s too much at once. We 
recommend changing the ‘shake’ command 
to ‘single tap’ and sprinting to ‘toggle’ to make 
things more bearable. Or try using a controller.

Stray is also a heavy battery hog, almost 
draining our M1 Pro MacBook Pro entirely 
within 90 minutes. Performance was decent 
– we hit around 40fps on medium settings, 
but it felt much smoother.

Ultimately, Stray is an absolute 
treat on every count. From its story and 
environments to its gameplay and audio, 
it’ll live long in the memory. For Mac gamers, 
it’s close to purr-fection. Alex Blake

 £24.99  FROM stray.game  NEEDS macOS 12 or later, Mac with Apple M1 chip or later

Stray
It’s the cat’s pyjamas

M

Almost every scene in Stray 
is a feast for the eyes.

You spend 
your time 
exploring 

environments 
that are almost 
unparalleled in 

their beauty

VERDICT
 Stunning to look 

at and packed with 
absorbing gameplay, 

Stray is one to savour.

★★★★★
 Looks stunning

 Atmospheric audio
 Intriguing story

 Controls need 
changing
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Forest: Focus 
for Productivity

one sec | screen 
time + focus

 £3.99  FROM forestapp.cc
 NEEDS iOS 13 or later

 Free (IAPs)  FROM one-sec.app
 NEEDS iOS 14 or later

Forest is such a simple yet 
incredibly effective app. It 
starts with a simple premise: 

leave your phone alone and a forest 
grows on-screen. But if you close the app 
or indulge in a little social media… The 
forest dies. Its clever mechanism rewards 
you for staying away from your device 
and its distractions. Instead of putting up 
annoying roadblocks, it alters your 
mindset so that you want to ditch your 
iPhone and get on with your work.

One sec takes a different 
approach to distraction 
blocking. It doesn’t outright 

prevent you from using certain apps – it 
just makes things a little harder. It does 
this by adding a delay whenever you 
open a specified app, forcing you to 
consider whether you actually want to 
break your concentration. Like Forest, it’s 
about encouraging you to change your 
mindset and make decisions for yourself, 
which could help break the cycle.

Many people find that audio 
is the missing piece of their 
concentration puzzle. With the 

right sounds pumping into your ears, you 
can filter out distractions. Dark Noise 
creates long loops of ambient sounds that 
are perfect for building focus, including 
gentle rain, crackling fires, distant storms 
and more. As well as the app’s own tracks, 
you can create custom mixes that suit 
whatever mood you’re in, whether you 
want to work, fall asleep or anything else.

Improve your focus

 Image credits: SeekrTech Co Ltd, riedel.wtf GmbH, Dark Noise LLC 

6 apps to… 

 Free (IAPs)  FROM darknoise.app
 NEEDS iOS 16 or later

Dark Noise: 
Ambient Sounds

Need a hand staying on task? These apps can help

APPLE CHOICE iOS
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Toggl Track: 
Hours & Time Log

Clear Todos Structured – 
Daily Planner

 Free  FROM toggl.com
 NEEDS iOS 15 or later

 Free (IAPs)  FROM useclear.com
 NEEDS iOS 15 or later  Free (IAPs)  FROM structured.app

 NEEDS iOS 16 or later

With the Pomodoro Technique,  
you set a timer for 25 minutes 
of work, have a five-minute 

break, then repeat. It’s highly effective, 
and Toggl Track lets you put it to great 
use. But there’s more to the app than 
that; you can set timers to record how 
long you spend on a piece of work – ideal 
for freelancers and anyone tracking 
project time. It syncs with calendars, can 
set reminders, and can even detect idle 
time and exclude it from your timers.

You’ve never seen a to-do list 
app quite like Clear. It turns 
convention on its head, using 

strong colours, large fonts and bold 
designs to make tracking your tasks as 
simple as possible. It pairs that with some 
of the most ingenious gestures you’ll ever 
use, which are both incredibly powerful 
and yet so easy to learn. Plus, it’s totally 
free to use with no ads or subscriptions. 
It’s the ideal way to keep on top of your 
work, stay focused and – dare we say it? 
– it even makes to-do lists feel fun.

Need an all-in-one app to help 
you stay on track? Structured 
packs in a calendar, to-do lists 

and a habit tracker, which combine to 
ensure your mind stays on the job at 
hand. With the ability to create tasks, set 
deadlines and organise thoughts – all 
without needing to switch between apps 
– it’s adept at helping you maximise focus 
when you need to knuckle down. It even 
has a focus timer for when you want to 
start a session of deep concentration.

 Image credit: Toggl OÜ, Impending Inc, unorderly GmbH

ur devices are with us 
everywhere we go these days, 
which makes it harder than 

ever to avoid the disruptions and 
temptations that come with them. With 
apps, games and social media all vying for 
your attention, blocking them out can be 

tricky. But don’t worry if it all feels a little 
overwhelming; there are plenty of apps 
that can help. The six apps here block 
distractions, focus your mind and help 
you plan your day, ensuring the important 
tasks get done and the diversions get 
banished out of sight. Alex Blake

O

Focus apps APPLE CHOICE
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 In October 2023, Apple updated its 
only iMac – the 24in model, so that it now 
benefits from Apple’s also newly-released M3 
chip. You can now choose between an 8-core 
CPU/8-core GPU at the entry-level, or an 8-core 
CPU/10-core GPU on the mid-range and top-tier 
versions. You still get a 4.5K (4480x2520) 
Retina display, and all models come with 8GB of 
memory as standard, but this is now upgradeable 
to 24GB throughout. The solid-state drive (SSD) 
storage ranges from 256GB on entry-level and 
mid-range versions to 512GB on the top tier, 
although you can add up to 1TB on the entry-level 
and up to 2TB on mid-range and top-tier models.

The entry level version is available in Blue, Green, 
Pink and Silver, but the mid- and top-tier models are also 
available in Yellow, Orange, and Purple. Each M3 iMac also 
comes with a 1080p FaceTime camera, and a six-speaker 
sound system with support for spatial audio. You’ll also find 
two Thunderbolt/USB 4 ports on each model, with mid-range 
and top-tier options offering two additional USB 3 (USB-C) 
ports. Rather surprisingly – and pleasingly – the starting price 
remains unchanged at £1,399.

iMac  From 
£1,399

 From £179 

 From £79  From £129 

Your guide to the best Apple hardware and third-party accessories

iMac 24in £1,399  
(Entry level)
Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 8-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)
Storage: 256GB (upgradeable to 512GB or 1TB)
Ports: 2x Thunderbolt/USB 4, 1x Gb Ethernet (option)

iMac 24in £1,599  
(Mid-range)
Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)
Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet

iMac 24in £1,799  
(Ultimate)
Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)
Storage: 512GB (upgradeable to 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet

Apple Magic Keyboard with 
Touch ID and Numeric Keypad

Apple Magic 
Mouse

Apple Magic 
Trackpad

 This extended keyboard is a great upgrade 
option for any Mac and comes with Touch ID for 
faster Mac logins. The black version costs £199.

 Design quirks aside, 
(we’re looking at you, 
Lightning Port) the Magic 
Mouse is a great pointing 
device, thanks to its Multi 
Touch support. The black 
version costs £99.

 This Multi Touch glass 
trackpad is a thing of 
beauty, giving you lots 
of control over macOS 
and it’s rechargeable 
too. The black version 
costs £149.

EXPECTED
OCT 2024
UPDATED
OCT 2023
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 Apple’s most affordable laptop was 
given an upgrade in March 2024, with 
both the 13-inch and 15-inch models 
now sporting Apple silicon M3 chips, 
although an M2-equipped version of 
the 13-inch remains available.
 The laptop boasts a silent, fanless 
design, a six-speaker sound system 
(the 13in has four speakers) and spatial 
audio. The 13in M3 features an 8-core 
CPU, offering 1.6x faster performance 
than the M1, along with either an 8- or 
a 10-core GPU, giving it a 5.8% boost 
in graphics performance. The M3 also 
benefits from 100GB/sec memory 
bandwidth. Both M3 MacBook Air models 
come with 8GB of memory as standard, 
configurable to 16 or 24GB, and both can 
be configured with up to 2TB of storage. 

The 15in MacBook Air is the thinnest 
15in laptop available – 40% thinner than 
comparable PC laptops; it’s just 11.5mm 
thin and weighs 1.51kg. The 13in Air is 
11.3mm thin and weighs 1.24kg. The 
Liquid Retina display in the 15in MacBook 
Air has a resolution of 2880x1864 pixels, 
while the 13in has 2560x1664. Both 
support up to one billion colours.

Both M3 MacBook Air models come 
with 1080p FaceTime HD cameras, 
MagSafe 3, two Thunderbolt/USB 4 
ports and a headphone jack and 
Bluetooth 5.3, and they now support 
Wi-Fi 6E. You also get up to 18 hours 
of battery life when viewing video or 
15 when web surfing.

Prices for the 13in model start at 
£1,099, while the 15in starts at £1,299. 

 £99/£299 
 From £219

EXPECTED
OCT 2024
UPDATED
JAN 2023

Mac mini £649  
(Entry level)
Chip: Apple M2, 8-core CPU (4 performance cores, 4 
efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)
Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 2x USB-A, 1x HDMI 2.0, 
3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)

MacBook Air 13in £1,099 
(Entry level)

MacBook Air 15in £1,699 
(Ultimate)

Mac mini £1,399  
(Ultimate)

Display: 13.6in Liquid Retina with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 8-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)
Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

Display: 15.3in Liquid Retina with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 16GB (upgradeable to 24GB)
Storage: 512GB (upgradeable to 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

Chip: Apple M2 Pro with 10-core CPU (4 performance cores, 
4 efficiency cores), 16-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)
Storage: 512GB (upgradeable to 1TB or 2TB)
Ports: 4x Thunderbolt/USB 4, 2x USB-A, 1x HDMI 2.0, 
3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)

MacBook Air  From  
£1,099

 Apple’s most affordable desktop 
may not come with a mouse, a 
trackpad or keyboard, but it’s also 
great value starting at even less 
than the last model at £649.

Despite the reduction in price, the 
Mac mini now boasts Apple’s M2 chip, 
boasting an 8-core CPU, 10-core GPU 
and 16-core Neural Engine. The 8GB 
of memory can now be boosted up 
to 24GB, while SSD storage options 
range from 256GB all the way up to 
2TB. There is now also an M2 Pro 
version with a 10-core CPU/16-core 
GPU (configurable to 12-core CPU/19-
core GPU), with 16 to 32GB memory 
and 512GB to 8TB SSD storage.

Entry-level and mid-range M2 Mac 
mini models continue to come with 
two Thunderbolt/USB 4 ports, but 
the M2 Pro model has now has four.

 From 
£649  Mac mini

Apple HomePod/
HomePod mini

TV 4K Watch 
Series 9, 
Ultra 2, SE

 Apple’s Siri-powered 
speakers sound great, 
you can link two for 
stereo sound, and use them 
as smart home hubs. The mini comes in five 
colours; the 2nd-gen Midnight/White HomePod 
(£299), offers higher spec and spatial audio. 

 Apple’s third-gen 
little black box with 
A15 Bionic chip now 
adds HDR10+ to the 
mix. Prices now start at just 
£149 (Wi-Fi only); the standard version now 
comes with 64GB of storage, while paying £20 
extra gets you 128GB, Ethernet and Thread.

 The SE and 
Series 9 are water resistant to 
50m, but the titanium Ultra 2 is water resistant to 
100m. The Series 9 and the Ultra 2 now run on an 
S9 SiP and boast an Always-On Retina display, and 
all three offer Emergency SOS and Crash Detection.

 From £149 

EXPECTED
MAR 2025
UPDATED
MAR 2024
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 October 2023 saw the introduction 
of the M3 chip family to the MacBook 
Pro. The new 14-inch M3 model is 
available with an 8-core CPU/10-core 
GPU. But if you step up to the M3 Pro 
option, you can opt for either an 11-core 
CPU/14-core GPU or a 12-core CPU/ 
18-core GPU, or the M3 Max which 
has a 14-core CPU/30-core GPU. 
 The 16in options start with the M3 Pro 
chip with a 12-core CPU/18-core GPU and 
either 18GB or 36GB of unified memory. 
Or you can opt for the M3 Max chip with 

either a 14-core CPU/30-core GPU or 
16-core CPU/40-core GPU. The unified 
memory can be upgraded to a max of 
128GB on the M3 Max models, while SSD 

storage can be upgraded to a max of 
8TB on M3 Max models. The 14in M3 and 
and 16in M3 Pro and M3 Max models now 
offer up to 22 hours of battery life. 

 The Mac Studio finally received a 
long-hoped-for update in June 2023 
with the latest model sporting Apple 
silicon M2 Max and M2 Ultra chips. 
The Mac Studio is up to six times faster 
than the most powerful Intel-based 
27-inch iMac and up to three times faster 
than the M1 Ultra Studio that preceded it.

The Studio’s aluminium body is very 
compact for a desktop Mac, measuring 
197x197x95mm, but it’s what’s inside that 
counts. The M2 Max chip has a 12-core 
CPU, a 30-core GPU (upgradeable to 
38-core), and 32GB of memory 
(configurable to 96GB). The M2 Ultra 
comes with a 24-core CPU, 60-core GPU 
(upgradeable to 76-core), and 64GB of 

unified memory (upgradeable to 192GB). 
Storage options on both scale up to 8TB. 

The Mac Studio M2 Max starts at 
£2,099, and the M2 Ultra starts at 
£4,199, so these machines are not for 
everyone. But both offer an incredible 
array of connectivity options and 
support for the more pro user. 

MacBook Pro

Mac Studio  From 
£2,099

 From £1,499

MacBook Pro 14in £1,699 
(Entry level)
Display: 14.2in Liquid Retina XDR (3024x1964) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, 
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)
Storage: 512GB (upgradeable to 1TB, 2TB)
Ports: 2x Thunderbolt/USB 4, HDMI port, SDXC card slot

Mac Studio £2,099  
(Entry level)
Chip: M2 Max with 12-core CPU (8 performance cores, 
4 efficiency cores), 30-core GPU, 16-core Neural Engine
Memory: 32GB (upgradeable to 96GB)
Storage: 512GB (upgradeable to 1TB, 2TB, 4TB, 8TB)
Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, HDMI 2.0, 
3.5mm headphone jack, 10Gb Ethernet, SDXC card slot

MacBook Pro 16in £2,599 
(Mid-range)
Display: 16.2in Liquid Retina XDR (3456x2234) with True Tone
Chip: Apple M3 Pro with 12-core CPU (6 performance cores, 
6 efficiency cores), 18-core GPU, 16-core Neural Engine
Memory: 18GB (upgradeable to 36GB)
Storage: 512GB (upgradeable to 1TB, 2TB, 4TB)
Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

Mac Studio £4,199  
(Ultimate)
Chip: M2 Ultra with 24-core CPU (16 performance cores, 
8 efficiency cores), 60-core GPU, 32-core Neural Engine
Memory: 64GB (upgradeable to 192GB)
Storage: 1TB (upgradeable to 2TB, 4TB, 8TB)
Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, HDMI 2.0, 
3.5mm headphone jack, 10Gb Ethernet, SDXC card slot

MacBook Pro 16in £4,099 
(Ultimate)
Display: 16.2in Liquid Retina XDR (3456x2234) and True Tone
Chip: Apple M3 Max with 16-core CPU (12 performance cores, 
4 efficiency cores), 40-core GPU, 16-core Neural Engine
Memory: 48GB (upgradeable to 128GB)
Storage: 1TB (upgradeable to 2TB, 4TB or 8TB)
Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

Studio Display

 Launched alongside the Mac 
Studio in March 2022, the Studio 
Display is a great addition to any 
Mac set-up.

Powered by Apple’s A13 Bionic 
and running iOS, it features a 
27-inch Retina display with 5K 
resolution (5120x2880 pixels) 
and True Tone, a 12MP Ultra Wide 
camera with Centre Stage, and 
a six-speaker sound system with 
support for spatial audio. A range 
of stand options are available, and 
you can choose nano-texture glass 
for £250 more.

The Mac Studio is Apple’s most powerful 
desktop Mac to date – it’s pricy though.

EXPECTED
JUNE 2024

UPDATED
JUNE 2023

 From £1,349

EXPECTED
OCT 2024
UPDATED
OCT 2023
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 From £79
 From £279 

Apple PencilApple Smart Folio Apple Magic 
Keyboard

 Available in a range of stylish colours, these 
wrap-around magnetic cases will keep your iPad, 
iPad mini, iPad Air and iPad Pro looking good for 
years, and they double as handy stands.

 Apple has recently released a 
more affordable Pencil with USB-C 
charging, although the pricier 1st- 
and 2nd-gen variants are still 
available. The Pencil brings 
accuracy to iPad interactions, 
making it great for sketching, 
painting and handwritten notes. 

 The Magic Keyboard 
(for iPad Air/iPad Pro), 
comes with backlit 
keys and easy-to-use 
trackpad. There’s also 
a Magic Keyboard 
Folio for iPads.

 Apple celebrates the iPad’s 10th 
incarnation by increasing the 
display to 10.9in and boosting its 
internals to an A14 Bionic chip. You 
now get an Ultra Wide 12MP front and 
updated 12MP back camera. The iPad 
now also finally adopts the USB-C 
port, and comes in Blue, Pink, Yellow 
and Silver. Prices start at £499.

The iPad mini is like a shrunk 
down iPad Air, with an all-screen 
design centred around its 8.3in Liquid 
Retina display. The £569 version 
comes with 64GB of storage (but can 
be upgraded to 256GB), comes with a 
12MP Wide camera, second-gen Apple 
Pencil support and USB-C charging.

 Like the iPad, iPad mini and iPad 
Pro, the iPad Air has an all-screen 
design that makes the most of its 
10.9in Liquid Retina display. Inside its  
super-slim chassis, you’ll find the same 
Apple silicon M1 chip as the entry-level 
MacBook Air and Mac mini. Plus it’s 
available in a choice of storage options 
(64GB or 256GB), has 802.11ax Wi-Fi 
(aka Wi-Fi 6) and Bluetooth 5.0 
onboard, and there are Wi-Fi+Cellular 
variants with 5G starting at £719.

The iPad Air also supports Apple’s 
second-gen Apple Pencil and can be 
teamed with Apple’s Magic Keyboard 
for powerhouse productivity on the go. 
Augmented reality fans will love its 
LiDAR-equipped 12MP Wide camera, 
plus it also has Centre Stage.

 Apple’s priciest iPad is also its 
most fully featured. Available in 11in 
and 12.9in sizes, the iPad Pro models 
now boast M2 Apple silicon, which 
turbocharges the performance, and 
iPadOS 16 enables the Apple Pencil 
‘hover experience’. 

The 12.9in model’s Liquid 
Retina XDR display boasts miniLED 
backlighting, but even the 11in model 
gets 120Hz ProMotion refresh rates, 
plus a Thunderbolt/USB 4 port for 
charging and connection to a wide 
range of external devices. And both 
support the second-gen Apple Pencil, 
Magic Keyboard, and Centre Stage. 
The 12.9in now makes an even 
greater MacBook replacement.

iPad/mini iPad Air iPad Pro
 iPad (10th gen) From £499 
 iPad mini From £569

 From 
£669

 From 
£899

iPad ProiPad iPad AiriPad mini
Display: 10.9in
Chip: A14 Bionic
Storage: 64GB, 256GB
Ports: USB-C
Unlocking: Touch ID

Display: 10.9in
Chip: Apple M1
Storage: 64GB, 256GB
Ports: USB-C
Unlocking: Touch ID

Display: 11in or 12.9in
Chip: Apple M2
Storage: 128GB-2TB 
Ports: Thunderbolt 4
Unlocking: Face ID

Display: 8.3in
Chip: A15 Bionic
Storage: 64GB, 256GB
Ports: USB-C
Unlocking: Touch ID

EXPECTED
MAY 2024
UPDATED
MAR 2022

EXPECTED
MAY 2024
UPDATED
OCT 2022

EXPECTED
MAY 2024
UPDATED
OCT 2022

 From £69
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 $3,499  

Apple AirPods Max/
AirPods Pro/AirPods

Apple Vision Pro

 Marking the start of what 
Apple hopes is a new era of 
spatial computing, the Vision 
Pro is now available in the US. 
Equipped with a custom 23 million 
pixel microOLED display, the twin 
lenses inside the Vision Pro boasts 
better than 4K resolution and it 

has spatial audio onboard too. 
Driving the whole thing are Apple 
silicon M2 and R1 chips, upon which 
sits an entirely new OS: visionOS.

 The AirPods Max are super comfy 
and boast Transparency Mode and ANC. 
The second-gen AirPods Pro add in 
Adaptive Audio. The third-gen AirPods are 
available with either a Lightning (£169) 
or MagSafe (£179) charging case. All three 
come with personalised spatial audio.

 Apple’s most affordable iPhone 
is now even better value, thanks 
to a September price reduction of 
£20. As with the iPhone 14 range, 
the SE works on an A15 Bionic 
chip. The iPhone SE offers plenty of 
the things people love about iPhone, 
including iOS’s phenomenal ease of 
use. There’s only a single 12MP Wide 
main camera and no Night mode, but 
you do get True Tone, a Photonic 
engine, and 4K recording.

Battery life is decent too with the 
iPhone SE lasting for up to 15 hours 
between recharges (with Qi wireless 
charging onboard too). The main 
thing the iPhone SE misses out on 
is Face ID unlocking, making do with 
Touch ID on the Home button instead.

 In September, Apple launched its 
iPhone 15 range. The base model 
retains its 6.1in screen, and the Plus 
stays at 6.7in, while both handsets 
are still of an aluminium build.

Both models now benefit from the 
Dynamic Island, while the dual-camera 
system has been improved with a 
48MP Main camera and a 12MP Ultra 
Wide, plus a Photonic Engine for low-
light images and Smart HDR 5. The 
iPhone 15 lasts for up to 20 hours 
when playing video playback; the Plus 
up to 26. And the best news? The 15 
and 15 Plus are each £50 cheaper than 
the 14 and 14 Plus before them.

 The iPhone 15 Pro and Pro Max 
boast a lightweight titanium shell 
with a textured matt glass back. 
There’s now a new fast Action button  
on the side of the handset that acts 
as a handy physical shortcut. 

The quad-pixel sensor on the 
Main camera provides 48MP, 12MP 
Ultra Wide, 12 MP Telephoto with up 
to 5x optical zoom on the Pro Max. 
The 15 Pro and Pro Max are powered 
by a graphics-friendly A17 Pro chip. 
Video playback times remain at up to 
23 hours for the Pro, while the Pro 
Max can keep going for 29. 

iPhone SE iPhone 15/
Plus
 iPhone 15 From £799
 iPhone 15 Plus From £899

 iPhone 15 Pro From £999 
 iPhone 15 Pro Max From £1,199

 From £429

iPhone 15 iPhone 15 ProiPhone 15 Plus iPhone 15 Pro Max
Display: 6.1in
Chip: A16 Bionic
Storage: 128GB-512GB
Connectivity: 5G, Wi-Fi
Unlocking: Face ID

Display: 6.1in
Chip: A17 Pro
Storage: 128GB-1TB
Connectivity: 5G, Wi-Fi
Unlocking: Face ID

Display: 6.7in
Chip: A16 Bionic
Storage: 128GB-512GB
Connectivity: 5G, Wi-Fi
Unlocking: Face ID

Display: 6.7in
Chip: A17 Pro
Storage: 256GB-1TB
Connectivity: 5G, Wi-Fi
Unlocking: Face ID

iPhone SE
Display: 4.7in
Chip: A15 Bionic
Storage: 64GB-256GB
Connectivity: 5G, Wi-Fi
Unlocking: Touch ID

EXPECTED
MAR 2025
UPDATED
MAR 2022

EXPECTED
SEPT 2024
UPDATED

SEPT 2023

iPhone 15  
Pro/Pro Max

EXPECTED
SEPT 2024
UPDATED

SEPT 2023

 £499/£229/From £169
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 Image credits: Koninklijke Philips NV, Marshall Amplification PLC, Asustor Inc, ASUSTeK Computer Inc, Linksys 
Holdings Inc, devolo AG, Micron Technology, Inc, Western Digital Corporation, Other World Computing Inc, 
Satechi, Fantasia Trading LLC, Ugreen Ltd, Skylum, publicspace.net, Literature & Latte Ltd, Wondershare, Artlist 
UK Ltd, LWKS.com, Momenta BV, ShinyFrog, Automattic Inc, Spark Mail Ltd, Edison Software, Bloop, Luma Touch 
LLC, Ginger Labs, The Grizzly Labs, Serif (Europe) Ltd, Capture One, Silvio Rizzi, inkle Ltd

JUNE 2024 | MACFORMAT | 103

BEST BUYS… Third-party Mac apps 

BEST BUYS… 
Third-party iPhone, 
iPad & Watch apps 

BEST BUYS…

 VIDEO EDITOR (iOS/iPADOS)

LumaFusion 3
£29.99 luma-touch.com

 NOTE-TAKING (iOS/iPADOS)

Notability
£8.99 notability.com

 EXTERNAL DISPLAY

Philips 27B1U7903
£1,099, philips.co.uk

 BLUETOOTH SPEAKER

Marshall Middleton
£269.99, 
marshallheadphones.com

 NAS DRIVE

Asustor Lockerstor 2 
Gen2 AS6702T
£469, asustor.com

 SCANNING/OCR (iOS/iPADOS)

GeniusScan+
£8.99 grizzlylabs.com

 PAGE LAYOUT (iPADOS)

Affinity Publisher 2
£17.99 affinity.serif.com

 PHOTO EDITOR (iPADOS)

Capture One
£4.49/month captureone.com

 RSS READER (iOS)

Reeder 5
£4.99 reederapp.com

 GAME (iOS/iPADOS)

Overboard!
£5.99 inklestudios.com

 A powerful and reasonably priced 
video-editing suite. Existing users 
can upgrade for free. 
★★★★★ MF372

 Notability is a superb note-taking
app with lots of flexibility. It’s ideal 
for a variety of projects. 
★★★★★ MF360

 An excellent monitor that 
satisfies on every level. It’s 
expensive, but you do get a 
lot of quality for your money.
★★★★★ MF392

 Meaty, beaty, big and 
bouncy, the Middleton 
knows how to rock.
★★★★★ MF391

 Excellent and versatile 
mid-range network 
storage.
★★★★★ MF390

 PHOTO EDITOR

Luminar AI
£9.99/month skylum.com

 PRODUCTIVITY TIMER

Vitamin-R 4.14
€27.95 (about £30) 
publicspace.net

 WRITING APPS

Scrivener
£49.99 
literatureandlatte.com If you want to improve 

your photos without 
spending too much, this 
is the app for you. 
★★★★★ MF361

 Break your working day 
up into short bursts of 
distraction-free activity. 
★★★★★ MF384

 A genuinely outstanding 
app that has almost 
everything you could ever 
need. ★★★★★ MF385

 Fast, flexible and useful scanning 
with good optical character 
recognition (OCR). 
★★★★★ MF368

Serif’s page layout app finally arrives on 
iPad and it’s great – even if the interface 
takes some getting used to.
★★★★★ MF391

 A comprehensive photo editor offering 
powerful Raw conversion and desktop-
quality editing tools on the iPad. 
★★★★★ MF384

 Version 5 brings minor, but welcome 
improvements to an already great 
RSS news-reader app. 
★★★★★ MF361

 A gem. A small, but perfectly formed 
and entertaining game about a ship-
based murder mystery. 
★★★★★ MF372

 OUR TOP 3  OUR TOP 3  OUR TOP 3

ASUS ZenWiFi XT9
>£459.99 >MF386 
>asus.com/uk

Crucial X8
>£211.99 >MF388
>uk.crucial.com

Satechi 200W 
USB-C 6-Port PD GaN
£159.99 >MF392
>satechi.net

Linksys Atlas 6
>£179.99 >MF386 
> linksys.com/gb

SanDisk Extreme
>£99.99, >MF388
>westerndigital.com

Anker 737 Charger 
GaNPrime 120W
£84.99 >MF392
>anker.com/uk

Devolo Magic 2 
WiFi next
>£174.99 >MF386
>devolo.co.uk

OWC Envoy Pro SX
>£285 >MF388
> owc.com

Ugreen Nexode 
200W USB-C Desktop
£199.99 >MF394
>uk.ugreen.com

MESH NETWORK DEVICES PORTABLE SSDS

 OUR TOP 3  OUR TOP 3  OUR TOP 3

Wondershare Filmora
>£17.49/month >MF387
>wondershare.com

Agenda.
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>simplenote.com

Airmail Pro
>£5.99/month >MF375
>airmailapp.com
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GOODBYE Until next issue… 

One more thing
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here are rumours circulating that 
a new HomePod speaker featuring 
a screen is on the way from 

Apple any day now… While I think there 
almost certainly will be a new third-gen 
HomePod from Apple at some point, the 
idea that it’s imminent? Well, I’d take 
that with a Cupertino-sized dose of salt. 
With HomePod, Apple really doesn’t 
seem to follow the same yearly update 
schedule it does with the iPhone, or even 
feel the urge to follow any schedule at all.

Let’s just recap the history of the 
HomePod. First released in 2018 as a 
response to Amazon’s Alexa-powered 
Echo speakers, but featuring Siri, it 
turned out to be nice luxury item, but 
also too expensive and a little too limited 
for anybody to really want one. If 
anything it simply highlighted that 
you could do more with Alexa-based 
speakers than you could with Siri 
ones, so Apple quietly killed it while 
introducing something else instead. 
The smaller, cheaper, HomePod mini 
appeared in 2020. It still cost more than 
cheaper Amazon rivals but it filled the 
home speaker-sized gap in the average 
Apple owner’s life. Then, in February 
2023, Apple mysteriously resurrected 
HomePod with a second-gen version. While 
its specs had been updated from the 2018 
model that had preceded it, it really wasn’t that 
different. What was Apple’s motivation here? 
I’m asking because nobody seems to know.

AI wait for next model
Now we’re more than a year  on since the 
return of the HomePod and the rumour mill 
has ramped up, and people are getting excited 
about the idea of a third-gen HomePod 
featuring a screen. While Amazon has had 
the Echo Show on the market for ages (an 
Alexa speaker with a screen that can do video   

T

calls), Apple still hasn’t responded with a similar 
version of HomePod. It makes sense for Apple 
to meet the challenge, but my guess is that Apple 
is waiting for AI development to get to the 
point where Siri can benefit from it before 
it launches a new HomePod. That would 
deliver a real step up in performance, but it’s 
going to take time. I wouldn’t expect to see 
one on the market until we’re well into 2025.

 Image credit: Apple Inc

Graham Barlow isn’t holding his breath for the next HomePod
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There are rumours circulating that a new HomePod release is imminent, 
but Apple might be holding back for further AI advances.
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